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Introduction

hat’s your story?

¥ Are you a working stiff, interested in knowing more about the way your
company’'s computers work?

¥ Areyou a student who needs some extra reading in order to survive a
beginning computer course?

¥ Are you a typical computer user — you've done lots of word processing and
you want to do something more interesting with your computer?

3 Areyou a job seeker with an interest in entering the fast-paced, glamorous,
high-profile world of computer programming (or, at least, the decent-paying
world of computer programming)?

Well, if you want to write computer programs, this book is for you. This book
avoids the snobby “of-course-you-already-know” assumptions and describes
computer programming from scratch.

About This Book

The book uses Java — a powerful, general-purpose computer programming
language. But Java’s subtleties and eccentricities aren’t the book’s main focus.
Instead, this book emphasizes a process — the process of creating instructions for
a computer to follow. Many highfalutin books describe the mechanics of this
process — the rules, the conventions, and the formalisms. But those other books
aren’t written for real people. Those books don’t take you from where you are to
where you want to be.

In this book, I assume very little about your experience with computers. As you

read each section, you get to see inside my head. You see the problems that I face,
the things that I think, and the solutions that I find. Some problems are the kind
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that I remember facing when I was a novice; other problems are the kind that
I face as an expert. I help you understand, I help you visualize, and I help you
create solutions on your own. I even get to tell a few funny stories.

How to Use This Book

I wish I could say, “Open to a random page of this book and start writing Java
code. Just fill in the blanks and don’t look back.” In a sense, this is true. You can’t
break anything by writing Java code, so you’re always free to experiment.

But I have to be honest: If you don’t understand the bigger picture, writing a pro-
gram is difficult. That’s true with any computer programming language — not
just Java. If you’re typing code without knowing what it’s about, and the code
doesn’t do exactly what you want it to do, you’re just plain stuck.

In this book, I divide programming into manageable chunks. Each chunk is (more
or less) a chapter. You can jump in anywhere you want — Chapter 5, Chapter 10,
or wherever. You can even start by poking around in the middle of a chapter. I’ve
tried to make the examples interesting without making one chapter depend on
another. When I use an important idea from another chapter, I include a note to
help you find your way around.

In general, my advice is as follows:

¥ If you already know something, don't bother reading about it.

¥ If you're curious, don't be afraid to skip ahead. You can always sneak a peek at
an earlier chapter, if you really need to do so.

Conventions Used in This Book

Almost every technical book starts with a little typeface legend, and Beginning
Programming with Java For Dummies, 5th Edition, is no exception. What follows is a
brief explanation of the typefaces used in this book:

¥ New terms are set in jtalics.

3 When I want you to type something short or perform a step, | use bold.

2 Beginning Programming with Java For Dummies



»

»

You'll also see this computerese font. | use the computerese font for Java
code, filenames, web page addresses (URLs), onscreen messages, and other
such things. Also, if something you need to type is really long, it appears in
computerese font on its own line (or lines).

You need to change certain things when you type them on your own com-
puter keyboard. For example, | may ask you to type

class Anyname

which means you should type class and then a name that you make up on
your own. Words that you need to replace with your own words are set in
italicized computerese.

What You Don’t Have to Read

Pick the first chapter or section that has material you don’t already know and start
reading there. Of course, you may hate making decisions as much as I do. If so,
here are some guidelines you can follow:

»

»

»

»

If you already know what computer programming is all about, skip the first
half of Chapter 1. Believe me, | won't mind.

If you're required to use a development environment other than Eclipse, you
can skip Chapter 2. This applies if you plan to use NetBeans, Intelli] IDEA, or a
number of other development environments.

Most of this book’s examples require Java 5.0 or later, and some of the
examples require Java 7 or later. So make sure that your system uses Java 7 or
later. If you're not sure about your computer’s Java version or if you have
leeway in choosing a development environment, your safest move is to read
Chapter 3.

If you've already done a little computer programming, be prepared to skim
Chapters 6, 7, and 8. Dive fully into Chapter 9 and see whether it feels
comfortable. (If so, read on. If not, skim Chapters 6, 7, and 8 again.)

If you feel comfortable writing programs in a language other than Java, this
book isn't for you. Keep this book as a memento and buy my Java For
Dummies, 7th Edition (also published by Wiley).

If you want to skip the sidebars and the material highlighted by a Technical Stuff
icon, please do. In fact, if you want to skip anything at all, feel free.
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Foolish Assumptions

In this book, I make a few assumptions about you, the reader. If one of these
assumptions is incorrect, you’re probably okay. If all these assumptions are
incorrect . . . well, buy the book anyway.

3 | assume that you have access to a computer. Here's good news. You can
run the code in this book on almost any computer. The only computers you
can't use to run this code are ancient things that are more than eight years old
(give or take a few years). You can run the latest version of Java on Windows,
Macintosh, and Linux computers.

3 | assume that you can navigate your computer's common menus and
dialog boxes. You don't have to be a Windows, Linux, or Macintosh power
user, but you should be able to start a program, find a file, put a file into a
certain directory — that sort of thing. Most of the time, when you practice the
stuff in this book, you're typing code on your keyboard, not pointing and
clicking the mouse.

On those rare occasions when you need to drag and drop, cut and paste, or
plug and play, | guide you carefully through the steps. But your computer may
be configured in any of several billion ways, and my instructions may not quite
fit your special situation. So when you reach one of these platform-specific
tasks, try following the steps in this book. If the steps don't quite fit, send me
an email message or consult a book with instructions tailored to your system.

3 lassume that you can think logically. That's all there is to computer
programming — thinking logically. If you can think logically, you've got it
made. If you don't believe that you can think logically, read on. You may be
pleasantly surprised.

3 | assume that you know little or nothing about computer programming.
This isn't one of those “all things to all people” books. | don't please the novice
while | tease the expert. | aim this book specifically toward the novice — the
person who has never programmed a computer or has never felt comfortable
programming a computer. If you're one of these people, you're reading the
right book.

How This Book Is Organized

This book is divided into subsections, which are grouped into sections, which
come together to make chapters, which are lumped finally into five parts. (When
you write a book, you get to know your book’s structure pretty well. After months
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of writing, you find yourself dreaming in sections and chapters when you go to
bed at night.) The parts of the book are listed here.

Part 1: Getting Started with
Java Programming

The chapters in Part 1 prepare you for the overall programming experience. In
these chapters, you find out what programming is all about and get your computer
ready for writing and testing programs.

Part 2: Writing Your Own Java Programs

This part covers the basic building blocks — the elements in any Java program and
in any program written using a Java-like language. In this part, you discover how
to represent data and how to get new values from existing values. The program
examples are short, but cute.

Part 3: Controlling the Flow

Part 3 has some of my favorite chapters. In these chapters, you make the computer
navigate from one part of your program to another. Think of your program as a big
mansion, with the computer moving from room to room. Sometimes the com-
puter chooses between two or more hallways, and sometimes the computer revis-
its rooms. As a programmer, your job is to plan the computer’s rounds through
the mansion. It’s great fun.

Part 4: Using Program Units

Have you ever solved a big problem by breaking it into smaller, more manageable
pieces? That’s exactly what you do in Part 4 of this book. You discover the best
ways to break programming problems into pieces and to create solutions for the
newly found pieces. You also find out how to use other peoples’ solutions. It feels
like stealing, but it’s not.

This part also contains a chapter about programming with windows, buttons, and

other graphical items. If your mouse feels ignored by the examples in this book,
read Chapter 20.
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Part 5: The Part of Tens

The Part of Tens is a little beginning-programmer’s candy store. In The Part of
Tens, you can find lists — lists of tips, resources, and all kinds of interesting
goodies.

I added an article at www.dummies.com to help you feel comfortable with Java’s
documentation (www.dummies.com/programming/java/making-sense-of-javas—
api-documentation, to be precise). I can’t write programs without my Java
programming documentation. In fact, no Java programmer can write programs
without those all-important docs. These docs are in web page format, so they’re
easy to find and easy to navigate. But if you’re not used to all the terminology, the
documentation can be overwhelming.

Icons Used in This Book

6

Q

TIP

A

WARNING

REMEMBER

If you could watch me write this book, you’d see me sitting at my computer, talk-
ing to myself. I say each sentence several times in my head. When I have an extra
thought, a side comment, or something that doesn’t belong in the regular stream,
I twist my head a little bit. That way, whoever’s listening to me (usually nobody)
knows that I’'m off on a momentary tangent.

Of course, in print, you can’t see me twisting my head. I need some other way of
setting a side thought in a corner by itself. I do it with icons. When you see a Tip
icon or a Remember icon, you know that I’m taking a quick detour.

Here’s a list of icons that I use in this book:

A tip is an extra piece of information — something helpful that the other books
may forget to tell you.

Everyone makes mistakes. Heaven knows that I’ve made a few in my time. Any-
way, when I think of a mistake that people are especially prone to make, I write
about the mistake in a Warning icon.

Sometimes I want to hire a skywriting airplane crew. “Barry,” says the white
smoky cloud, “if you want to compare two numbers, use the double equal sign.
Please don’t forget to do this.” Because I can’t afford skywriting, I have to settle
for something more modest. I create a Remember icon.
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Writing computer code is an activity, and the best way to learn an activity is to
practice it. That’s why I’ve created things for you to try in order to reinforce your
knowledge. Many of these are confidence-builders, but some are a bit more chal-
lenging. When you first start putting things into practice, you’ll discover all kinds
of issues, quandaries, and roadblocks that didn’t occur to you when you started
reading about the material. But that’s a good thing. Keep at it! Don’t become frus-
trated. Or, if you do become frustrated, visit this book’s website (www.allmycode.
com/BeginProg) for hints and solutions.

Occasionally, I run across a technical tidbit. The tidbit may help you understand
what the people behind the scenes (the people who developed Java) were thinking.
You don’t have to read it, but you may find it useful. You may also find the tidbit
helpful if you plan to read other (more geeky) books about Java.

This icon calls attention to useful material that you can find online. (You don’t
have to wait long to see one of these icons. I use one at the end of this
introduction!)

“If you don’t remember what such-and-such means, see blah-blah-blah,” or
“For more information, read blahbity-blah-blah.”

Beyond the Book

In addition to what you’re reading right now, this book comes with a free access-
anywhere Cheat Sheet containing code that you can copy and paste into your own
Java program. To get this Cheat Sheet, simply go to www.dummies.com and type
Beginning Programming with Java For Dummies Cheat Sheet in the Search box.

Where to Go from Here

If you’ve gotten this far, you’re ready to start reading about computer program-
ming. Think of me (the author) as your guide, your host, your personal assistant.
I do everything I can to keep things interesting and, most importantly, help you
understand.

If you like what you read, send me an email, post on my Facebook wall, or give me
a tweet. My email address, which I created just for comments and questions about
this book, is BeginProg@allmycode.com. My Facebook page is /allmycode, and
my Twitter handle is @al1mycode. And don’t forget: To get the latest information,
visit this book’s support website — http://allmycode.com/BeginProg.
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enables you to write programs
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Chapter 1
Getting Started

omputer programming? What'’s that? Is it technical? Does it hurt? Is it
politically correct? Does Google control it? Why would anyone want to do it?
And what about me? Can I learn to do it?

What's It All About?

You’ve probably used a computer to do word processing. Type a letter, print it, and
then send the printout to someone you love. If you have easy access to a computer,
you’ve probably surfed the web. Visit a page, click a link, and see another page. It’s
easy, right?

Well, it’s easy only because someone told the computer exactly what to do. If you
take a computer directly from the factory and give no instructions to this com-
puter, the computer can’t do word processing, it can’t surf the web, and it can’t
do anything. All a computer can do is follow the instructions that people give to it.

Now imagine that you’re using Microsoft Word to write the great American novel,
and you come to the end of a line. (You’re not at the end of a sentence; just the end
of a line.) As you type the next word, the computer’s cursor jumps automatically
to the next line of type. What’s going on here?
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Well, someone wrote a computer program — a set of instructions telling the
computer what to do. Another name for a program (or part of a program) is code.
Listing 1-1 shows you what some of Microsoft Word’s code may look like.

m A Few Lines in a Computer Program

12

if (columnNumber > 60) {
wrapToNextLine();

} else {
continueSamelLine();

}

If you translate Listing 1-1 into plain English, you get something like this:

If the column number is greater than 60,
then go to the next line.
Otherwise (if the column number isn't greater than 60),

then stay on the same line.

Somebody has to write code of the kind shown in Listing 1-1. This code, along with
millions of other lines of code, makes up the program called Microsoft Word.

And what about web surfing? You click a link that’s supposed to take you directly
to Facebook. Behind the scenes, someone has written code of the following kind:

Go to <a href="http://www.facebook.com">Facebook</a> .

One way or another, someone has to write a program. That someone is called a
programmer.

Telling a computer what to do

Everything you do with a computer involves gobs and gobs of code. For example,
every computer game is really a big (make that “very big”!) bunch of computer
code. At some point, someone had to write the game program:

if (person.touches(goldenRing)) {
person.getPoints(10);

Without a doubt, the people who write programs have valuable skills. These peo-
ple have two important qualities:
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3 They know how to break big problems into smaller, step-by-step procedures.

¥ They can express these steps in a very precise language.

A language for writing steps is called a programming language, and Java is just one
of several thousand useful programming languages. The stuff in Listing 1-1 is
written in the Java programming language.

Pick your poison

This book isn’t about the differences among programming languages, but you
should see code in some other languages so you understand the bigger picture.
For example, there’s another language, Visual Basic, whose code looks a bit dif-
ferent from code written in Java. An excerpt from a Visual Basic program may look
like this:

If columnNumber > 60 Then
Call wrapToNextLine
Else
Call continueSameline
End If

The Visual Basic code looks more like ordinary English than the Java code in
Listing 1-1. But, if you think that Visual Basic is like English, then just look at
some code written in COBOL:

IF COLUMN-NUMBER IS GREATER THAN 6@ THEN
PERFORM WRAP-TO-NEXT-LINE

ELSE
PERFORM CONTINUE-SAME-LINE

END-IF.

At the other end of the spectrum, you find languages like Forth. Here’s a snippet
of code written in Forth:

: WRAP? 60 > IF WRAP_TO_NEXT_LINE? ELSE CONTINUE_SAME_LINE? THEN ;

Computer languages can be very different from one another, but in some ways,
they’re all the same. When you get used to writing IF COLUMN-NUMBER IS GREATER
THAN 60, you can also become comfortable writing if (columnNumber > 60).It’s
just a mental substitution of one set of symbols for another. Eventually, writing
things like i f (columnNumber > 60) becomes second nature.
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From Your Mind to the
Computer’s Processor

When you create a new computer program, you go through a multistep process.
The process involves three important tools:

3 Compiler: A compiler translates your code into computer-friendly (human-
unfriendly) instructions.

¥ Virtual machine: A virtual machine steps through the computer-friendly
instructions.

3 Application programming interface: An application programming interface
contains useful prewritten code.

The next three sections describe each of the three tools.

Translating your code

You may have heard that computers deal with zeros and ones. That’s certainly true,
but what does it mean? Well, for starters, computer circuits don’t deal directly with
letters of the alphabet. When you see the word Start on your computer screen, the
computer stores the word internally as 01010011 01110100 01100001 01110010
01110100. That feeling you get of seeing a friendly looking five-letter word is your
interpretation of the computer screen’s pixels, and nothing more. Computers break
everything down into very low-level, unfriendly sequences of zeros and ones and
then put things back together so that humans can deal with the results.

So what happens when you write a computer program? Well, the program has to
get translated into zeros and ones. The official name for the translation process is
compilation. Without compilation, the computer can’t run your program.

I compiled the code in Listing 1-1. Then I did some harmless hacking to help me
see the resulting zeros and ones. What I saw was the mishmash in Figure 1-1.

The compiled mumbo jumbo in Figure 1-1 goes by many different names:

¥ Most Java programmers call it bytecode.

¥ | often call it a.class file. That's because, in Java, the bytecode gets stored in
files named SomethingOrOther.class.

¥ To emphasize the difference, Java programmers call Listing 1-1 the source code
and refer to the zeros and ones in Figure 1-1 as object code.
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FIGURE 1-1:

My computer
understands
these zeros and
ones, but | don't.

FIGURE 1-2:
The computer
compiles source
code to create
object code.

)
TECHNICAL
STUFF

To visualize the relationship between source code and object code, see Figure 1-2.
You can write source code and then get the computer to create object code from
your source code. To create object code, the computer uses a special software tool
called a compiler.
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0A00ARA1 PARNBRORA
HA000nA1 BHABABOA
91100101 BAAAAAAL
91191110 91160101
1100181 B1110610Q
91100101 AARBAAAL
111606811 61110660
91191111 611190618
09101000 01061601
H90011160 911108111
A1101111 A100A1114
091101601 61161110
A1100611 A1161111
9111681081 61160101
010160011 9110606001 011611681 01100161 616011600 01161061
91191110 A1100101 AAKARAA1L OPARVEAA VWABN1910 P1010011
URA11AR1111 A111@1681 A111AG10 A11ARA11 11 AG1601 A1AAA1106 |

if (columnNumber > 60)... | Javasourcefile(a .java file)

Compiler

11001010 11111110 Objectfile (a . c1ass file) also known as bytecode

Your computer’s hard drive may have a file named javac or javac.exe. This file
contains that special software tool — the compiler. (Hey, how about that? The
word javac stands for “Java compiler!”) As a Java programmer, you often tell
your computer to build some new object code. Your computer fulfills this wish by
going behind the scenes and running the instructions in the javac file.

Running code

Several years ago, I spent a week in Copenhagen. I hung out with a friend who
spoke both Danish and English fluently. As we chatted in the public park, I vaguely
noticed some kids orbiting around us. I don’t speak a word of Danish, so I assumed
that the kids were talking about ordinary kid stuff.
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WHAT IS BYTECODE, ANYWAY?

Look at Listing 1-1 and at the listing's translation into bytecode in Figure 1-1. You may be
tempted to think that a bytecode file is just a cryptogram — substituting zeros and ones
for the letters in words like i f and else. But it doesn't work that way at all. In fact, the
most important part of a bytecode file is the encoding of a program'’s logic.

The zeros and ones in Figure 1-1 describe the flow of data from one part of your com-
puter to another. | illustrate this flow in the following figure. But remember: This figure is
just an illustration. Your computer doesn’t look at this particular figure, or at anything like
it. Instead, your computer reads a bunch of zeros and ones to decide what to do next.

columnNumber 60

N/

Subtract 60 from columnNumber.
Store the following info:
Is the result negative?
Is the result zero?

result not
negative result is
negative
ot zero result
wrap continue

Don't bother to absorb the details in my attempt at graphical representation in the
figure. It's not worth your time. The thing you should glean from my mix of text, boxes,
and arrows is that bytecode (the stuff in a . class file) contains a complete description
of the operations that the computer is to perform. When you write a computer pro-
gram, your source code describes an overall strategy — a big picture. The compiled
bytecode turns the overall strategy into hundreds of tiny, step-by-step details. When the
computer “runs your program,” the computer examines this bytecode and carries out
each of the little step-by-step details.
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FIGURE 1-3:
What the
computer

gleans from a
bytecode file.

Then my friend told me that the kids weren’t speaking Danish. “What language
are they speaking?” I asked.

“They’re talking gibberish,” she said. “It’s just nonsense syllables. They don’t
understand English, so they’re imitating you.”

Now to return to present-day matters. I look at the stuff in Figure 1-1, and I’'m
tempted to make fun of the way my computer talks. But then I’d be just like the
kids in Copenhagen. What’s meaningless to me can make perfect sense to my
computer. When the zeros and ones in Figure 1-1 percolate through my comput-
er’s circuits, the computer “thinks” the thoughts shown in Figure 1-3.

Get columnNumber from memory.
Get 60 from memory.
Subtract 60 from columnNumber.
Store the following info:
Is the result negative?
Is the result zero?
If the result is negative, then continue.
If the result is not negative, then
check to see if the result is zero.
If the result is zero, then continue.
If the result is not zero, then wrap.

01001110 01110101 01101101 01100010 01100101 01110010
01010100 01100001 01100010 01101100 01100101 00000001
00000000 00001011 01100100 01101001 01110011 01110000
01101100 01100001 01111001 01010111 01101111 01110010

Everyone knows that computers don’t think, but a computer can carry out the
instructions depicted in Figure 1-3. With many programming languages (lan-
guages like C++ and COBOL, for example), a computer does exactly what I’m
describing. A computer gobbles up some object code and does whatever the object
code says to do.
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FIGURE 1-4:

How a computer

18

runs a Java
program.

That’s how it works in many programming languages, but that’s not how it works
in Java. With Java, the computer executes a different set of instructions. The com-
puter executes instructions like the ones in Figure 1-4.

Carry out the first instruction in Figure 1-3.
Carry out the second instruction in Figure 1-3.
Carry out the third instruction in Figure 1-3.
Keep going until you encounter an "If."
When you encounter an "If," then decide which of
the two alternative paths you should follow.
Carry out the instructions in the path that you choose.

The instructions in Figure 1-4 tell the computer how to follow other instructions.
Instead of starting with Get columnNumber from memory, the computer’s first
instruction is, “Do what it says to do in the bytecode file.” (Of course, in the byte-
code file, the first instruction happens to be Get columnNumber from memory.)

There’s a special piece of software that carries out the instructions in Figure 1-4.
That special piece of software is called the Java Virtual Machine (JVM). The JVM
walks your computer through the execution of some bytecode instructions. When
you run a Java program, your computer is really running the JVM. That JVM exam-
ines your bytecode, zero by zero, one by one, and carries out the instructions
described in the bytecode.

Many good metaphors can describe the JVM. Think of the JVM as a proxy, an
errand boy, a go-between. One way or another, you have the situation shown in
Figure 1-5. On the (a) side is the story you get with most programming
languages — the computer runs some object code. On the (b) side is the story with
Java — the computer runs the JVM, and the JVM follows the bytecode’s
instructions.
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FIGURE 1-5:

Two ways to run
a computer
program.

Your computer’s hard drive may have files named javac and java (or javac.exe
and java.exe). A java (or java.exe) file contains the instructions illustrated pre-
viously in Figure 1-4 — the instructions in the JVM. As a Java programmer, you
often tell your computer to run a Java program. Your computer fulfills this wish by
going behind the scenes and running the instructions in the java file.

yov@ thEC‘ode

(a)

WRITE ONCE, RUN ANYWHERE

When Java first hit the tech scene in 1995, the language became popular almost imme-
diately. This happened in part because of the VM. The JVM is like a foreign language
interpreter, turning Java bytecode into whatever native language a particular computer
understands. So if you hand my Windows computer a Java bytecode file, the computer’s
JVM interprets the file for the Windows environment. If you hand the same Java byte-
code file to my colleague’s Macintosh, the Macintosh JVM interprets that same bytecode
for the Mac environment.

Look again at Figure 1-5. Without a virtual machine, you need a different kind of object
code for each operating system. But with the JVM, just one piece of bytecode works on
Windows machines, Unix boxes, Macs, or whatever. This is called portability, and in the
computer-programming world, portability is a precious commaodity. Think about all the
people using computers to browse the Internet. These people don't all run Microsoft
Windows, but each person’s computer can have its own bytecode interpreter — its
own JVM.

The marketing folks at Oracle call it the Write Once, Run Anywhere model of computing.
| call it a great way to create software.
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Code you can use

During the early 1980s, my cousin-in-law Chris worked for a computer software
firm. The firm wrote code for word processing machines. (At the time, if you wanted
to compose documents without a typewriter, you bought a “computer” that did
nothing but word processing.) Chris complained about being asked to write the
same old code over and over again. “First, I write a search-and-replace program.
Then I write a spell checker. Then I write another search-and-replace program.
Then, a different kind of spell checker. And then, a better search-and-replace.”

How did Chris manage to stay interested in his work? And how did Chris’s
employer manage to stay in business? Every few months, Chris had to reinvent the
wheel. Toss out the old search-and-replace program and write a new program
from scratch. That’s inefficient. What’s worse, it’s boring.

For years, computer professionals were seeking the Holy Grail — a way to write
software so that it’s easy to reuse. Don’t write and rewrite your search-and-
replace code. Just break the task into tiny pieces. One piece searches for a single
character, another piece looks for blank spaces, and a third piece substitutes one
letter for another. When you have all the pieces, just assemble these pieces to form
a search-and-replace program. Later on, when you think of a new feature for your
word-processing software, you reassemble the pieces in a slightly different way.
It’s sensible, it’s cost efficient, and it’s much more fun.

The late 1980s saw several advances in software development, and by the early
1990s, many large programming projects were being written from prefab compo-
nents. Java came along in 1995, so it was natural for the language’s founders to
create a library of reusable code. The library included about 250 programs, includ-
ing code for dealing with disk files, code for creating windows, and code for pass-
ing information over the Internet. Since 1995, this library has grown to include
more than 4,000 programs. This library is called the Application Programming
Interface (API).

Every Java program, even the simplest one, calls on code in the Java API. This Java
API is both useful and formidable. It’s useful because of all the things you can do
with the API’s programs. It’s formidable because the API is extensive. No one
memorizes all the features made available by the Java API. Programmers remem-
ber the features that they use often and look up the features that they need in a
pinch. They look up these features in an online document called the API Specifica-
tion (known affectionately to most Java programmers as the API documentation, or
the Javadocs).

The API documentation (see http://docs.oracle.com/javase/8/docs/api)
describes the thousands of features in the Java APIL. As a Java programmer, you
consult this API documentation on a daily basis. You can bookmark the
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documentation at the Oracle website and revisit the site whenever you need to look
up something, or you can save time by downloading your own copy of the API docs
using the links found at www . oracle.com/technetwork/ java/javase/downloads/
index.html.

Your Java Programming Toolset

©

REMEMBER

To write Java programs, you need the tools described previously in this chapter:

3 You need a Java compiler. (Refer to the section “Translating your code.”)

¥ You need a JVM. (Refer to the section “Running code.”)

¥ You need the Java API. (Refer to the section “Code you can use.”)

¥ You need access to the Java APl documentation. (Again, refer to the “Code

you can use” section.)

You also need some less exotic tools:

»

»

You need an editor to compose your Java programs. Listing 1-1 contains
part of a computer program. When you come right down to it, a computer
program is a big bunch of text. So, to write a computer program, you need an
editor — a tool for creating text documents.

An editor is a lot like Microsoft Word, or like any other word processing
program. The big difference is that an editor adds no formatting to your
text — no bold, italic, or distinctions among fonts. Computer programs have
no formatting whatsoever. They have nothing except plain old letters,
numbers, and other familiar keyboard characters.

When you edit a program, you may see bold text, italic text, and text in several
colors. But your program contains none of this formatting. If you see stuff that
looks like formatting, it's because the editor that you're using does syntax
highlighting. With syntax highlighting, an editor makes the text appear to be
formatted in order to help you understand the structure of your program.
Believe me, syntax highlighting is very helpful.

You need a way to issue commands. You need a way to say things like
“compile this program” and “run the JVM."” Every computer provides ways of
issuing commands. (You can double-click icons or type verbose commands in
a Run dialog box.) But when you use your computer’s facilities, you jump from
one window to another. You open one window to read Java documentation,
another window to edit a Java program, and a third window to start up the
Java compiler. The process can be tedious.
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A tool for creating code

In the best of all possible worlds, you do all your program editing, documentation
reading, and command issuing through one nice interface. This interface is called
an integrated development environment (IDE).

A typical IDE divides your screen’s work area into several panes — one pane for
editing programs, another pane for listing the names of programs, a third pane
for issuing commands, and other panes to help you compose and test programs.
You can arrange the panes for quick access. Better yet, if you change the informa-
tion in one pane, the IDE automatically updates the information in all the other
panes.

An IDE helps you move seamlessly from one part of the programming endeavor to
another. With an IDE, you don’t have to worry about the mechanics of editing,
compiling, and running a JVM. Instead, you can worry about the logic of writing
programs. (Wouldn’t you know it? One way or another, you always have some-
thing to worry about!)

In the chapters that follow, I describe basic features of the Eclipse IDE. Eclipse has
many bells and whistles, but you can ignore most of them and learn to repeat a
few routine sequences of steps. After using Eclipse a few times, your brain auto-
matically performs the routine steps. From then on, you can stop worrying about
Eclipse and concentrate on Java programming.

As you read my paragraphs about Eclipse, remember that Java and Eclipse aren’t
wedded to one another. The programs in this book work with any IDE that can run
Java. Instead of using Eclipse, you can use Intelli] IDEA, NetBeans, Blue]J, or any
other Java IDE. In fact, if you enjoy roughing it, you can write and run this book’s
programs without an IDE. You can use Notepad, TextEdit or vi, along with your
operating system’s command prompt or Terminal. It’s all up to you.

What's already on your hard drive?

You may already have some of the tools you need for creating Java programs. But,
on an older computer, your tools may be obsolete. Most of this book’s examples
run on all versions of Java. But some examples don’t run on versions earlier than
Java 5.0. Other examples run only on Java 6, Java 7, Java 8, or later.

The safest bet is to download tools afresh. To get detailed instructions on doing
the downloads, see Chapter 2.
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Chapter 2

Setting Up Your
Computer

his chapter goes into much more detail than you normally need. If you’re

like most readers, you’ll follow the steps in the “If You Don’t Like Reading

Instructions . . .” section. Then you’ll jump to the “Importing This Book’s
Sample Programs” section, near the end of this chapter. With about 20 percent of
this chapter’s contents, you’ll have 100 percent of the required software.

Of course, there are always glitches. One person has an older computer. Another
person has some conflicting software. Joe has a PC and Jane has a Mac. Joe’s PC
runs Windows 10 but Janis runs Windows 8. Joe misreads one of my instructions
and, as a result, nothing on his screen matches the steps that I describe. Eighty
percent of this chapter describes the things you do in those rare situations in
which you must diagnose a problem.

If you find yourself in a real jam, there’s always an alternative. You can send
an email to me at BeginProg@allmycode.com. You can also find me on Facebook
at /allmycode or on Twitter at @allmycode. I’'m happy to answer questions and
help you figure out what’s wrong.

So, by all means, skip anything in this chapter that you don’t need to read. You

won’t break anything by following your instincts. And if you do break anything,
there’s always a way to fix it.
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If You Don’t Like Reading
Instructions...

To start writing Java programs, you need the software that I describe in Chapter 1:
a Java compiler and a Java Virtual Machine (JVM, for short). You can also use a
good integrated development environment (IDE) and some sample code to get you
started.

All the software you need for writing Java programs is free. The software comes as
three downloads: one from this book’s website, another from Oracle, and a third
from eclipse.org.

Here’s how you get the software for creating Java programs:

1. visitwww.al Imycode . com/BeginProg and download a file containing all
program examples in this book.

2. Visitwww.oracle. com/technetwork/ java/ javase/downloads and get the
latest available version of the JDK.

At the top of the page, you might see links and buttons for Java 8. That's okay,
but to get the most from this book’s content, | recommend Java 9. With Java 9,
you can run JShell, a new interactive environment for testing Java features. If
Oracle’s web page highlights Java 8, scroll down to find an early access preview
of Java 9. Follow the links and buttons to get the cutting edge technology.

Choose a version of the software that matches your operating system
(Windows, Macintosh, or whatever). If you have trouble choosing between the
JRE and the JDK, pick the JDK.

If you run Windows and you have trouble choosing between 32-bit software
and 64-bit software, flip a coin and make a note of your choice. (If you make
the wrong choice, you'll get an error message when you try to install Java or
when you try to launch the Eclipse IDE.)

Most people who have trouble with this chapter’s instructions have installed
@ either 32-bit Java with 64-bit Eclipse or 64-bit Java with 32-bit Eclipse. If you

experience pain when you get to Step 6, download and install alternative
REMEMBER versions of Java or Eclipse.

3. Find the icon representing the Java software that you downloaded in
Step 2. Double-click the icon to begin installing Java.
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7.

If you're in a hurry (and who isn't?), you may benefit from a quick visit to
http://java.com. Thehttp://java.com website offers a hassle-free, 1-click
Java installer. (Simply click the big Java Download button. You can't miss it.) The
Java Download button doesn't work on all computers. But if it works for you,
with a wave of a virtual magic wand, you're finished with this step. You can
bypass the complexities of the java.oracle.com website and move immedi-
ately to Step 4.

Visithttp://eclipse.org/downloads and get the Eclipse IDE.

Most of the time, Eclipse’s website automatically checks your computer’s
operating system and offers you a download that's optimized for your system.
But if the website gives a choice, select Eclipse IDE for Java Developers.

The resulting download is either an executable installer file (with the .exe
extension) or a compressed archive file (with the . zip or .tar.gz extension).

If you downloaded an . exe file in Step 4, double-click this file’s icon to
begin the installation of Eclipse.

If you downloaded a .zip file or a . tar.gz file in Step 4, extract the
contents of this compressed archive.

If you have a compressed archive, you see a folder named eclipse or
Eclipse.app when you uncompress it. Copy this folder to a handy place on
your computer’s hard drive. For example, on my Windows computer, | end up
with aC: \eclipse folder. On my Mac, | end up with anEclipse orEclipse.
app icon inside my Applications folder.

In Windows, the blank space in the name Program Files confuses some Java
software. | don't think any of this book’s software presents such a problem, but
| can't guarantee it. If you want, extract Eclipse to your C: \Program Files or
C:\Program Files (x86) folder. But make a mental note about your choice
(in case you run into any trouble later).

Launch Eclipse and click the Welcome screen’s Workbench icon.

Initially, the Welcome screen’s icons may have no text labels. But when you
hover over an icon, a tooltip appears. Select the icon whose tooltip has the title
Workbench.

In Eclipse, import the code that you downloaded in Step 1.

For details about any of this stuff, see the next several sections.
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THOSE PESKY FILENAME EXTENSIONS

The filenames displayed in Windows File Explorer or in a Finder window can be mislead-
ing. You may browse one of your directories and see the name Mortgage. The file's real
name might be Mortgage . java, Mortgage . class, Mortgage . somethingElse, or plain
old Mortgage. Filename endings like .zip, . java, and .class are called filename
extensions.

The ugly truth is that, by default, Windows and Macs hide many filename extensions.
This awful feature tends to confuse programmers. So, if you don't want to be confused,
change your computer's system-wide settings. Here's how you do it:

® In Windows 10: In the taskbar's Search box, type File Explorer Options. On the list
of choices that appears, choose File Explorer Options. Then follow the instructions
in the In All Versions of Windows bullet.

® In Windows 8: On the Start screen, hold down the Windows key while pressing
Q. In the resulting search box, type Folder Options and then press Enter. Then
follow the instructions in the In All Versions of Windows bullet.

® In Windows 7: Choose Start = Control Panel &> Appearance and
Personalization = Folder Options. Then follow the instructions in the In All Versions
of Windows bullet.

® |n all versions of Windows (7 and newer): Follow the instructions in one of the
preceding bullets. Then, in the Folder Options (or File Explorer Options) dialog box,
click the View tab. Look for the Hide File Extensions for Known File Types option.
Make sure that this check box is not selected.

® In Mac OS X: On the Finder application’s menu, select Preferences. In the resulting
dialog box, select the Advanced tab and look for the Show All File Extensions option.
Make sure that this check box is selected.

® |n Linux: Linux distributions tend not to hide filename extensions. So, if you use
Linux, you probably don't have to worry about this. But | haven't checked all Linux
distributions. So, if your files are named Mortgage instead of Mortgage. java or
Mortgage.class, check the documentation specific to your Linux distribution.

Getting This Book’s Sample Programs

To get copies of this book’s sample programs, visit http://allmycode.com/
BeginProg and click the link to download the programs in this book. Save the
download file (BeginProgJavaDummies5.zip) to your computer’s hard drive.
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COMPRESSED ARCHIVE FILES

When you visitwww . al Imycode . com/BeginProg and you download this book’s

Java examples, you download a file named BeginProgJavaDummies5.zip. A .zip
file is a single file that encodes a bunch of smaller files and folders. For example, my
BeginProgJavaDummies5. zip file encodes folders named 06-01, 96-02, and so on.
The 06-02 folder contains some subfolders, which in turn contain files. (The folder
named @6-02 contains the code in Listing 6-2 — the second listing in Chapter 6.)

A .zip file is an example of a compressed archive file. Some other examples of
compressed archives include . tar . gz files, . rar files, and . cab files. Uncompressing
a file means extracting the original files stored inside the big archive file. (For a

.zip file, another word for uncompressing is unzipping.) Uncompressing normally
re-creates the folder structure encoded in the archive file. So, after uncompressing my
BeginProgJavaDummies5. zip file, your hard drive has folders named 06-01, 06-02,
with subfolders named src and bin, which in turn contain files named SnitSoft.
java, SnitSoft.class, and so on.

When you download BeginProgJavaDummies5. zip, your web browser may uncom-
press the file automatically for you. If not, you can see the . zip file's contents by double-
clicking the file's icon. (In fact, you can copy the file's contents and perform other file
operations after double-clicking the file's icon.) One way or another, don't worry about
uncompressing my BeginProgJavaDummies5. zip file. When you follow this chapter’s
instructions, you import the contents of my BeginProgJavaDummies5 . zip file into the
Eclipse IDE. And behind the scenes, Eclipse’s import process uncompresses the . zip file.

In some cases, you click a download link but your web browser doesn’t offer you
the option to save a file. If this happens to you, right-click the link (or Control-
click on a Mac). On the resulting context menu, select Save Target As, Save Link
As, Download Linked File As, or a similarly labeled menu item.

Most web browsers save files to a Downloads directory on your computer’s
hard drive. But your browser may be configured a bit differently. One way or
another, make note of the folder containing the downloaded BeginProgJava
Dummies5.zip file.

Up Java

You can get the latest, greatest versions of Java by visiting www.oracle.com/
technetwork/ java/javase/downloads. Look for the newest available version of
the JDK. Select a version that runs on your computer’s operating system.
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FIGURE 2-1:
Getting the
Java JDK.

REMEMBER

Figure 2-1 shows me clicking a Download JDK button (circa March 2014) at the
Oracle website. When you visit the site, the page on your computer screen prob-
ably looks a lot like Figure 2-1, but you might see Java SE 9 instead of Java SE 8.

¥ Ifyou see Java 9, go for it.

¥ If you see Java 8 instead of Java 9, scroll down to find an early access Java 9
preview.

With plain, old Java 8, you can run all the programs in this book. But if you
have Java 9, you can use JShell — a tool for experimenting quickly and easily
with snippets of Java's code.

Java Platform ¢JDIK) 8

Crveryi et Downloadds Documentation Cummunlt\r Technologles Tralnlng
Java SE Downloads
=’ |ava % NetBeans

JDK 8 & NetBeans 8.0

| Java Flatform, Standard Edition |

JavaSES

This new major release contains several new features and enhancements that increase the
performance of existing applications, make it easier to develop applications for modemn
platiorms, and increase maintainability of code.

Learn more »

= Installation Instructions JDK 8

= Release Notes “

= Oracle License

* Java 5E Products Server JRE
8

+ Third Party Licenses

= Cerified System Configurations

= Readme Files
= JDK Readhe JRE 8
= JRE Readhe

The Oracle and Eclipse websites that I describe in this chapter are always chang-
ing. The software that you download from these sites changes, too. A specific
instruction such as “click the button in the upper-right corner” becomes obsolete
(and even misleading) in no time at all. So in this chapter, I provide long lists of
steps, but I also describe the ideas behind the steps. Browse each of the suggested
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sites and look for ways to get the software that I describe. When a website offers
you several options, check the instructions in this chapter for hints on choosing
the best option. If your computer’s Eclipse window doesn’t look quite like the
window in this chapter’s figures, scan your computer’s window for whatever
options I describe. If, after all that, you can’t find what you’re looking for, check
this book’s website (www.allmycode.com/BeginProg) or send an email to me at
BeginProg@al 1mycode . com.

If you can’t identify the most appropriate Java version or if you want to know what
the acronyms JRE and JDK stand for, see the later sidebar entitled “Eenie, meenie,
miney mo.”

Downloading and installing Java

After you accept a license agreement and click a link to a Java installation file, your
computer does one of two things:

3 Downloads and installs Java on your system

¥ Downloads the Java installation file and saves the file on your computer’s hard
drive

If the installation begins on its own, follow the instructions, answer Yes to any
prompts, and (unless you have good reason to do otherwise) accept the defaults.
If the installation doesn’t begin on its own, start the installation by double-
clicking the downloaded installation file.

If your computer runs Linux, the downloaded file might be a .tar.gz file.
A .tar.ggz file is a compressed archive. Extract the archive’s contents to a folder
of your choice and follow the installation instructions posted on the Oracle
website.

For more information about filenames, file types, and archives, see the earlier
sidebars entitled “Those pesky filename extensions” and “Compressed archive
files” in this chapter.

While you’re visiting www.oracle.com/technetwork/java/javase/downloads,
you can also download a copy of the Java API documentation. Look for a download
labeled Java SE Documentation (or something like that). Accept the license agree-
ment, click the download link, and watch the file flow downward onto your
computer’s hard drive. The downloaded file is a compressed .zip archive, so
you can uncompress it the way you uncompress all other such archives. (The
uncompressed folder is a bunch of web pages. To start reading the Java API docu-
mentation, look in that folder for an index file or an index.htm1 file. Double-click
the file, and you’re on your way.)
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EENIE, MEENIE, MINEY MO

The Java Standard Edition download page (www .oracle.com/technetwork/java/
javase/downloads) has many options. If you're not familiar with these options, the
page can be intimidating. Here are some of the choices on the page:

® Word length: 32-bit or 64-bit

You may have to choose between links labeled for 32-bit systems and links labeled
for 64-bit systems. If you don't know which to choose, start by trying the 32-bit
version. (For more information about 32-bit systems and 64-bit systems, see the
later sidebar “How many bits does your computer have?”)

® Java version number

The Java download page may have older and newer Java versions for you to choose
from. You may see links to Java SE 7, Java SE 8, Java SE 9u4, and many others.
(Numbering such as 9u4 stands for the fourth update to Java 9.) If you're not sure
which version number you want, choosing the highest version number is probably
safe. For additional help with the decision, consider these facts:

® |f you have Java 9 or higher, you're okay.

® |f the only Java versions that you have are older than Java 7 (including Java 1.4.2,
Java 5.0, and Java 6), your computer can run some but not all of the programs in
this book.

® |f you have Java 7 or Java 8 but not Java 9, your computer can run all the pro-
grams in this book but you can't run Java's JShell tool. | introduce JShell in
Chapter 6. You can learn all about Java without ever running JShell. But JShell is
handy and it's fun to use.

The numbering of Java's versions is really confusing. First comes Java 1.0, and
then Java 1.1, and then Java 2 Standard Edition 1.2 (J2SE 1.2). Yes, the “Java 2"
numbering overlaps partially with the “1.x" numbering. Next come versions 1.3
and 1.4. After version 1.4.1 comes version 1.4.2 (with intermediate stops at ver-
sions like 1.4.1_02). After 1.4.2_06, the next version is version 1.5, which is also
known as version 5.0. (That's no misprint. Version 5.0 comes immediately after
the 1.4 versions.)

The formal name for version 1.5 is Java 2 Platform, Standard Edition 5.0. And to
make matters even worse, the next big release is Java Platform, Standard Edition
6 with the 2 removed from Java 2 and the .0 missing from 6.0. That's what hap-
pens when a company lets marketing people call the shots.


http://www.oracle.com/technetwork/java/javase/downloads
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Mercifully, from Java 6 onward, the version numbers settle into a predictable pat-
tern. After Java 6 comes Java Platform, Standard Edition 7 and then Java Platform,
Standard Edition 8 with updates such as 8u2 (Java 8, update 2). And starting with
Java 9, there's no longer such a thing as version 1.9. Now it's plain old version 9.

® JDK versus JRE

The download page offers you a choice between the JDK (Java Development Kit)
and the JRE (Java Runtime Environment). The JDK download contains more stuff
than the JRE download. The JRE includes a Java Virtual Machine and the application
programming interface. (Refer to Chapter 1.) The JDK includes everything in the JRE,
and in addition, the DK includes a Java compiler. (Again, refer to Chapter 1.)

The Eclipse IDE contains its own Java compiler. So you can survive by downloading
the smaller JRE (and avoiding the big JDK download). But | recommend downloading
the entire JDK. Why? Because you never know when another compiler (separate
from Eclipse) will come in handy. Besides, the installation and configuration of
Eclipse on a Mac can be convoluted if you haven't installed the full JDK. So, if you
want to have a smooth ride, download the JDK instead of the JRE.

By the way, another name for the JDK is the Java SDK — the Java Software
Development Kit. Some people still use the SDK acronym, even though the folks at
Oracle don't use it any more. (Actually, the original name was the JDK. Later, Sun
Microsystems changed it to the SDK. A few years after that, the captains of Java
changed it back to the name JDK. This constant naming and renaming drives me
crazy as an author.)

® Java SE, Java EE, and Java ME

While you wander around, you may notice links labeled Java EE or Java ME. If you
know what these are, and you know you need them, by all means, download these
goodies. But if you're not sure, bypass both the Java EE and the Java ME links.
Instead, follow links to the Java SE (Java Standard Edition).

The abbreviation Java EE stands for Java Enterprise Edition, and Java ME stands for
Java Micro Edition. The Enterprise Edition has software for large businesses, and
the Micro Edition has software for handheld devices. (Google's Android software
bears a passing resemblance to Java's Micro Edition, but in many ways, Android and
Java ME are very different animals.)

You don't need the Java EE or the Java ME to run any of the examples in this book.
® Additional Java-related software

You can download Java alone, or you can download Java with Oracle’s NetBeans
IDE. You can download a collection of demos and samples. You can probably even
download Java with fries and a soft drink. You can download plenty of extra stuff,
but in truth, all you need is the Java JDK.
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@ For an introduction to the Java API documentation, refer to Chapter 1.

TIP Most people have no difficulties visiting the Oracle website java.oracle.com and
installing Java using the website’s menus. But if your situation is more
“interesting” than most, you may have to make some decisions and perform
some extra steps. The next few sections describe some of these “interesting”
scenarios.

HOW MANY BITS DOES YOUR
COMPUTER HAVE?

As you follow this chapter’s instructions, you may be prompted to choose between two
versions of a piece of software — the 32-bit version and the 64-bit version. What's the
difference, and why should you care?

A bitis the smallest piece of information that you can store on a computer. Most people
think of a bit as either a zero or a one, and that depiction of “bit” is quite useful. To rep-
resent almost any number, you pile several bits next to one another and do some fancy
things with powers of two. The numbering system'’s details aren’t showstoppers. The
important thing to remember is that each piece of circuitry inside your computer stores
the same number of bits. (Well, some circuits inside your computer are outliers with
their own particular numbers of bits, but that's not a big deal.)

In an older computer, each piece of circuitry stores 32 bits. In a newer computer, each
piece of circuitry stores 64 bits. This number of bits (either 32 or 64) is the computer’s
word length. In a newer computer, a word is 64 bits long.

“Great!” you say. “I bought my computer last week. It must be a 64-bit computer.” Well,
the story may not be that simple. In addition to your computer’s circuitry having a word
length, the operating system on your computer also has a word length. An operating
system’s instructions work with a particular number of bits. An operating system with
32-bit instructions can run on either a 32-bit computer or a 64-bit computer, but an
operating system with 64-bit instructions can run only on a 64-bit computer. And to
make things even more complicated, each program that you run (a web browser, a
word processor, or one of your own Java programs) is either a 32-bit program or a
64-bit program. You may run a 32-bit web browser on a 64-bit operating system run-
ning on a 64-bit computer. Alternatively, you may run a 32-bit browser on a 32-bit oper-
ating system on a 64-bit computer. (See the figure that accompanies this sidebar.)
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— 32-bit computer
— 32-bit operating system
|— 32-bit software

— 64-bit computer
— 32-bit operating system

|— 32-bit software —|

— 64-bit computer
64-bit operating system

|- 32-bit software —| |- 64-bit software —|

When a website makes you choose between 32-bit and 64-bit software versions, the
main consideration is the word length of your operating system, not the word length of
your computer’s circuitry. You can run a 32-bit word processor on a 64-bit operating
system, but you can’t run a 64-bit word processor on a 32-bit operating system (no
matter what word length your computer’s circuitry has). Choosing 64-bit software has
one big advantage — namely, that 64-bit software can access more than 3 gigabytes of
a computer's fast random access memory. And in my experience, more memory means
faster processing.

How does all this stuff about word lengths affect your Java and Eclipse downloads?
Here's the story:
® |fyou run a 32-bit operating system, you run only 32-bit software.

® |fyou run a 64-bit operating system, you probably run some 32-bit software and
some 64-bit software. Most 32-bit software runs fine on a 64-bit operating system.

® On a 64-bit operating system, you might have two versions of the same program.
For example, on my Windows computer, | have two versions of Internet Explorer —
a 32-bit version and a 64-bit version.

Normally, Windows puts 32-bit programs in its Program Files (x86) directory
and puts 64-bit programs in its Program Files directory.

(continued)
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® A chain of word lengths is as strong as its weakest link. For example, when |
visithttp://java.com and click the site’s Do | Have Java? link, the answer | get
depends on the match between my computer’s Java version and the web browser
that I'm running. With only 64-bit Java installed on my computer, the Do | Have Java?
link in my 32-bit Firefox browser answersNo working Java was detected on
your system. But the same link in my 64-bit Internet Explorer answers You have
the recommended Java installed.

On a Mac, Safari and Firefox are 64-bit browsers, but Chrome is a 32-bit browser.
So on a Magc, you're likely to see slightly different behavior when using Firefox
versus Chrome.

® Here's the most important thing to remember about word lengths: When you
follow this chapter’s instructions, you get Java software and Eclipse software on
your computer. Your Java software’s word length must match your Eclipse soft-
ware's word length. In other words, 32-bit Eclipse runs with 32-bit Java, and 64-bit
Eclipse runs with 64-bit Java. | haven't tried all possible combinations, but when |
try to run 32-bit Eclipse with 64-bit Java, | see a misleading No Java virtual
machine was found error message.

® Finally, some websites use unintuitive names for their software downloads. If you
see j365 or i586 in the name of a download, that usually means 32-bit. If you see x86
without the number 64 anywhere in a download’s name, that also means 32-bits. If
you see 64 in the name (with or without the x86 designation), that indicates a 64-bit
program.

If you want to find Java on
your computer ...

Chapter 1 describes the Java ecosystem with its compiler, its virtual machine, and
its other parts. Your computer may already have some of these Java gizmos. If so,
you can either live with what you already have or add the newest version of Java
to whatever is already on your system. If you need help deciding what to do, refer
to the sidebar entitled “Eenie, meenie, miney mo.”

Java’s versions aren’t like indoor cats — they can coexist on the same computer

=I5 without fighting or hissing at one another. If you have more than one version of
\J Java on your computer, you’re okay. You can even mix 32-bit versions and 64-bit
TecunicaL  versions on the same computer (as long as you have at least one Java version
STUFF whose word length matches your Eclipse version). I have three versions of Java on
my Windows 10 computer, and I never run into trouble. (Occasionally, I cause my

own trouble by confusing one version of Java for another. But this chapter’s later
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FIGURE 2-2:
The Programs
and Features
dialog box on
Windows.

section “Configuring Java in Eclipse” helps me sort things out. What would I do
without this book by my side?)

To find out what you already have and possibly avoid reinstalling Java, keep
reading.

On Windows 10

In the taskbar’s Search box, type Programs and Features. In the list of choices
that appears, choose Programs and Features. A list of installed programs appears.
In that list, look for items labeled Java. (See Figure 2-2.)

|£/Java & Update 91 Oracle Corporation 6/2/2016 178 MB  8.0.810.15
| £|Java & Update 91 (B4-bit) Oracle Corperation 6/2/2016 204MB  8.0.810.15
|| Java 9 (64-bit) Oracle Corporation 12/15/2016 136MB  9.0.0.0
| £/)ava SE Development Kit 8 Update 91 Oracle Corporation 6/2/2016 520MB  8.0.910.15
|£:/)ava SE Development Kit & Update 91 (64-bit) Oracle Corporation 6/2/2016 538MB  8.0.810.15
&< Java to C++ Converter (Free Edition) Tangible Software Solutions 12/13/2015 148 MB
|22/ Java(TM) SE Development Kit 9 (64-bit) Oracle Corporation 12/15/2016 535MB  9.0.00
T JavaFX Scene Builder 2.0 Oracle 97472015 287MB 20
[ )Creator LE 5.00 Kinox Software 9/21/2013 223 MB
@JGRASP Auburn University 9/27/2016 850MB 2.0.2 Beta
[®ljruler 9/27/2016 236 KB
.
On Windows 8

On the Start screen, hold down the Windows key while pressing Q. In the resulting
search box, type Programs and Features and then press Enter. A list of installed
programs appears. In that list, look for items labeled Java. (Refer to Figure 2-2.)

On Windows 7

Select Start=> Control Panel > Programs Programs and Features. A list of installed
programs appears. In that list, look for items labeled Java. (Refer to Figure 2-2.)

On a Mac

A Macintosh computer can support two different flavors of Java: a flavor devel-
oped in-house at Apple, Inc., and another flavor developed under Oracle’s aus-
pices. Certain commands and procedures apply to one flavor of Java but not to the
other. For example, to find Apple’s version of Java, you look in the /System/
Library/Java/Java Virtual Machines directory or the /System/Library/
Frameworks/JavaVM. framework/Versions directory. But to find Oracle’s Java,
you look in the /Library/Java/JavaVirtualMachines directory. You might also
find Oracle’s Java in the /Library/Internet Plug-Ins/JavaAppletPlugin.
plugin/Contents/Home directory.
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Tiger, Leopard, and Snow Leopard (OS X 10.4, OS X 10.5, and OS X 10.6) have Java
preinstalled. Java isn’t preinstalled on later Mac operating systems. On these later
systems, the computer prompts you to install either Apple’s Java or Oracle’s Java
the first time you launch an application that requires Java. (For example, later in
this chapter, you install Eclipse. When you first try to launch Eclipse, if you haven’t
already installed Java, your computer advises you to do so.)

Table 2-1 describes the correlations between Mac OS and Java versions.

TABLE 2-1 Mac OS X Versions and Java Versions
Then You Have This And You Can Install

If You Have This Mac OS X Version . .. Version of Java. .. This Java Version

0S X 10.4.11 (Tiger) Apple’s Java 5.0 Apple's Java 5.0
0OS X 10.5.8 (Leopard) PowerPC and/or 32-bit

0OS X 10.5.8 (Leopard) Intel-based and 64-bit Apple’s Java 6 Apple's Java 6
0S X 10.6.8 (Snow Leopard)

0S X 10.7.5 (Lion) (no Java) Apple’s Java 6
0S X 10.8.5 (Mountain Lion) Oracle’s Java 9

0OS X 10.9 (Mavericks)
0S X 10.10 (Yosemite)
OS X 10.11 (El Capitan)
macOS 10.12 (Sierra)

To find out which version of OS X you’re running, do the following:

1. choose Apple=> About This Mac.
2. Inthe About This Mac dialog that appears, look for the word Version.

You see Version 10.12.4 (or something like that) in faint gray text.

regularly apply software updates, you may be running OS X 10.8.1 instead of 10.8.5.

The information in Table 2-1 applies to updated versions of Mac OS X. If you don’t
If so, select Software Update in the Apple menu and follow the resulting prompts.

0S X 10.3 and other ways to circumvent the restrictions in Table 2-1. But if you
don’t like to tinker, these workarounds aren’t for you. (For every hardware or

TP software requirement, someone tries to create a workaround, or hack. Anyway,
apply hacks at your own risk.)

‘ Here and there on the web, I see postings describing ways to install Java 5.0 on
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FIGURE 2-3:

The Java
Preferences
application.

If you don’t trust Table 2-1 (and frankly, you shouldn’t trust everything you find
in print), you can perform tests on your computer to discover the presence of Java
and (if your Mac has Java) the Java version number. Here are some tests:

WITH OS X 10.6 OR EARLIER

1.
2.

In the Spotlight's search field, type Java Preferences.
When the Spotlight's top hit is Java Preferences, press Enter.

The Java Preferences window appears. (See Figure 2-3.)

800 Java Preferences

Security = Network | Advanced |

[_] Enable applet plug-in and Web Start applications

Java applications, applets, and command line tools use this order to determine the first compatible version to
use.

On | Name Vendor CPU-Type Version

[2] Java SE 7 Dewveloper Preview Oracle Corpora... 64-bit 1.7.0-ea-b219

E] Java SE 7 Dewveloper Preview Oracle Corpora.__ 32-bit 1.7.0-ea-h219

@] Java SE & (System) Apple Inc. B4-bit 1.6.0_29-b11-402
[9] Java SE & (System) Apple Inc. 32-bit 1.6.0_29-b11-402

Drag to change the preferred order

Options.. | Restore Defaults

Changes take effect in browsers and Java applications the next time you open them.

The Java Preferences window lists versions of Java that are installed on

your computer.

In Figure 2-3, the computer has four versions of Java: the 32-bit (i386) versions
of Java 6 and Java 7 and the 64-bit (x86_64) versions of Java 6 and Java 7.

WITH OS X 10.7 OR LATER

1.
2.

On the Apple menu, select System Preferences.

In the System Preferences application window, click the Java

icon.

The Java Control Panel appears. It looks like the panel in Figure 2-4 or the one

in Figure 2-5.
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[ JoN ] |2 Java Control Panel

Update Desktop Settings Web Settings =~ Security Advanced

Version 9-ea (build 9-ea+187) x86_64
Copyright {c) 2017, Oracle andjor its affiliates. All rights reserved.

Current JRE meets the Security Baseline and Expiration Date (explanation)
Security Baseline: 9

Expiration Date: Oct 26, 2017
FIGURE 2-4:

For more information about Java technology and to explore great Java applications, visit https://java.com

Your Java Control
Panel might
look like this.

Java Control Panel

Update | Java | Security | Advanced |

About
View version information about Java Control Panel.

[ About... |
MNetwork Settings

Network settings are used when making Internet connections. By default, Java

will use the network settings in your web browser. Only advanced users should
modify these settings.

| Metwork Settings... |
Temporary Internet Files
Files you use in Java applications are stored in a special folder for quick

execution later. Only advanced users should delete files or modify these
settings.

| Settings... | | View...

Java in the browser is enabled. See the Security tab

FIGURE 2-5:
Another
incarnation

of the Java
Control Panel.

| ok | | cancel | Apply

3. i your Java Control Panel looks like the panel in Figure 2-4, you see your
computer’s Java version on the panel's General tab.

According to the panel shown in Figure 2-4, my computer has an early access
(ea) version of Java 9. You can skip the rest of these steps.

4. your Java Control Panel looks like the panel in Figure 2-5, select the
panel's Java tab. (See Figure 2-6.)
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FIGURE 2-6:
The Java tab
in the Java
Control Panel.

FIGURE 2-7:

The User tab in
the Java Runtime
Environment
Settings window.

Java Control Panel

View

applets.

| General = Update Security | Advanced |

and manage Java Runtime versions and settings for Java applications and

[ OK ] | Cancel | Apply

5. on the Java tab, click View.

The Java Runtime Environment Settings window appears. (See Figure 2-7.)

8 00 Java Runtime Environment Settings

!lg System |

Platform Product Location Path Runtime Parameters

L8

1.8.0 hrep://java.s... [JLibrary/Internet Plu.. ]

[ OK ] | Cancel |

6.

Look for versions of Java on the User tab and the System tab of the Java
Runtime Environment Settings window.

Figure 2-7 shows the User tab of the Java Runtime Environment Settings
window. According to the figure, the computer runs Java 1.8. (Java’s close
friends call this version “Java 8.")
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On Linux

To check your Java installation (or your lack of Java) on a Linux computer, do the
following:

1. Pokearound among the desktop’s menus for something named Terminal
(also known as Konsole).

A Terminal window opens (usually, with plain white text on a plain black
background).

2. Inthe Terminal window, type the following text and then press Enter:
java -version.

On one of my Linux computers, the Terminal window responds with the
following text:

java version 1.8.0_111

On another Linux computer, | see this:

java version 9

Between Java 8 and Java 9, Oracle changed its version numbering system. So
version 9 comes immediately after the 1.8.0 versions. Anyway, if your com-
puter responds with the number 9 or higher, you can pop open the cham-
pagne and look forward to some good times running this book’s examples.

If the version number is 1.5 or greater, you can run many, but not all, of this
book's examples. If your computer responds with something like command not
found, most likely, Java isn't installed on your computer.

Setting Up the Eclipse Integrated
Development Environment

40

In the previous sections, you get all the tools your computer needs for processing
Java programs. This section is different. In this section, you get the tool that you
need for composing and testing your Java programs. You get Eclipse — an inte-
grated development environment for Java.

An integrated development environment (IDE) is a program that provides tools to
help you create software easily and efficiently. You can create Java programs
without an IDE, but the time and effort you save using an IDE makes the IDE
worthwhile. (Some hard-core programmers disagree with me, but that’s another
matter.)
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FIGURE 2-8:
The home page
for eclipse.org.

According to the Eclipse Foundation’s website, Eclipse is “a universal tool
platform — an open extensible IDE for anything and nothing in particular.”
Indeed, Eclipse is versatile. Programmers generally think of Eclipse as an IDE for
developing Java programs, but Eclipse has tools for programming in C++, PHP,
and many other languages.

I've even seen incarnations of Eclipse that have nothing to do with program
development. For example, Dynatrace has an application that monitors the per-
formance of large systems. When you run Dynatrace’s application on a desktop
computer, you’re running a dressed-up version of Eclipse.

Downloading Eclipse

Here’s how you download Eclipse:

1. visitwww.ecl ipse.org.

Today, | visitwww. eclipse.org and see a big button displaying the word
Download. (See Figure 2-8.) Tomorrow, who knows what I'll see on this ever-
changing website!

Welcome, BarryBurd (& Editmyaccount O Log out

= eclipse corernsewn [0

GETTING STARTED MEMBERS PROJECTS MORE~

Eclipse Is...

An amazing open source community of Toels, Projects and
Collaborative Working Groups. Discover what we have to offer and join us.

One way or another, you probably see a Download button of some kind.
2. Cclick the Download button.

After clicking the Download button, you might find a few download options.
(See Figure 2-9.)

A new version of Eclipse appears every year in June, and the version names
are ordered alphabetically. In June 2016, the name is Neon. In June 2017, it's
Oxygen. In June 2018, it's Photon. Get it? The names begin with N, and then O,
and then P. (In Figure 2-9, don't let the O in Orion fool you. That's a different
piece of software.)
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FIGURE 2-9:
In May 2017,
| download
Eclipse Neon.

WARNING

Tool Platforms

-_—
-wr
W
Get Eclipse
Install your favorite Eclipse packages. Eclipse Che is a developer A modern, open source
workspace server and software development
cloud IDE. environment that runs in

the cloud.

3. Click the button to download the current Eclipse version.

In May 2017, | clicked the DOWNLOAD 64 BIT button in Figure 2-9. As a result,
Eclipse’s website showed me yet another button. This other button offered me
a copy of Eclipse from one of many servers around the world.

4. Click the appropriate button and follow the appropriate links to get the
download to begin.

The links you follow depend on which of Eclipse’s many mirror sites is offering
up your download. Just wade through the possibilities and get the download

going.

Notice the Download Packages link in Figure 2-9. If you click that link, you can
download a copy of Eclipse with certain features added. For example, the Eclipse
IDE for Java EE Developers package includes heavyweight features for industrial-
strength development. The Eclipse IDE for JavaScript and Web Developers package
has features to help people create web pages.

If you land on a page that offers various packages, look for a package named
Eclipse IDE for Java Developers (not Java EE Developers).

Eclipse’s download page directs you to versions of Eclipse that are specific to your
computer’s operating system. For example, if you visit the page on a Windows
computer, the page shows you downloads for Windows only. If you’re download-
ing Eclipse for use on another computer, you may want to override the automatic
choice of operating system. Look for a little drop-down list containing the name
of your computer’s operating system. You can change the selected operating
system on that drop-down list.

If you know which Java version you have (32-bit or 64-bit), be sure to download
the corresponding Eclipse version. If you don’t know which Java version you have,
download the 64-bit version of Eclipse and try to launch it. If you can launch
64-bit Eclipse, you’re okay. But if you get aNo Java virtual machine was found
error message, try downloading and launching the 32-bit version of Eclipse. For
the full lowdown on 32-bit and 64-bit word lengths, see this chapter’s earlier
sidebar “How many bits does your computer have?”
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Installing Eclipse

Precisely how you install Eclipse depends on your operating system and on what
kind of file you get when you download Eclipse. Here’s a brief summary:

»

»

»

If you run Windows and the download is an . exe file:
Double-click the . exe file's icon.

If you run Windows and the download is a . zip file:
Extract the file's contents to the directory of your choice.

In other words, find the . zip file's icon in File Explorer (also known as
Windows Explorer). Then double-click the . zip file's icon. (As a result, Explorer
displays the contents of the . zip file, which consists of only one folder — a
folder named eclipse.) Drag the eclipse folder to a convenient place on
your computer’s hard drive.

For more information about . zip files, see the “Compressed archive files”
sidebar, earlier in this chapter.

My favorite place to drag the eclipse folder is directly onto the C: drive.
SomyC: drive has folders named Program Files,Windows, eclipse, and
others. | avoid making the eclipse folder be a subfolder of Program Files
because from time to time, I've had problems dealing with the blank space in
the name Program Files.

If you run Mac OS X:
When you download Eclipse, you get either a . tar . gz file or a . dmg file.

A .tar.gz file is a compressed archive file. When you download the file,
your web browser might automatically do some uncompressing for you. If
so, you won't find a . tar . gz file in your Downloads folder. Instead, you'll
find either a . tar file (because your web browser uncompressed the . gz
part) or an eclipse folder (because your web browser uncompressed
both the . tar and . gz parts).

If you find a new . tar file or .tar . gz file in your Downloads folder,
double-click the file until you see the eclipse folder. Drag this new
eclipse folder to your Applications folder, and you're all set.

If you download a . dmg file, your web browser may open the file for you.
If not, find the . dmg file in your Downloads folder and double-click the file.
Follow any instructions that appear after this double-click. If you're
expected to drag Eclipse into your Applications folder, do so.
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TIP

3 If you run Linux:

You may get a . tar . gz file, but there's a chance you'll get a self-extracting

.bin file. Extract the . tar . gz file to your favorite directory or execute the
self-extracting .bin file.

Running Eclipse for the first time

The first time you launch Eclipse, you perform a few extra steps. To get Eclipse
running, do the following:

1.

Launch Eclipse.

In Windows, the Start menu may not have an Eclipse icon. In that case, look in
File Explorer (aka Windows Explorer) for the folder containing your extracted
Eclipse files. Double-click the icon representing the eclipse. exe file. (If you
see aneclipse file but not aneclipse.exe file, check this chapter's earlier
sidebar “Those pesky filename extensions.”)

On a Mac, go to the Spotlight and type Eclipse in the search field. When Eclipse
appears as the top hit on the Spotlight's list, press Enter.

The first time you try to run Eclipse on a Mac, you might get a message telling
you that Eclipse isn't from the App Store and isn't from an identified developer.
Nothing in this world is 100 percent safe, but I've downloaded and installed
Eclipse a zillion times, and I've never had a problem with it. So, to get around
this stumbling block, find the Eclipse app entry in your Applications folder
(or wherever else you installed Eclipse). Control-click the application entry and,
on the resulting context menu, select Open. At this point, a dialog box appears.
The dialog box asks whether you're sure that you want to open the application.
You're sure, so click Open.

When you launch Eclipse, you see a Workspace Launcher dialog. (See Figure 2-10.)
The dialog asks where, on your computer’s hard drive, you want to store the code
that you will create using Eclipse.

In the Workspace Launcher dialog, click OK to accept the default (or don't
accept the default!).

One way or another, it's no big deal!

Because this is your first time using a particular Eclipse workspace, Eclipse
starts with a Welcome screen. (See Figure 2-11.)
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+ Workspace Launcher =)

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session

Waorkspace: CUsersibburdiwaorkspace -

FIGURE 2-10: [T]Use this as the default and do naot ask again
Eclipse’s
Workspace 2l QJ [ Cancal
Launcher.
2 workspaceOxygen - Java - Eclipse - m} ®
File Edit Mavigate Search Project Run Window Help
%) Welcome 52 far & aE= s
& . ~
Cl|pse Welcome to the Eclipse IDE for Java Developers ®)
Workbench
Review the IDE's most fiercely contested Get an overview of the features
preferences
- A guided walkthrough to create the famous Go through tutorials
Hello World in Eclipse
Try out the samples
Create a new Java Eclipse project
Find out what is new
Checkout Eclipse projects hosted in a Git
repository
FIGURE 2-11: ;T;E;);::‘iztirnagrsilizse projects from the
ECIIpSe s EA\ways show Welcome at start up v
Welcome 1
screen.
3. Onthe Welcome screen, look for a button or an icon labeled Workbench.
In Figure 2-11, that button is in the upper-right corner.
Through the ages, many of the Eclipse Welcome screens have displayed icons
@ along with little or no helpful text. If you don't see the word Workbench
anywhere on the Welcome screen, hover the mouse over each icon until you
TIP find an icon whose tooltip contains the word Workbench.

4. Click the Workbench icon to open Eclipse’s main screen.

A view of the main screen, after opening Eclipse with a brand-new workspace,
is shown in Figure 2-12.
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File Edit Bun Source MNavigate Search Project Refactor Window Help
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|& Package Explarer 2 =g = B |[ § Task List 2 =8
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@ Connect Mylyn b
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tools or create a local task
8% Outline 2 ¥ =8
An outline is not available
[ Problems 2 @ Javadoc| 2, Declaration = =08
0 iterns
: Locat T
FIGURE 2-12: Description Resource Path ocation Ype
The Eclipse
workbench with
a brand-new
i a0 E W
workspace. |

If you have to configure Java in Eclipse. ..

Eclipse normally looks on your computer for Java installations and selects an
installed version of Java to use for running your Java programs. Your computer
may have more than one version of Java, so you may want to double-check
Eclipse’s choice of the Java version. The following steps show you how:

1. onWindows or Linux: On Eclipse’s main menu, select
Window > Preferences. On a Mac: On Eclipse’s main menu, select
Eclipse = Preferences.

As a result, Eclipse’s Preferences dialog appears. (You can follow along with
Figure 2-13.)

2. Inthe tree on the left side of the Preferences dialog, expand the Java
branch.

3. Within the Java branch, select the Installed JREs subbranch.

4. Look at the list of Java versions (Installed JREs) in the main body of the
Preferences dialog.
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FIGURE 2-13:
Eclipse’s
Preferences
dialog.

S Preferences = =
type filter text Installed JREs Pro T
> General , - q
. Ant Add, remove or edit JRE d_efmltmns‘ By default, the checked JRE is added to the build path
of newly created Java projects,

> Code Recommenders
> Help Installed IREs:
- InstallfUp date Hame Lacation Type Add..,
4 Java

» Appearance [ =hjdk1.6.0.32 CaAProgram FileshJavaljdk1.6.0 32 Stan Edit...

. Build Path [] =hjdk1.7.025 C\Program Files (x36)%Javaydk1.7.0_25  Stan

. Code Style Eijdk1.8.0(d.. C\Program Files\Java\jdk1.8.0 Stan| Duplicate...

> Compiler Rermove

» Debug

> Editor Search..

> Installed JREs

IUnit %
Properties Files Editor

> Mawven
> Mlylyn
» Run/Debug
> Team

Walidation
> WindowBuilder
s ML < >

In the list, each version of Java has a check box. Eclipse uses the version whose
box is checked. If the checked version isn't your preferred version (for example,
if the checked version isn't version 9 or higher), you can make some changes.

If your preferred version of Java appears on the Installed JREs list, put a
check mark in that version’s check box.

If your preferred version of Java doesn’t appear in the Installed JREs list,
click the Add button.

When you click the Add button, a JRE Type dialog appears. (See Figure 2-14.)
In the JRE Type dialog, double-click Standard VM.

As a result, a JRE Definition dialog appears. (See Figure 2-15.) What you do next
depends on a few different things.

Fill in the dialog's JRE Home field.
How you do this depends on your operating system.

On Windows, browse to the directory in which you've installed your
preferred Java version. On my many Windows computers, that directory
is either C: \Program Files\Java\jre-9,C:\Program Files\Java\
jdk1.8.0,C:\Program Files (x86)\Java\jre-9, or something of
that sort.
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S Add JRE )
JRE Type \
Select the type of JRE to add to the workspace. y
Installed JRE Types:
Execution Environrment Description
Standard 1.1, WM
Standard VIV
FIGURE 2-14:
TheREType || @ <Bark Enish
dialog.
S Add JRE O >
JRE Definition 3
(1, Enter the home directory of the JRE. \)
JRE home: ‘ | Directory...
JRE name: ‘ |
Default VM arguments: ‘ | Variables...
JRE system libraries:
Add External JARs...
Javadoc Location...
Source Attachment...
External annotations...
Remove
Up
Down
Restore Default
FIGURE 2-15:
The JRE Definition ® Next > Finish Cancel
dialog.

® On a Mag, use the Finder to browse to the directory in which you've

installed your preferred Java version. Type the name of the directory in the
dialog's JRE Home field.

My Mac has one Java directory named /System/Library/Java/Java
Virtual Machines/1.6.0. jdk/Contents/Home and another Java
directory named /Library/Java/JavaVirtualMachines/jdk-9. jdk/
Contents/Home. (The first is for Apple’s old version of Java; the second is
for Oracle’s new Java version.) You might also find Apple’s old Java version
in the /System/Library/Frameworks/JavaVM. framework/Versions
directory, and find Oracle’s Java in the /Library/Internet Plug-Ins/
JavaAppletPlugin.plugin/Contents/Home directory.
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TIP

TIP

TIP

Directories like /System and /Library don't normally appear in the Finder
window. To browse to one of these directories (to the /Library directory,
for example), choose Go = Go to Folder in the Finder's menu bar. In the
resulting dialog, type /Library and then press Go.

As you navigate to the directory containing your preferred Java version,
you may encounter a JOK 1.8.0. jdk icon or some other item whose
extension is . jdk. To see the contents of this item, Control-click the item’s
icon and then select Show Package Contents from the menu that appears.

On Linux, browse to the directory in which you've installed your preferred
Java version. When in doubt, search for a directory whose name starts with
jre or jdk.

You might have one more thing to do back in the JRE Definition dialog.

9. Look at the JRE Definition dialog’s JRE Name field; if Eclipse hasn't filled in

a name automatically, type a name (almost any text) in the JRE Name
field.

10. pismiss the JRE Definition dialog by clicking Finish.

Eclipse’s Preferences dialog returns to the foreground. The box's Installed JREs
list contains your newly added version of Java.

11. Put a check mark in the check box next to your newly added version of

Java.

You're almost done. (You have a few more steps to follow.)

12. ithin the Java branch on the left side of the Preferences dialog, select

the Compiler subbranch.

In the main body of the Preferences dialog, you see a Compiler Compliance
Level drop-down list.

13. Inthe Compiler Compliance Level drop-down list, select a number that

matches your preferred Java version.

For Java 8, | select compliance level 1.8. For Java 9, | select compliance level 1.9
or compliance level 9.

Eclipse updates aren't always in sync with Java updates. If you're running Java 9
and the Eclipse’s highest compliance level is 1.8, select 1.8. Take my word for it.
Everything will be okay.

14. Whew! Click the Preferences dialog’s OK button to return to the Eclipse

workbench.
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Importing This Book’s Sample Programs

The import business in Eclipse can be tricky. As you move from one dialog to the
next, many of the options have similar names. That’s because Eclipse offers many
different ways to import many different kinds of things. Anyway, if you follow
these instructions, you’ll be okay.

1. Follow the steps in this chapter’s earlier section “Getting This Book’s
Sample Programs.”
2. on Eclipse’s main menu, choose File > Import. (See Figure 2-16.)

As a result, Eclipse displays an Import dialog.

= Java - Ecllpse

Edit Run Source MNavigate Search Project Refactor W
Mewy Alt+Shift+N » 3& R
Open File..,
Close Ctrl 4
Close All Ctrl +Shift +4
Save Ctl+8
Save A,
Save Al Ctrl+5hift+5
Rewvert
kove..,
Renarme.., F2

#1 Refresh F3
Corvert Line Delimiters To 3
Print.., Chrl+P
Switch Warkspace »
Restart

f2g Import., L\\)

) Export.,
Properties Alt+Enter
Exit

FIGURE 2-16:
Sta.rtmg to import Bl Problems 5 - @
this book’s code.

w

In the Import dialog's tree, expand the General branch.

4. IntheGeneral branch, double-click the Existing Projects into
Workspace subbranch. (See Figure 2-17)

As a result, the Import Projects dialog appears.
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FIGURE 2-17:
Among all the
options, select

Existing Projects
into Workspace.

A\

WARNING

REMEMBER

< Import O x

Select

Create new projects from an archive file or directory. E 4 E |

Select an import wizard:

T

JE Archive File ~
[ Existing Projects into Workspace
() File System

[T] Preferences

() Projects frem Folder or Archive
Git

Gradle

Install

Maven

Oomph

Run/Debug

Tasks

Team

XML

< Back Mext > Finish Cancel

Look again at Figure 2-17. In that dialog box, don't select Archive File or File
System. My book’s download isn't set up for either of these options.

In the Import Projects dialog, choose either the Select Root Directory
radio button or the Select Archive File radio button. (See Figure 2-18)

Here's how you decide which radio button to choose:

First, make sure that you've heeded the advice that | give in the earlier sidebar
entitled “Those pesky filename extensions.” Then look in the folder containing
the file that you downloaded from this book’s website.

If your web browser doesn’t automatically uncompress downloaded .zip
files, you'll find this book’s code in an archive file named BeginProgJava
Dummies5.zip. In that case, choose the Select Archive File radio button.

If your web browser automatically uncompresses downloaded . zip files,
you'll find this book’s code in a directory (a folder) named
BeginProgJavaDummiesb. In that case, choose the Select Root Directory
radio button.

To ensure that you can distinguish between a folder and a . zip file, check this
chapter's “Those pesky filename extensions” sidebar.

For the complete scoop on . zip files and other archive files, see the sidebar
entitled “Compressed archive files.”
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< Import

Import Projects

Select a directory to search for existing Eclipse projects.

FIGURE 2-18:
The Import @ < Back Next >
Projects dialog.

Finish

(®) Select root directory: | | ~ | Browse...
() Select archive file: Browse...
Projects:
Select All
Deselect All
Refresh
Options
[ Search for nested projects
Copy projects into workspace
[IHide projects that already exist in the workspace
Working sets
[]Add project to working sets Mew...

Select...

Cancel

6. Cclick the Browse button to find the BeginProgJavaDummies5.zip file or
the BeginProgDummies5 directory on your computer’s hard drive.

After you find the file or the directory, Eclipse’s Import Projects dialog displays
the names of the projects inside the file. (See Figure 2-19.)

7. Click the Select All button.

This book's examples are so exciting that you want to import all of them!

8. Click the Finish button.

As a result, the main Eclipse workbench reappears. The left side of the
workbench displays the names of this book’s Java projects. (See Figure 2-20.)

Now the real fun begins.
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FIGURE 2-19:
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What's Next?

If you’re reading this paragraph, you’ve probably finished installing Java and
Eclipse on your computer. In Chapter 3, you start reaping the benefits of your
software installation efforts. You use Eclipse to run a brand-new Java program.
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IN THIS CHAPTER

» Compiling and running a program

» Editing your own Java code

» Working with a workspace

Chapter 3
Running Programs

f you’re a programming newbie, for you, running a program probably means
clicking a mouse. You want to run Microsoft Word, so you double-click the
Microsoft Word icon. That’s all there is to it.

When you create your own programs, the situation is a bit different. With a new
program, the programmer (or someone from the programmer’s company) creates
the program’s icon. Before that process, a perfectly good program may not even
have an icon. So what do you do with a brand-new Java program? How do you get
the program to run? This chapter tells you what you need to know.

Running a Canned Java Program

The best way to get to know Java is to do Java. When you’re doing Java, you’re
writing, testing, and running your own Java programs. This section prepares you
by describing how you run and test a program. Instead of writing your own pro-
gram, you run a program that I’ve already written for you. The program calculates
your monthly payments on a home mortgage loan.

The mortgage-calculating program doesn’t open its own window. Instead, the
program runs in Eclipse’s Console view. The Console view is one of the tabs in the
lower-right part of the Eclipse workbench. (See Figure 3-1.) A program that oper-
ates completely in this Console view is called a text-based program.
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FIGURE 3-1:
A run of this
chapter's
text-based
mortgage
program.
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How many years are you taking to pay? 3@

Your monthly payment is $552.20

You may not see a Console tab in the lower-right part of the Eclipse workbench.
To coax the Console view out of hiding, choose Windowt> Show Viewt> Other. In
the resulting Show View dialog box, expand the General branch. Finally, within
that General branch, double-click the Console item.

For more information about the Console view (and about Eclipse’s workbench in
general), see the “Views, editors, and other stuff” section, later in this chapter.

You can see GUI versions of the program in Figure 3-1, and of many other exam-
ples from this book, by visiting the book’s website (http://allmycode.com/
BeginProg).

Actually, as you run the mortgage program, you see two things in Eclipse’s Console
view:

3 Messages and results that the mortgage program sends to you: Messages
include things like How much are you borrowing?, and results include lines
like Your monthly payment is $552.20.

3 Responses that you give to the mortgage program while it runs: If you
type 100000.00 in response to the program'’s question about how much
you're borrowing, you see that number echoed in Eclipse’s Console view.

Here’s how you run the mortgage program:

1. Make sure that you've followed the instructions in Chapter 2 — instructions
for installing Java, for installing and configuring Eclipse, and for getting this
book’s sample programs.

Thank goodness! You don't have to follow those instructions more than once.
2. Launch Eclipse.

The Eclipse Workspace Launcher dialog box appears. (See Figure 3-2.)
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FIGURE 3-2:
The Eclipse
Workspace

Launcher.

[ ] Workspace Launcher

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: | {Users/barryburd/Documents/workspace] i Browse...

} Copy Settings

@ el

A workspace is a folder on your computer’s hard drive. Eclipse stores your Java
programs in one or more workspace folders. Along with these Java programs,
each workspace folder contains some Eclipse settings. These settings store
things like the version of Java that you're using, the colors that you prefer for
words in the editor, and the size of the editor area when you drag the area’s
edges. You can have several workspaces with different programs and different
settings in each workspace.

By default, the Workspace Launcher offers to open whatever workspace you
opened the last time you ran Eclipse. You want to open the workspace that you
used in Chapter 2, so don't modify the stuff in the Launcher's Workspace field.

3. Inthe Workspace Launcher dialog box, click OK.

The big Eclipse workbench stares at you from your computer screen. (See
Figure 3-3.)

In Figure 3-3, the leftmost part of the workbench is Eclipse’s Package Explorer,
which contains numbers like 03-01, 04-01, and so on. Each number is actually
the name of an Eclipse project. Formally, a project is a collection of files and
folders inside a workspace. Intuitively, a project is a basic work unit. For
example, a self-contained collection of Java program files to manage your CD
collection (along with the files containing the data) may constitute a single
Eclipse project.

Looking again at the Package Explorer in Figure 3-3, you see projects named
03-01, 04-01, and so on. My project 03-01 holds the code for Listing 3-1 (the
first and only listing in this chapter, Chapter 3). Project 06-02 contains the Java
program in Listing 6-2 (the second code listing in Chapter 6 of this book).
Project names can include letters, digits, blank spaces, and other characters;
for the names of this book’s examples, | stick with digits and dashes.
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WARNING

TIP

To read more about topics like Eclipse’s Package Explorer, see the upcoming
section “What's All That Stuff in Eclipse’s Window?”

When you launch Eclipse, you may see something different from the stuffin
Figure 3-3. You may see Eclipse’s Welcome screen with only a few icons in an
otherwise barren window. You may also see a workbench like the one in
Figure 3-3, but without a list of numbers (03-01, 04-01, and so on) in the
Package Explorer. If so, you may have missed some instructions on configuring
Eclipse in Chapter 2. Alternatively, you may have modified the stuff in the
Launcher's Workspace field in Step 2 of this section’s instructions.

In any case, make sure that you see numbers like 03-01 and 04-01 in the
Package Explorer. Seeing these numbers assures you that Eclipse is ready to
run the sample programs from this book.

In the Package Explorer, click the 93-0-Mortgage branch.

The 03-0-Mortgage project is the only project whose name isn't two digits, a
dash, and then two more digits.

You may want to see a sneak preview of some Java code. To see the Java
program that you're running in Project 93-0-Mortgage, expand the
03-0-Mortgage branch in the Package Explorer. Inside the @3-0-Mortgage
branch, you find a src branch, which in turn contains a (default package)
branch. Inside the (default package) branch, you find the Mortgage . java
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FIGURE 3-4:

One of the

ways to run the
code in Project
03-0-Mortgage.

A\

WARNING

branch. That Mortgage. java branch represents my Java program. Double-
clicking the Mortgage . java branch makes my code appear in Eclipse’s editor.

Choose Run > Run As =>]Java Application from the main menu, as shown in
Figure 3-4.

When you choose Run As =>Java Application, the computer runs the project's
code. (In this example, the computer runs a Java program that | wrote.) As part
of the run, the message How much are you borrowing? appears in Eclipse’s
Console view. (The Console view shares the lower-right area of Eclipse’s
workbench with the Problems view, the Javadoc view, the Declaration view, and
possibly other views. Refer to Figure 3-1.)

e File Edit Source Refactor Refactor Navigate Search Project m Window Help Apr1 9:02 PM
[ ] @ Java - Eclipse - fUsers/barryburd/Decuments/Py C.‘,v Run %8
e i WA QR B G m (B ; *, Debug 3€F11:_I1,E
[% Ppackage Explorer 53 = m) Run History P sLis
ee . vl Bl rpiet  Yaxa TSN
= S = PR = s - E
BEL O SRCIT R Confiaurations
> %03'07 Debug History >
6. click anywhere inside Eclipse’s Console view and then type a number, like

100000.00, and press Enter.

When you type a number in Step 6, don't include your country’s currency
symbol and don't group the digits. (U.S. residents: Don't type a dollar sign and
don't use any commas.) Things like $100000.00 and 1,000,000.00 cause the
program to crash. You see a NumberFormatException message in the Console
view.

Grouping separators vary from one country to another. The run shown in
Figure 3-1 is for a computer configured in the United States where 700000.00
(with a dot) means “one hundred thousand.” But the run might look different
on a computer that's configured in what | call a “comma country” — a country
where 700000,00 (with a comma) means “one hundred thousand.” If you live in
a comma country and you type 100000.00 exactly as it's shown in Figure 3-1,
you probably get an error message (an InputMismatchException). If so,
change the number amounts in your file to match your country’s number
format. When you do, you should be okay.

After you press Enter, the Java program displays another message What's
the interest rate?)in the Console view. (Again, refer to Figure 3-1.)

In response to the interest rate question, type a number, like 5.25, and
press Enter.

After you press Enter, the Java program displays another message (How many
years ... ?)inthe Console view.
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8. Type a number, like 30, and press Enter.

In response to the numbers that you type, the Java program displays a monthly
payment amount. Again, refer to Figure 3-1.

Disclaimer: Your local mortgage company charges fees of all kinds. To get a
mortgage in real life, you pay more than the amount that my Java program
calculates. (A lot more.)

& When you type a number in Step 8, don't include a decimal point. Numbers
like 30.0 cause the program to crash. You see a NumberFormatException
message in the Console view.
WARNING
Occasionally, you decide in the middle of a program’s run that you've made a
@ mistake of some kind. You want to stop the program’s run dead in its tracks.
Simply click the little red square above the Console view. (See Figure 3-5.)
TIP
. :
*{ Problems | @ Javadoc |_—Q> Declaration | 4" Search | E Consale 52 ®
FIGURE 3-5: Mortgage [Java Application] C:\Program Files\Java\jre?\binyjavaw exe (Dec 4, QD%M)

How to prema-
turely terminate a
program’s run.

How much are you borrowing?

If you follow this section’s instructions and you don’t get the results that
I describe, you can try three things. I list them in order from best to worst:

¥ Check all the steps to make sure that you did everything correctly.

¥ Send an email to me at BeginProg@allmycode.com, post to my Facebook
wall (/allmycode), or tweet to the Burd (@allmycode). If you describe what
happened, | can probably figure out what went wrong and tell you how to
correct the problem.

¥ Panic.

Typing and Running Your Own Code

The previous section is about running someone else’s Java code (code that you
download from this book’s website). But eventually, you’ll write code on your
own. This section shows you how to create code with the Eclipse IDE.
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Separating your programs from mine

In Chapter 2, you download this book’s examples from my website. Then you
create an Eclipse workspace and import the book’s examples into your workspace.

You can create your own projects in the same workspace. But if you want to sepa-
rate your code from mine, you can create a second workspace. Here are two ways
to create a new workspace:

3 When you launch Eclipse, type a new folder name in the Workspace field
of Eclipse’s Workspace Launcher dialog box.

If the folder doesn't already exist, Eclipse creates the folder. If the folder already
exists, Eclipse’s Package Explorer lists any projects that the folder contains.

3 On the Eclipse workbench’s main menu, choose File => Switch Workspace.
(See Figure 3-6.)

When you choose File &> Switch Workspace, Eclipse offers you a few of your
previously opened workspace folders. If your choice of folder isn't in the list,
select the Other option. In response, Eclipse reopens its Workspace Launcher
dialog box.

= Java - Eclipse
File | Edit Run Mawigate Search Project Refactor indows Help

Mew alsShiftelr | o @+ i@ @ v @

Open File..

Close Cirl 4

Close Al Ctrl+ Shift +4

Save Ctrl+5

Save A,

Save Al Chrl+Shift+3

Rewert

hove..,

Rename... F2

Refresh Fa

Conwvert Line Delimiters To 3

Print... Ctrl+P

Swiitch Workspace 2 Lpurgetuark

Restart fwsershbburdiwworkspace
G | Hpae chpurgetworkspacelavat
&) | Bt chpurgetworkspacelaval

Praperties Alt+Enter Sthel l}

1Mortgagejava [03-01/5rc]
2 MyFirstlavaClass.java [_pasted_code..]
3 MyFirstlavaClass.java [Users/bburd/..]

FIGURE 3-6: Exit
Switching to a R
different Eclipse = 1202
workspace. & 1203 2
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Writing and running your program

Here’s how you create a new Java project:

1.

Launch Eclipse.
From Eclipse’s menu bar, choose File > New > Java Project

2.
A New Java Project dialog box appears.

3.

In the New Java Project dialog box, type a name for your project and then

click Finish.
In Figure 3-7, | type the name MyF irstProject.
] New Java Project = = =
Create a Java Project > [
Create a Java project in the workspace or in an external location. f 7
Project name: | MyFirstProject
[¥] Use default lacation
CUsers\Barryhwrarkspace JavaFD_Ged_Eclipse\byFirstProje Browse...
JRE
(®) Use an execution environmentJRE: | JavaSE-1.8 v
(1 Use a project specific JRE: jdlk1.8.0
() Use default JRE (currently ‘jdk1.8.07 Configure JREs...
Project layout
(73 Use project folder s root for sources and class files
Create separate falders for sources and class files Configure default..,
Working sets
["]A4dd project to working sets
Select..,
FIGURE 3-7:
Getting Eclipse
to create a new @ < Back Next > Finish s Cancel
project.
If you click Next instead of Finish, you see some other options that you don't
need right now. To avoid any confusion, just click Finish.

REMEMBER Clicking Finish brings you back to Eclipse’s workbench, with MyF irstProject
in the Package Explorer, as shown in Figure 3-8.
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The next step is to create a new Java source code file.
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FIGURE 3-8:

Your project
appears in
Eclipse's Package
Explorer.

FIGURE 3-9:
Getting Eclipse
to create a new
Java class.

= Java - Treesisrc/UseTree Java - Ecllpsd

File Edit Run Source MNavigate Search

CI~E~ [
- | ow :tjtl '(;,E' - -
1% Package Explorer 2 . =Nl
- =

=R-YIC

> = MyFirstProject
> & SomeOtherProject

4.

5.

Select your newly created project in the Package Explorer.

To create Figure 3-8, | selected MyFirstProject instead of
SomeOtherProject.

In Eclipse’s main menu, choose File => New > Class.

Eclipse’s New Java Class dialog box appears. (See Figure 3-9.)

= New Java Class A T T |

Java Class

Source folder: MyF irstProjectisrc

The use of the default package is discouraged. Q

Package: (default)
[TIEnclosing type: Browse..
Name: MyFirstlavaClass
Modifiers: @ public 7 default private protected

[T abstract [[lfinal static

Superclass java.lang. Object
Interfaces: Add..

Remave

Which method stubs would you like to create?

ublu: static yoid main(Stnngf] args)

Constructors from superclass

[l Inherited abstract methods
Do you want to add comments? (Configure templates and default value here)

[l Generate comments
@ Einish l I Cancel
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Java programmers normally divide their code into one or more packages. A

06“ typical package has a name like java.util ororg.allyourcode. images. In
Figure 3-9, Eclipse is warning me that I'm not naming a package to contain my

TECHNICAL project’s code. So the code goes into a nondescript thing called Java's default

STUFF , . . .
package. Java's default package is a package with no name — a catchall location
for code that isn't otherwise packaged. Packages are great for managing big
programming projects, but this book contains no big programming projects.
So, in this example (and in all of this book’s examples), | choose to ignore the
warning. For more info about Java packages, see Chapter 18.

Like every other windowed environment, Eclipse provides many ways to

@ accomplish the same task. Instead of choosing File &> New > Class, you can
right-click MyFirstProject in the Package Explorer in Windows (or control-
TIP click MyFirstProject in the Package Explorer on a Mac). From the resulting

context menu, choose New > Class. You can also start by pressing Alt+Shift+N
in Windows (or Option+38+N on a Mac). The choice of clicks and keystrokes is
up to you.

6. Inthe New Java Class dialog box's Name field, type the name of your new
class.

In this example, | use the name MyF irstJavaClass, with no blank spaces
between any of the words in the name. (Refer to Figure 3-9.)

The name in the New Java Class dialog box cannot have blank spaces. And the

& only allowable punctuation symbol is the underscore character (_). You can
name your class MyFirstJavaClass or My_First_Java_Class, butyou can't
WARNING nameitMy First Java Class or JavaClass,MyFirst.

7. Putacheck markin the public static void main(String[] args)
check box.

Your check mark tells Eclipse to create some boilerplate Java code.

8. Accept the defaults for everything else in the New Java Class dialog box.
(In other words, click Finish.)

You can even ignore the “Default Package Is Discouraged” warning near the top
of the dialog box.

Clicking Finish brings you back to Eclipse’s workbench. Now MyFirstProject
contains a file named MyF irstJavaClass. java. For your convenience, the
MyFirstJavaClass. java file already has some code in it. Eclipse’s editor
displays the Java code. (See Figure 3-10.)
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FIGURE 3-10:
Eclipse writes
some code in

the Editor.

o

[ Package Explorer 53 = [4] MyFirstlavaClass.java 32

S - 1
(9 MyFirstProject 2 public class MyFirstlavaClass {
= . . . . .
=sre public static void main(String[] args) {
£ (default package) = /7 Auto-generated method stub
[3] MyFirstJavaClass java ¢
i, JRE System Library [JavaSE-1.8] }
[ SomeOtherProject

0. Replace an existing line of code in your new Java program.
Type a line of code in Eclipse’s Editor. Replace the line
// TODO Auto-generated method stub
with the line

System.out.println("Chocolate, royalties, sleep");

DO | SEE FORMATTING IN
MY JAVA PROGRAM?

When you use Eclipse’s editor to write a Java program, you see words in various colors.
Certain words are always blue. Other words are always black. You even see some bold
and italic phrases. You may think you see formatting, but you don't. Instead, what you
see is called syntax coloring or syntax highlighting.

No matter what you call it, the issue is as follows:

® With Microsoft Word, things like bold formatting are marked inside a document.
When you save MyPersonalDiary . docx, the instructions to make the words /ove
and hate bold are recorded inside the MyPersonalDiary . docx file.

® With a Java program editor, things like bold and coloring aren’t marked inside the
Java program file. Instead, the editor displays each word in a way that makes the
Java program easy to read.

For example, in a Java program, certain words (words like class, public, and void)
have their own special meanings. So Eclipse’s editor displays class, public, and void
in bold, reddish letters. When | save my Java program file, the computer stores nothing
about bold, colored letters in my Java program file. But the editor uses its discretion to
highlight special words with reddish coloring.

Certain other editors may display the same words in a blue font. Another editor (like
Windows Notepad) displays all words in plain old black.
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Copy the new line of code exactly as you see it in Listing 3-1.
® Spell each word exactly the way | spell it in Listing 3-1.
® C(Capitalize each word exactly the way | do in Listing 3-1.

® Include all the punctuation symbols — the dots, the quotation marks, the
semicolon — everything.

Distinguish between the lowercase letter 1 and the digit 1. The word
println tells the computer to print a whole line. Each character in the

word println is a lowercase letter. The word contains no digits.
REMEMBER

m A Program to Display the Things I Like

public class MyFirstJavaClass {

public static void main(String[] args) {
System.out.println("Chocolate, royalties, sleep");

}
}
& Java is case-sensitive, which means that system.out . printLn isn't the same as
System.out.println. If yOu tyPe system.out . printlLn, your progrAm won't
worK. Be sUre to cAPItalize your codE eXactly as it is in LiSTIng 3-1.
WARNING
If you copy and paste code from an ebook, check to make sure that the
& quotation marks in the code are straight quotation marks (""), not curly
quotation marks (““*). In a Java program, straight quotation marks are good;
WARNING curly quotation marks are troublesome.
If you typed everything correctly, you see the stuff in Figure 3-11.
MyFirstJavaClass.java 2
i public class MyFirstlava(lass {
:1‘7 public static void main{String[] args) {
5 System. out.println("Chocolate, royalties, sleep");
FIGURE 3-11: e 3
A Java program, s s
in the Eclipse 1
editor. 11
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FIGURE 3-12:
A Java program,
typed incorrectly.

TIP

If you don't type the code exactly as it's shown in Listing 3-1, you may see
jagged red underlines, tiny rectangles with X-like markings inside them, or
other red marks in the editor. (See Figure 3-12.)

@ MyFirstJavaClass.java 23

1
2 public class MyFirstlavaClass {

public static void main{String[] args) {

The red marks in Eclipse’s editor refer to compile-time errors in your Java
code. A compile-time error (also known as a compiler error) is an error
that prevents the computer from translating your code. (See the talk
about code translation in Chapter 1.)

The error marker in Figure 3-12 appears on line 5 of the Java program.
Line numbers appear in the editor’s left margin. To make Eclipse’s editor
display line numbers, choose Window = Preferences (in Windows) or
Eclipse = Preferences (on a Mac). Then choose General => Editors = Text
Editors. Finally, put a check mark in the Show Line Numbers check box.

To fix compile-time errors, you must become a dedicated detective. You
join an elite squad known as Law & Order: Java Programming Unit. You
seldom find easy answers. Instead, you comb the evidence slowly and
carefully for clues. You compare everything you see in the editor, character
by character, with my code in Listing 3-1. You don't miss a single detail,
including spelling, punctuation, and uppercase-versus-lowercase.

Eclipse has a few nice features to help you find the source of a compile-
time error. For example, you can hover the mouse pointer over the jagged
red underline. When you do, you see a brief explanation of the error along
with some suggestions for repairing the error — some quick fixes. (See
Figure 3-13.)

In Figure 3-13, a pop-up message tells you that Java doesn't know what the
word system means — that is, system cannot be resolved. Near the bottom of
the figure, one of the quick fix options is to change system to System.

When you click that Change To 'System'’ (java. lang) option, Eclipse’s editor
replaces system with System. The editor’s error markers disappear, and
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FIGURE 3-13:
Eclipse offers
some helpful
suggestions.

FIGURE 3-14:
Running the
program in
Listing 3-1.

you go from the incorrect code in Figure 3-12 to the correct code back in
Figure 3-11.

@ MyFirstJavaClass.java B3 m Maortgage.java
1 public class MyFirstJavaClass {

3= public static void main(String[] args) {

g 4 system.out.println{"Chocolate, royalties

: } - system cannot be resolved
" 11 guick fixes available:
“ 3 @ Create local variable 'system'

1: o Create field 'system'

11 Create parameter 'system'

12 Create class 'system'

13 Create constant ‘system’

14

Create interface 'system'

Create enum 'system'

Change to 'System’ (java.lang)
Change to 'SysterEuoIDr' (java.awt)

Change to 'SystemTray’ (java.awt)

23 33@0Q0 @0

Fix project setup...

10. make any changes or corrections to the code in Eclipse’s editor.

When at last you see no jagged underlines or blotches in the editor, you're
ready to try running the program.

11. select MyFirstJavaClass either by clicking inside the editor or by clicking
the MyFirstProject branch in the Package Explorer.

12. From Eclipse’s main menu, choose Run=>Run As~>Java Application.

That does the trick. Your new Java program runs in Eclipse’s Console view. If
you're running the code in Listing 3-1, you see the Chocolate, royalties,
sleep message in Figure 3-14. It's like being in heaven!

F|

'* Problems | @ Javadoc ._—{LJ‘, Declaration | 4" Search | & Console 2

L

<terminated> MyFirstJavaClass [Java Application] C:\Program Files\Javaijre]
Choceolate, royalties, sleep
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WHAT CAN POSSIBLY GO WRONG?

Ridding the editor of jagged underlines is cause for celebration. Eclipse likes the look of
your code, so from that point on, it's smooth sailing. Right?

Well, it ain't necessarily so. In addition to some conspicuous compile-time errors, your
code can have other, less obvious errors.

Imagine someone telling you to “go to the intersection, and then rurn tight." You notice
immediately that the speaker made a mistake, and you respond with a polite “Huh?”
The nonsensical rurn tight phrase is like a compile-time error. Your “Huh?" is like the
jagged underlines in Eclipse’s editor. As a listening human being, you may be able to
guess what rurn tight means, but Eclipse’s editor never dares to fix your code’s mistakes.

In addition to compile-time errors, some other kinds of gremlins can hide inside a Java
program:

® Unchecked runtime exceptions: You have no compile-time errors, but when you
run your program, the run ends prematurely. Somewhere in the middle of the run,
your instructions tell Java to do something that can't be done. For example, while
you're running the Mortgage program in the “Running a Canned Java Program” sec-
tion, you type 1,000,000.00 instead of 1000000.00. Java doesn't like the commas in
the number, so your program crashes and displays a nasty-looking message, as
shown in the figure.

T T B

! Problems | @ Javadoc [[2) Declaration | 47 Search | & Consale &2 X %R
<terminated> Morgage [Java Application] C:\Program Files\ava\jre7\binYjavaw exe (Dec B, 2011 10

How much are you borrowing? 1,000, 200. 22

Exception in thread "main® java.lang.WumberFormatException: For input string: "1,00@,22@.22"
at sun.misc.FloatingDecimal.readlavaFermatstring(Unknown Source)
at java.lang.Double.parseboubleiUnknoun Source)
st Mortgage.main(Mortgape. javai2l)

This is an example of an unchecked runtime exception — the equivalent of someone tell-
ing you to turn right at the intersection when the only thing to the right is a big brick
wall. Eclipse’s editor doesn’t warn you about an unchecked runtime exception because,
until you run the program, the computer can't predict that the exception will occur.

® Logic errors: You see no error markers in Eclipse’s editor, and when you run your
code, the program runs to completion. But the answer isn't correct. Instead of
$552.20 in the figure, the output is $552,200,000.00. The program wrongly tells you
to pay thousands of times what your house is worth and tells you to pay this
amount each month! It's the equivalent of being told to turn right instead of turning
left. You can drive in the wrong direction for a very long time.

(continued)
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(continued)

& Consale 2 @ Javadoc | [, Declaration | 47 Search
<terminated> Mortgage [Java Application] C:\Program Files\avaljrer

How much are you borrowing? 180002, 82
What's the interest rate? 5.25
How many years are you taking to pay? 3@

Your monthly payment is $552,200,000. 00

Logic errors are the most challenging errors to find and to fix. And worst of all, logic
errors often go unnoticed. In March 1985, | got a monthly home heating bill for
$1,328,932.21. Clearly, some computer had printed the incorrect amount. When |
called the gas company to complain about it, the telephone service representative
said, “Don’t be upset. Pay only half that amount.”

® Compile-time warnings: A warning isn't as severe as an error message. So, when
Eclipse notices something suspicious in your program, the editor displays a jagged
yellow underline, a tiny yellow icon containing an exclamation point, and a few
other not-so-intrusive clues.

For example, in the sidebar figure, | add something about amount = 1@ to the
code from Listing 3-1. (It's that bit on line 8.) The problem is, | never make use of
amount or of the number 10 anywhere in my program. With its faint yellow mark-
ings, Eclipse effectively tells me “Your amount = 1@ code isn't bad enough to be a
showstopper. Eclipse can still manage to run your program. But are you sure you
wantamount = 10 (the stuff that seems to serve no purpose) in your program?”

J| MyFirstJavaClass.java &3

1
public class MyFirstlavaClass {

public static void main{String[] args) {
int amount = 18;
System.out.println("Chocolate, royalties, sleep");

Imagine being told to “turn when you reach the intersection.” The direction may be
just fine. But if you're suspicious, you ask, “Which way should | turn? Left or right?”

When you're sure that you know what you're doing, you can ignore warnings and
worry about them at some later time. But a warning can be an indicator that some-
thing more serious is wrong with your code. My sweeping recommendation is this:
Pay attention to warnings. But, if you can't figure out why you're getting a particular
warning, don't let the warning prevent you from moving forward.
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What's All That Stuff in Eclipse’s Window?

Believe it or not, an editor once rejected one of my book proposals. In the margins,
the editor scribbled, “This is not a word” next to things like can’t, it’s, and I’ve. To
this day, I still do not know what this editor did not like about contractions. My
own opinion is that language always needs to expand. Where would we be without
a new words — words like dot-com, infomercial, and vaporware?

Even the Oxford English Dictionary (the last word in any argument about words)
grows by more than 4,000 entries each year. That’s an increase of more than
1 percent per year. It’s about 11 new words per day!

The fact is, human thought is like a big high-rise building: You can’t build the
50th floor until you’ve built at least part of the 49th. You can’t talk about spam
until you have a word like email. With all that goes on these days, you need verbal
building blocks. That’s why this section contains a bunch of new terms.

In this section, each newly defined term describes an aspect of the Eclipse IDE. So
before you read all this Eclipse terminology, I provide the following disclaimers:

¥ This section is optional reading. Refer to this section if you have trouble
understanding some of this book’s instructions. But if you have no trouble
navigating the Eclipse IDE, don't complicate things by fussing over the
terminology in this section.

3 This section provides explanations of terms, not formal definitions of
terms. Yes, my explanations are fairly precise, but no, they're not airtight.
Almost every description in this section has hidden exceptions, omissions,
exemptions, and exclusions. Take the paragraphs in this section to be friendly
reminders, not legal contracts.

3 Eclipse is a very useful tool. But Eclipse isn't officially part of the Java
ecosystem. Although | don't describe details in this book, you can write Java
programs without ever using Eclipse.

Understanding the big picture

Your tour of Eclipse begins with a big Burd’s-eye view.

3 Workbench: The Eclipse Desktop. (Refer to Figure 3-3.) The workbench is the
environment in which you develop code.

¥ Area: A section of the workbench. The workbench in Figure 3-3 contains five
areas. To illustrate the point, I've drawn borders around each of the areas.
(See Figure 3-15.)
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FIGURE 3-15:

The workbench is

72

divided into
areas.

TIP

3 Window: A copy of the Eclipse workbench. With Eclipse, you can have several
copies of the workbench open at once. Each copy appears in its own window.

¥ Action: A choice that's offered to you — typically, when you click something.
For example, when you choose File =>New on Eclipse’s main menu bar, you
see a list of new things that you can create. The list usually includes Project,
Folder, File, and Other, but it may also include things like Package, Class, and
Interface. Each of these things (each item on the menu) is called an action.

@ Eclipse File Edit Refactor Navigate Search Project Run Window Help _,’E:‘ [ %) B3 Apr110:25PM Q @ =
[ ] Java - Eclipse - /Users/barryburd/Documents/Purge/BeginProgJavaDummies4

- e Wi G O QB G (B A E e - | B & e

10

[# Package Explorer 53 =8 = 8| | & TaskList 53 =8

B S ~ o %% @ WHE
» (= 03-0-Mortgage -
» (= 03-01
> (Z0a-01 POl b Actv.
»Eos-01
> 20601
» (= 08-02
> 207-01
» & o7-02
> (Zo7-03
> (= 08-01
» 2 08-02
FEomos 5= Outline 52 =8
» (= 08-04
> 08-05 An outline is not available.
» (= 09-02
» (2 0s-03
» (= 09-04
> 10-01

> (210-05
> 10-08
» & 10-07
»E11-01
» 1102 [ Problems @ Javadoc (G} Declaration E) Console 52 = ]
»E11-03
b (1201
> 12-02
»212-03
b 21204
»(12-05
»13-01
rla3n

No consoles to display at this time.

Views, editors, and other stuff

The next bunch of terms deals with things called views, editors, and tabs.

You may have difficulty understanding the difference between views and editors.
(A view is like an editor, which is like a view, or something like that.) If views and
editors seem the same to you and you’re not sure that you can tell which is which,
don’t be upset. As an ordinary Eclipse user, the distinction between views and
editors comes naturally as you gain experience using the workbench. You rarely
have to decide whether the thing you’re using is a view or an editor.
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If you ever have to decide what a view is as opposed to an editor, here’s what you
need to know:

¥ View: A part of the Eclipse workbench that displays information for you to
browse. In the simplest case, a view fills up an area in the workbench. For
example, in Figure 3-15 the Package Explorer view fills up the leftmost area.

Many views display information as lists or trees. For example, in Figure 3-10
the Package Explorer view contains a tree.

You can use a view to make changes to things. For example, to delete the
03-01 project listed on the left side in Figure 3-15, right-click the ©3-01 branch
in the Package Explorer view. (On a Mac, control-click the 23-01 branch.)
Then, on the resulting context menu, choose Delete.

When you use a view to change something, the change takes place immedi-
ately. For example, when you choose Delete on the Package Explorer's context
menu, whatever item you've selected is deleted immediately. In a way, this
behavior is nothing new. The same kind of thing happens when you recycle a
file using Windows Explorer or trash a file using the Macintosh Finder.

3 Editor: A part of the Eclipse workbench that displays information for you to
modify. A typical editor displays information in the form of text. This text can
be the contents of a file. For example, an editor in Figure 3-11 displays the
contents of the MyFirstJavaClass. java file.

When you use an editor to change something, the change doesn't take place
immediately. For example, look at the editor in Figure 3-11. This editor
displays the contents of the MyFirstJavaClass. java file. You can type all
kinds of things in the editor. Nothing happens to MyFirstJavaClass. java
until you choose File => Save from Eclipse’s menu bar. Of course, this behavior
is nothing new. The same kind of thing happens when you work in Microsoft
Word or in any other word processing program.

Like other authors, | occasionally become lazy and use the word view when

| really mean view or editor. When you catch me doing this, just shake your
head and move onward. When I'm being very careful, | use the official Eclipse
terminology. | refer to views and editors as parts of the Eclipse workbench.
Unfortunately, this “parts” terminology doesn't stick in people’s minds very well.

An area of the Eclipse workbench might contain several overlapping views or
overlapping editors. To bring one view or editor to the forefront, you click a tab.
Most Eclipse users get along fine without giving this “several views” business a
second thought (or even a first thought). But if you care about the terminology
surrounding tabs and active views, here’s the scoop:
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3 Tab: Something that's impossible to describe except by calling it a tab. That
which we call a tab by any other name would move us as well from one view
to another or from one editor to another. The important thing is, views can be
stacked on top of one another. Eclipse displays stacked views as though
they're pages in a tabbed notebook. For example, Figure 3-14 displays one
area of the Eclipse workbench. The area contains five views (the Problems
view, the Javadoc view, the Declaration view, the Search view, and the Console
view). Each view has its own tab.

A bunch of stacked views is called a tab group. To bring a view in the stack to
the forefront, you click that view's tab.

And, by the way, all this stuff about tabs and views holds true for tabs and
editors. The only interesting thing is the way Eclipse uses the word editor. In
Eclipse, each tabbed page of the editor area is an individual editor. For
example, the Editor area in Figure 3-16 contains three editors (not three tabs
belonging to a single editor).

(] [J] MyFirstlavaClass.ja 2% | [J] Mertgage.java [1] ThingsILike.java =]
= 1 public class MyFirstloveClass {

. an

) 3 public static void main(String[] args) {
FIGURE 3-16: System.ouvt.println("Chocolate, royalties, sleep");

The editor area
contains three
editors.

}

3 Active view or active editor: In a tab group, the view or editor that's in front.

In Figure 3-16, the MyFirstJavaClass. java editor is the active editor. The
Mortgage. java and ThingsILike. java editors are inactive.

What's inside a view or an editor?

The next several terms deal with individual views, individual editors, and indi-
vidual areas.

3 Toolbar: The bar of buttons (and other little things) at the top of a view. (See
Figure 3-17.)

3 Menu button: A downward-pointing arrow in the toolbar. When you click the
Menu button, a drop-down list of actions appears. (See Figure 3-18.) Which
actions you see in the list varies from one view to another.
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FIGURE 3-17:
The Package
Explorer view's
toolbar.

FIGURE 3-18:
Clicking the
Package Explorer
view's Menu
button.

FIGURE 3-19:
An editor’s Close
button.
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Collapse All (¢ #Numpad_Divide) b

(=
M- = sysvem. out
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» B, JRE System Library [JavaSE-1.8] 7/
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¥ H3 (default package) Select Working Set...
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¥ @i\ JRE System Library [JavaSE-1.5] Edit Active Working Set...
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¥ (Esrc V 151 1 Window Working Set

¥ H4 (default package)

» [J] MyFirstJavaClass.java T Filters...
» m\, JRE System Library [JavaSE-1.8]
v (= 0s-01 Package Presentation 4
¥ [Hsrc + Show 'Referenced Libraries' Node

¥ H4 (default package)
b [J] ThingslLike.java
» m\, JRE System Library [JavaSE-1.8]
> (F05-01
> (= 06-01 ¥
»(log-02

&, Link with Editor

Focus on Active Task

3 Close button: A button that gets rid of a particular view or editor. (See

Figure 3-19.)

[J] MyFirstJavaClass.ja 33 3
1 public class MyBi=c+lgyaClass {
y Close

va ThingslLikg

3= public static void main(String[] args) {
4 System.out.println("Chocolate, royalties,
5

6 1

3 Chevron: A double arrow indicating that other tabs should appear in a
particular area (but that the area isn't wide enough). The chevron in Figure 3-20
has a little number 2 beside it. The 2 tells you that, in addition to the two visible
tabs, two tabs are invisible. Clicking the chevron brings up a hover tip contain-

ing the labels of all the tabs.

¥ Marker bar: The vertical ruler on the left edge of the editor area. Eclipse
displays tiny alert icons, called markers, inside the marker bar. (For an

example, refer to Figure 3-12.)
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FIGURE 3-20:

The chevron
indicates that two
editors are
hidden.

TIP
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|1| MyFirstJavaClas 52 E| Mortgage.java
1 public class MyFirstlavaClass { |

33

=

public static wvoid main{Strim mEcthine.jmra
System.out.println("Chocola [J] ThingslLike.java
[J] Mortgage java
} [J] MyFirstJavaClass.java

Returning to the big picture

The next two terms deal with Eclipse’s overall look and feel:

»

»

Layout: An arrangement of certain views. The layout in Figure 3-3 has seven
views, of which four are easily visible:

At the far left, you see the Package Explorer view.
On the far right, you have the Task List view and the Outline view.

Near the bottom, you get the Problems, Javadoc, Declaration, and Console
views.

Along with all these views, the layout contains a single editor area. Any and all
open editors appear inside this editor area.

Perspective: A very useful layout. If a particular layout is really useful,
someone gives that layout a name. And if a layout has a name, you can use
the layout whenever you want. For example, the workbench of Figure 3-3
displays Eclipse’s Java perspective. By default, the Java perspective contains six
views in an arrangement very much like the arrangement shown in Figure 3-3.

The Console view appears in Figure 3-3, but the Console view doesn't always
appear as part of the Java perspective. Normally, the Console view appears
automatically when you run a text-based Java program. If you want to force
the Console view to appear, choose Window =>Show View = Other. In the
resulting Show View dialog box, expand the General branch. Finally, within
that General branch, double-click the Console item.

Along with all these views, the Java perspective contains an editor area. (Sure,
the editor area has several tabs, but the number of tabs has nothing to do
with the Java perspective.)

You can switch among perspectives by choosing Window => Open Perspective
in Eclipse’s main menu bar. This book focuses almost exclusively on Eclipse’s
Java perspective. But if you like poking around, visit some of the other
perspectives to get a glimpse of Eclipse’s power and versatility.
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TRY IT OUT

Here are some things for you to try to help you understand the material in this
chapter. If trying these things builds your confidence, that’s good. If trying these
things makes you question what you’ve read, that’s good too. If trying these
things makes you nervous, don’t be discouraged. You can find answers and other
help at this book’s website (www.allmycode.com/BeginProg). You can also email
me with your questions (BeginProg@al lmycode.com).

Eclipse basics

Follow the instructions in this chapter’s earlier section “Running a Canned Java
Program.” Then try the following tasks:

»

»

»

»

»

Make sure you can see the mortgage-calculating program’s code in Eclipse’s
editor. If you don't see it, look for @3-0-Mortgage in the Package Explorer
view on the left side of the Eclipse workbench. Expand the 03-0-Mortgage
branch until you see a branch labeled Mortgage. java. Double-click the
Mortgage. java branch.

In Eclipse’s editor, make any change to the text in the mortgage-calculating
program. After making the change, undo the change by selecting Edit=>Undo
from Eclipse’s main menu.

Look for Eclipse's Console tab in the lower portion of the Eclipse workbench. If
you don't see that tab, make the Console view appear by selecting

Window => Show View => Console from Eclipse’s main menu. (If Window => Show
View > Console doesn't work, try Window =>Show View > Other. In the
resulting dialog box, double-click the General &> Console item.)

The Eclipse workbench has several areas. Use the mouse to drag the boundar-
ies between the areas (and thus resize each of the areas). To get the areas back
to the way they were before resizing, select Window > Perspective > Reset
Perspective from Eclipse’s main menu.

The Eclipse workbench has several different perspectives. In this book, you
use the Java perspective. Switch temporarily to the Debug perspective by
selecting Window > Perspective => Open Perspective &> Debug in Eclipse’s main
menu. Notice how the areas and views in the Eclipse workbench change.
Switch back to the Java perspective by selecting Window = Perspective = Open
Perspective =>Java from Eclipse’s main menu. (If, for some reason, Java isn't
among the choices when you select Window => Perspective => Open
Perspective, select Other and look for Java in the resulting dialog box.)
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Experimenting with error messages

Follow the instructions in this chapter’s earlier section "Running a Canned Java
Program." Look for the @3-01 branch in Eclipse’s Package Explorer. As you expand
that @3-01 branch, look for a branch labeled MyFirstJavaClass. java. When you
double-click the MyFirstJavaClass. java branch, the code for MyFirstJavaClass
appears in Eclipse’s editor.

¥ In Eclipse’s editor, change the lowercase letter ¢ in the word class to an
uppercase letter C. When you do this, notice that some red marks appear.
These red marks indicate that your program has a compile-time error. Java is
case-sensitive. So, in a Java program, the word Class (with an uppercase
letter C) doesn’'t mean the same thing as the word class (with a lowercase
letter c).

There are a few places in Project @3-01 where changing the capitalization
doesn't cause errors. But for most of the text, a change in capitalization
causes red error warnings to appear in the Eclipse editor.

3 In Eclipse’s editor, change
System.out.println("You'll love Java!");
to
System.out.println(6/0);
No error markers appear in Eclipse’s editor. But, when you try to run the
program, you see red text in Eclipse’s Console view. The red text indicates that

a runtime exception has occurred. The exception occurs because Java can't
divide a number by 0.
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IN THIS PART ...

Dissecting programs and examining the pieces
Working with numbers

Working with things that aren't numbers



IN THIS CHAPTER

» ldentifying the words in a Java
program

» Using punctuation and indentation

» Understanding Java statements and
methods

Chapter 4

Exploring the Parts of
a Program

work in the science building at a liberal arts college. When I walk past the

biology lab, I always say a word of thanks under my breath. I’'m thankful for not

having to dissect small animals. In my line of work, I dissect computer programs
instead. Computer programs smell much better than preserved dead animals.
Besides, when I dissect a program, I’m not reminded of my own mortality.

In this chapter, I invite you to dissect a program with me. I have a small program,
named ThingsILike. I cut apart the program and carefully investigate the pro-
gram’s innards. Get your scalpel ready. Here we go!

Checking Out Java Code for the First Time

I have a confession to make. The first time I look at somebody else’s computer
program, I feel a bit queasy. The realization that I don’t understand something (or
many things) in the code makes me nervous. I've written hundreds (maybe
thousands) of programs, but I still feel insecure when I start reading someone
else’s code.
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The truth is, learning about a computer program is a bootstrapping experience.
First, I gawk in awe of the program. Then I run the program to see what it does.
Then I stare at the program for a while or read someone’s explanation of the
program and its parts. Then I gawk a little more and run the program again.
Eventually, I come to terms with the program. Don’t believe the wise guys who say
they never go through these steps. Even experienced programmers approach a
new project slowly and carefully.

Behold! A program!

In Listing 4-1, you get a blast of Java code. Like all novice programmers, you’re
expected to gawk humbly at the code. But don’t be intimidated. When you get the
hang of it, programming is pretty easy. Yes, it’s fun, too.

A Simple Java Program

82

FIGURE 4-1:
Running the
program in
Listing 4-1.

/*

* A program to list the good things in life

* Author: Barry Burd, BeginProg@allmycode.com
*x February 13, 2017

*/

class ThingsILike {
public static void main(String args[]) {

System.out.println("Chocolate, royalties, sleep");

}

When I run the program in Listing 4-1, I get the result shown in Figure 4-1: The
computer shows the words Chocolate, royalties, sleep on the screen. Now, I
admit that writing and running a Java program is a lot of work just to get the
words Chocolate, royalties, sleep toappear on somebody’s computer screen,
but every endeavor has to start somewhere.

El Console &2
<terminated> ThingslLike [Java Application] C:\R
Chocolate, royalties, sleep
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Most of the programs in this book are text-based programs. When you run one of
these programs, the input and output appears in Eclipse’s Console view. In con-
trast, a GUI (graphical user interface) program displays windows, buttons, text
fields, and other widgets to interact with the user. You can see GUI versions of the
program in Listing 4-1, and in many other examples from this book, by visiting
the book’s website (http://allmycode.com/BeginProg).

You can run the code in Listing 4-1 on your computer. Here’s how:

1. Follow the instructions in Chapter 2 for installing Eclipse.
2. Then follow the instructions in the first half of Chapter 3.

Those instructions tell you how to run the project named @3-01, which comes
in a download from this book’s website (http://allmycode.com/BeginProg).
To run the code in Listing 4-1, follow the same instructions for the 04-01
project, which comes in the same download.

What the program’s lines say

If the program in Listing 4-1 ever becomes famous, someone will write a Cliffs
Notes book to summarize the program. The book will be really short because you
can summarize the action of Listing 4-1 in just one sentence. Here’s the
sentence:

Display Chocolate, royalties, sleep

on the computer screen.

Now compare the preceding sentence with the bulk in Listing 4-1. Because
Listing 4-1 has so many more lines, you may guess that it has lots of boilerplate
code. Well, your guess is correct. You can’t write a Java program without writing
the boilerplate stuff, but, fortunately, the boilerplate text doesn’t change much
from one Java program to another. Here’s my best effort at summarizing all the
Listing 4-1 text in 66 words or fewer:

This program lists the good things in life.

Barry Burd wrote this program on February 13, 2017.
Barry realizes that you may have questions about this
code, so you can reach him at BeginProg@allmycode.com,

on Twitter at @allmycode, or on Facebook at /allmycode.

This code defines a Java class named ThingsILike.
Here's the main starting point for the instructions:
Display Chocolate, royalties, sleep

on the screen.
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The rest of this chapter (about 5,000 more words) explains the Listing 4-1 code in
more detail.

The Elements in a Java Program

FIGURE 4-2:
The things you
find in a simple

sentence.

That both English and Java are called languages is no coincidence. You use a lan-
guage to express ideas. English expresses ideas to people, and Java expresses ideas
to computers. What’s more, both English and Java have things like words, names,
and punctuation. In fact, the biggest difference between the two languages is that
Java is easier to learn than English. (If English were easy, computers would under-
stand English. Unfortunately, they can’t.)

Take an ordinary English sentence and compare it with the code in Listing 4-1.
Here’s the sentence:

Ann doesn't pronounce the “r" sound because she’s from New York.

In your high school grammar class, you worried about verbs, adjectives, and other
such things. But in this book, you think in terms of keywords and identifiers, as
summarized in Figure 4-2.

Ann’s sentence has all kinds of things in it. They’re the same kinds of things that
you find in a computer program. So here’s the plan: Compare the elements in
Figure 4-2 with similar elements in Listing 4-1. You already understand English,
so you can use this understanding to figure out some new things about Java.

Keywords:
Ann doesn't] [pronounce](the] “r" [sound) (because][she’s]from] New York .

An identifier that you or | can define:

doesn’t pronounce the “r” sound because she’s from New York .

An identifier with a commonly agreed upon meaning:

Ann doesn’t pronounce the “r" sound because she’s from(New York].
A literal:

Ann doesn’t pronounce the["r"Jsound because she's from New York .
Punctuation:

Ann doesn’t pronounce the “r” sound because she’s from New YorkD

A comment:

Ann doesn’t pronounce the “r” sound because she’s from New York .| (That's a sentence.)
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WARNING

But first, here’s a friendly reminder: In the next several paragraphs, I draw
comparisons between English and Java. As you read these paragraphs, keep an
open mind. In comparing Java with English, I may write, “Names of things aren’t
the same as dictionary words.” Sure, you can argue that some dictionaries list
proper nouns and that some people have first names like Hope, Prudence, and
Spike, but please don’t. You’ll get more out of the reading if you avoid nitpicking.
Okay? Are we still friends?

Keywords

A keyword is a dictionary word — a word that’s built right into a language.
In Figure 4-2, a word like “from” is a keyword because “from” plays the same
role whenever it’s used in an English sentence. The other keywords in Ann’s

sentence are “doesn’t,” “pronounce,” “the,” “sound,” “because,” and “she’s.”

Computer programs have keywords, too. In fact, the program in Listing 4-1 uses
four of Java’s keywords (shown in bold):

class ThingsILike {
public static void main(String args[]) {
Each Java keyword has a specific meaning — a meaning that remains unchanged
from one program to another. For example, whenever I write a Java program, the

word public always signals a part of the program that’s accessible to any other
piece of code.

The java proGRAMMing lanGUage is case-sensitive. ThIS MEans that if you change
a lowerCASE LETTer in a wORD TO AN UPPercase letter, you chANge the wORD’S
MEaning. ChangiNG CASE CAN MakE the enTIRE WORD GO FROM BeiNG
MEANINGFul to bEING MEaningless. In Listing 4-1, you can’t replace public
with Public. If you do, the WHOLE PROGRAM STOPS WORKING.
This chapter has little or no detail about the meanings of the keywords class,
public, static, and void. You can peek ahead at the material in other chapters,
or you can get along by cheating. When you write a program, just start with

class SomethingOrOther {
and then paste the text

public static void main(String args[]) {

into your code. In your first few programs, this strategy serves you well.
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Table 4-1 has a complete list of Java keywords.

TABLE 4-1 Java Keywords
abstract continue for new switch
assert default goto package synchronized
boolean do if private this
break double implements protected throw
byte else import public throws
case enum instanceof return transient
catch extends int short try
char final interface static void
class finally long strictfp volatile
const float native super while
In Java, the words true, false, and null have specific meanings. As with the
?63 keywords in Table 4-1, you can’t use true, false, and null to mean anything
other than what they normally mean in a Java program. But for reasons that
tecunica  concern only the fussiest Java experts, true, false, and null are not called Java
STUFF keywords. One way or another, if you scribble the words true, false, and null
into Table 4-1, you’ll be okay.
Here’s one thing to remember about keywords: In Java, each keyword has an offi-
cial, predetermined meaning. The people at Oracle, who have the final say on what
constitutes a Java program, created all of Java’s keywords. You can’t make up your
own meaning for any of the Java keywords. For example, you can’t use the word
public in a calculation:
//This is BAD, BAD CODE:
public = 6;
If you try to use a keyword this way, the compiler displays an error message and
refuses to translate your source code. It works the same way in English. Have a
baby and name it Because:
“Let's have a special round of applause for tonight's master of ceremonies —
Because O. Borel.”
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You can do it, but the kid will never lead a normal life.

Despite my ardent claims in this section, two of Java’s keywords have no meaning
in a Java program. Those keywords — const and goto — are reserved for nonuse
in Java. If you try to create a variable named goto, Eclipse displays an Invalid
VariableDeclaratorId error message. The creators of Java figure that if you use
either of the words const or goto in your code, you should be told politely to move
to the C++ programmers’ table.

Identifiers that you or | can define

I like the name Ann, but if you don’t like traditional names, make up a brand-new
name. You're having a new baby. Call her Deneen or Chrisanta. Name him Belton
or Merk.

A name is a word that identifies something, so I’ll stop calling these things names
and start calling them identifiers. In computer programming, an identifier is a noun
of some kind. An identifier refers to a value, a part of a program, a certain kind of
structure, or any number of things.

Listing 4-1 has two identifiers that you or I can define on our own. They’re the
made-up words ThingsILike and args.

class ThingsILike {
public static void main(String args[]) {

Just as the names Ann and Chrisanta have no special meaning in English, the
names ThingsILike and args have no special meaning in Java. In Listing 4-1, I use
ThingsILike for the name of my program, but I could also have used a name like
GooseCrease, Enzyme, or Kalamazoo. I have to put (String someName[]) in my
program, but I could use (String args[]), (String commandLineArguments[]),
or (String cheese[]).

Make up sensible, informative names for the things in your Java programs. Names
like GooseGrease are legal, and they’re certainly cute, but they don’t help you
keep track of your program-writing strategy.

When I name my Java program, I can use ThingsILike or GooseGrease, but I can’t
use the word public. Words like class, public, static, and void are keywords
in Java.

The args in (String args[]) holds anything extra that you type when you issue

the command to run a Java program. For example, if you get the program to run
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by typing java ThingsILike won too 3, then args stores the extra values won,
too, and 3. As a beginning programmer, you don’t need to think about this feature
of Java. Just paste (String args[]) into each of your programs.

Identifiers with agreed-upon meanings

Many people are named Ann, but only one well-known city is named New York.
That’s because there’s a standard, well-known meaning for the term “New York.”
It’s the city that never sleeps. If you start your own city, you should avoid naming
it New York because naming it New York would just confuse everyone. (I know, a
town in Florida is named New York, but that doesn’t count. Remember, you should
ignore exceptions like this.)

Most programming languages have identifiers with agreed-upon meanings. In
Java, almost all these identifiers are defined in the Java API. Listing 4-1 has five
such identifiers. They’re the words main, String, System, out, and println:

public static void main(String args[]) {

System.out.println("Chocolate, royalties, sleep");

Here’s a quick rundown on the meaning of each of these names (and more detailed
descriptions appear throughout this book):

¥ main: The main starting point for execution in every Java program.
¥ String: A bunch of text; a row of characters, one after another.

¥ System: A canned program in the Java API. This program accesses some
features of your computer that are outside the direct control of the Java
Virtual Machine (JVM).

¥ out: The place where a text-based program displays its text. (For a program
running in Eclipse, the word out represents the Console view. To read more
about text-based programs, check the first several paragraphs of Chapter 3.)

3 printin: Displays text on your computer screen.

The name println comes from the words “print a line.” If you were allowed to
write the name in uppercase letters, it would be PRINTLN, with a letter L near the
end of the word. When the computer executes println, the computer puts
some text in Eclipse’s Console view and then immediately moves to the beginning of
the next line in preparation for whatever else will appear in the Console view.
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Strictly speaking, the meanings of the identifiers in the Java API aren’t cast in
stone. Although you can make up your own meanings for words like System or
println, doing so isn’t a good idea — because you’d confuse the dickens out of
other programmers, who are used to the standard API meanings for these familiar
identifier names.

Literals

A literal is a chunk of text that looks like whatever value it represents. In Ann’s
sentence (refer to Figure 4-2), “r” is a literal because “r” refers to the letter r.

Programming languages have literals, too. For example, in Listing 4-1, the stuff
in quotes is a literal:

System.out.println("Chocolate, royalties, sleep");
When you run the ThingsILike program, you see the words Chocolate,
royalties, sleep on the screen. In Listing 4-1, the text "Chocolate, royalties,
sleep” refers to these words, exactly as they appear on the screen (minus the

quotation marks).

Most of the numbers that you use in computer programs are literals. If you put the
statement

mySalary = 1000000.00;

in a computer program, then 1000000 .00 is a literal. It stands for the number
1000000.00 (one million).

If you don’t enjoy counting digits, you can put the following statement in your
Java 7 program:

mySalary = 1_000_000.00;
Starting with Java 7, numbers with underscores are permissible as literals.

In versions of Java before Java 7, you cannot use numbers such as 1_000_000 .00
in your code.

Different countries use different number separators and different number for-
mats. For example, in the United States, you write 1,234,567,890.55. In France,
you write 1234567890,55. In India, you group digits in sets of two and three. You
write 1,23,45,67,890.55. You can’t put a statement like mySalary = 1,000,000 .00
in your Java program. Java’s numeric literals don’t have any commas in them. But
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you can write mySalary = 10_00_000.00 for easy-to-read programming in India.
And for a program’s output, you can display numbers like 1234567890,55
using Java’s Locale and NumberFormat classes. (For more on Locale and
NumberFormat, check out Chapter 18.)

Punctuation

A typical computer program has lots of punctuation. For example, consider the
program in Listing 4-1:

class ThingsILike {

public static void main(String args[]) {
System.out.println("Chocolate, royalties, sleep");

}

Each bracket, each brace, each squiggle of any kind plays a role in making the
program meaningful.

In English, you write all the way across one line and then you wrap the text to the
start of the next line. In programming, you seldom work this way. Instead, the
code’s punctuation guides the indenting of certain lines. The indentation shows
which parts of the program are subordinate to which other parts. It’s as though,
in English, you wrote a sentence like this:

Ann doesn’t pronounce the “r” sound because

as we all know

)

she’s from New York.

The diagrams in Figures 4-3 and 4-4 show you how parts of the ThingsILike
program are contained inside other parts. Notice how a pair of curly braces acts
like a box. To make the program’s structure visible at a glance, you indent all the
stuff inside of each box.
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class ThingsTlLike {

public static void main(String args[]) {

system.out.println("Chocolate, royalties, sleep");

Here's a Java class named ThingsIlike:

Here's the main starting point for the instructions:

Display Chocolate, royalties, sleep on the screen.

I can’t emphasize this point enough: If you don’t indent your code or if you indent
but you don’t do it carefully, your code still compiles and runs correctly. But this
successful run gives you a false sense of confidence. The minute you try to update
some poorly indented code, you become hopelessly confused. Take my advice:
Keep your code carefully indented at every step in the process. Make its indenta-
tion precise, whether you’re scratching out a quick test program or writing code
for a billionaire customer.

Eclipse can indent your code automatically for you. Select the . java file whose
code you want to indent. Then, on Eclipse’s main menu, choose Source=> Format.
Eclipse rearranges the lines in the editor, indenting things that should be indented
and generally making your code look good.

Comments

A comment is text that’s outside the normal flow. In Figure 4-2, the words “That’s
a sentence” aren’t part of the Ann sentence. Instead, these words are about the
Ann sentence.

The same is true of comments in computer programs. The first five lines in
Listing 4-1 form one big comment. The computer doesn’t act on this comment.
There are no instructions for the computer to perform inside this comment.
Instead, the comment tells other programmers something about your code.

Comments are for your own benefit, too. Imagine that you set aside your code for

a while and work on something else. When you return later to work on the code
again, the comments help you remember what you were doing.

CHAPTER 4 Exploring the Parts of a Program o1



92

The Java programming language has three kinds of comments:

¥ Traditional comments: The comment in Listing 4-1 is a traditional comment.

»

TIP

The comment begins with /x and ends with x/. Everything between the
opening /* and the closing */ is for human eyes only. Nothing between
/* and x/ gets translated by the compiler.

The second, third, and fourth lines in Listing 4-1 have extra asterisks. | call
them “extra” because these asterisks aren’t required when you create a
comment. They just make the comment look pretty. | include them in
Listing 4-1 because, for some reason that | don't entirely understand, most
Java programmers add these extra asterisks.

End-of-line comments: Here's some code with end-of-line comments:

class ThingsILike { //Two things are missing

public static void main(String args[]) {

System.out.println("sleep"); // Missing from here

An end-of-line comment starts with two slashes and extends to the end of a
line of type.

You may hear programmers talk about commenting out certain parts of their
code. When you're writing a program and something's not working correctly,
it often helps to try removing some of the code. If nothing else, you find out
what happens when that suspicious code is removed. Of course, you may
not like what happens when the code is removed, so you don't want to
delete the code completely. Instead, you turn your ordinary Java statements
into comments. For example, turn System.out.println("Sleep"); into

/* System.out.println("Sleep"); x/.This keeps the Java compiler from
seeing the code while you try to figure out what's wrong with your program.

¥ Javadoc comments: A special Javadoc comment is any traditional comment

that begins with an extra asterisk:

/%%
* Print a String and then terminate the line.
*/

This is a cool Java feature. The Java SE software that you download from
Oracle's website includes a little program called javadoc. The javadoc
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program looks for these special comments in your code. The program uses
these comments to create a brand-new web page — a customized documenta-
tion page for your code. To find out more about turning Javadoc comments
into web pages, visit this book’s website (http://allmycode.com/BeginProg).

Understanding a Simple Java Program

The following sections present, explain, analyze, dissect, and otherwise demystify
the Java program in Listing 4-1.

What is a method?

You’re working as an auto mechanic in an upscale garage. Your boss, who’s always
in a hurry and has a habit of running words together, says, “fixTheAlternator
on that junkyOldFord.” Mentally, you run through a list of tasks. “Drive the car
into the bay, lift the hood, get a wrench, loosen the alternator belt,” and so on.
Three things are going on here:

3 You have a name for the thing you're supposed to do. The name is
fixTheAlternator.

3 Inyour mind, you have a list of tasks associated with the name
fixTheAlternator. The list includes “Drive the car into the bay, lift the
hood, get a wrench, loosen the alternator belt,” and so on.

3 You have a grumpy boss who's telling you to do all this work. Your boss
gets you working by saying, “fixTheAlternator.” In other words, your boss gets
you working by saying the name of the thing you're supposed to do.

In this scenario, using the word method wouldn’t be a big stretch. You have a
method for doing something with an alternator. Your boss calls that method into
action, and you respond by doing all the things in the list of instructions that
you’ve associated with the method.

Java methods

If you believe all that stuff in the preceding section, you’re ready to read about
Java methods. In Java, a method is a list of things to do. Every method has a name,
and you tell the computer to do the things in the list by using the method’s name
in your program.
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I've never written a program to get a robot to fix an alternator. But, if I were to,
the program might include a method named fixTheAlternator. The list of
instructions in my fixTheAlternator method would look something like the text
in Listing 4-2.

A Method Declaration

void fixTheAlternator(onACertainCar) ({
drivelnto(car, bay);
lift(hood);
get(wrench);
loosen(alternatorBelt);

Somewhere else in my Java code (somewhere outside of Listing 4-2), I need an
instruction to call my fixTheAlternator method into action. The instruction to
call the fixTheAlternator method into action may look like the line in
Listing 4-3.

Calling a Method
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fixTheAlternator (junkyOldFord);

Don’t scrutinize Listings 4-2 and 4-3 too carefully. All the lines of code in
Listings 4-2 and 4-3 are fakes! I made up this code so that it looks a lot like real
Java code, but it’s not real. What’s more important, the code in Listings 4-2
and 4-3 isn’t meant to illustrate all the rules about Java. So if you have a grain of
salt handy, take it with Listings 4-2 and 4-3.

Almost every computer programming language has something akin to Java’s
methods. If you’ve worked with other languages, you may remember things like
subprograms, procedures, functions, subroutines, Sub procedures, or PERFORM
statements. Whatever you call it in your favorite programming language, a method
is a bunch of instructions collected together and given a new name.

The declaration, the header, and the call

If you have a basic understanding of what a method is and how it works (see
preceding section), you can dig a little deeper into some useful terminology:
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¥ If 'm being lazy, | refer to the code in Listing 4-2 as a method. If 'm not being
lazy, | refer to this code as a method declaration.

¥ The method declaration in Listing 4-2 has two parts. The first line (the part
with the name fixTheAlternator in it, up to but not including the open curly
brace) is called a method header. The rest of Listing 4-2 (the part surrounded
by curly braces) is a method body.

3 The term method declaration distinguishes the list of instructions in Listing 4-2
from the instruction in Listing 4-3, which is known as a method call.

For a handy illustration of all the method terminology, see Figure 4-5.

_.----1 method header

. void fixTheAlternator (onACertainCar) H I
---------------------------------------- o
©" drivelnto(car, bay): E .--1 method body
lift (hood) ; 1
'
get (wrench) ; 4

loosen (alternatorBelt) ;

\\\ __________________________________________ /\ method declaration

(or “method” for short)

FIGURE 4.5: fixTheAlternator (junkyOldFord) ; ]
The terminology method call
describing

methods.

A method’s header and body are like an entry in a dictionary. An entry doesn’t
really use the word that it defines. Instead, an entry tells you what happens if and
when you use the word:

chocolate (choc-o-late) n. 1. The most habit-forming substance on earth. 2.
Something you pay for with money from royalties. 3. The most important nutri-
tional element in a person's diet.

fixTheAlternator(onACertainCar) Drive the car into the bay, lift the hood, get the
wrench, loosen the alternator belt, and then eat some chocolate.
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In contrast, a method call is like the use of a word in a sentence. A method call sets
some code in motion:

“l want some chocolate, or I'll throw a fit.”

“fixTheAlternator on that junkyOldFord.”

A method’s declaration tells the computer what will happen if you call the method
into action. A method call (a separate piece of code) tells the computer to actually
call the method into action. A method’s declaration and the method’s call tend to
be in different parts of the Java program.

The main method in a program

In Listing 4-1, the bulk of the code is the declaration of a method named main.
(Just look for the word main in the code’s method header.) For now, don’t worry
about the other words in the method header — the words public, static, void,
String, and args. I explain these words (on a need-to-know basis) in the next
several chapters.

Like any Java method, the main method is a recipe:

How to make biscuits:
Preheat the oven.
Roll the dough.
Bake the rolled dough.

or

How to follow the main instructions in
the ThingslIlLike code:

Display Chocolate, royalties, sleep on the screen.

The word main plays a special role in Java. In particular, you never write code that
explicitly calls a main method into action. The word main is the name of the
method that is called into action automatically when the program begins
running.

When the ThingsILike program runs, the computer automatically finds the pro-
gram’s main method and executes any instructions inside the method’s body. In
the ThingsIL ike program, the main method’s body has only one instruction. That
instruction tells the computer to print Chocolate, royalties, sleep on the
screen.
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None of the instructions in a method is executed until the method is called into
action. But if you give a method the name main, that method is called into action
automatically.

How you finally tell the computer
to do something

Buried deep in the heart of Listing 4-1 is the single line that actually issues a
direct instruction to the computer. The line

System.out.println("Chocolate, royalties, sleep");

tells the computer to display the words Chocolate, royalties, sleep. (If you
use Eclipse, the computer displays Chocolate, royalties, sleep in the Console
view.) I can describe this line of code in at least two different ways:

¥ It's a statement. In Java, a direct instruction that tells the computer to do
something is called a statement. The statement in Listing 4-1 tells the com-
puter to display some text. The statements in other programs may tell the
computer to put 7 in a certain memory location or make a window appear on
the screen. The statements in computer programs do all kinds of things.

¥ It's a method call. Earlier in this chapter, | describe something named a
method call. The statement

fixTheAlternator ( junkyOldFord);
is an example of a method call, and so is

System.out.println("Chocolate, royalties, sleep");

Java has many different kinds of statements. A method call is just one kind.

Ending a statement with a semicolon

In Java, each statement ends with a semicolon. The code in Listing 4-1 has only
one statement in it, so only one line in Listing 4-1 ends with a semicolon.

Take any other line in Listing 4-1 — the method header, for example. The method
header (the line with the word main in it) doesn’t directly tell the computer to do
anything. Instead, the method header describes some action for future reference.
The header announces “Just in case someone ever calls the main method, the next
few lines of code tell you what to do in response to that call.”
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Every complete Java statement ends with a semicolon. A method call is a state-
ment, so it ends with a semicolon, but neither a method header nor a method
declaration is a statement.

The method named System.out.printin

The statement in the middle of Listing 4-1 calls a method named System.out.
println. This method is defined in the Java API. Whenever you call the System.
out.println method, the computer displays text on its screen.

Think about names. Believe it or not, I know two people named Pauline Ott. One
of them is a nun; the other is a physicist. Of course, there are plenty of Paulines in
the English-speaking world, just as there are several things named print1n in the
Java API. To distinguish the physicist Pauline Ott from the film critic Pauline Kael,
I write the full name Pauline Ott. And to distinguish the nun from the physicist,
I write “Sister Pauline Ott.” In the same way, I write either System.out.println
or DriverManager.println. The first (which you use often) writes text on the
computer’s screen. The second (which you don’t use at all in this book) writes to
a database log file.

Just as Pauline and Ott are names in their own right, so System, out and println
are names in the Java API. But to use println, you must write the method’s full
name. You never write println alone. It’s always System.out .print1ln or another
combination of API names.

The Java programming language is cAsE-sEnSiTiVe. If you change a lowercase
letter to an uppercase letter (or vice versa), you change a word’s meaning. You
can’t replace System.out.println with system.out.Println. If you do, your
program won’t work.

Methods, methods everywhere

Two methods play roles in the ThingsILike program. Figure 4-6 illustrates the
situation, and the next few bullets give you a guided tour.

3 There's a declaration for amain method. | wrote the main method myself.
This main method is called automatically whenever | start running the
ThingsILike program.

¥ There's a call to the System.out . print1n method. The method call for the
System.out.println method is the only statement in the body of themain
method. In other words, calling the System.out . print1n method is the only
thing on the main method's to-do list.

The declaration for the System.out.println method is buried inside the
official Java API. For a refresher on the Java API, refer to Chapter 1.
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The Java Virtual Machine calls your
main method antomatically, and then ...

class ThingsILike {

public static void main(String args[]) {
[System.out.println]("chocolate, royalties, sleep™);

}

... a statement in your main method calls the
System.out .println method.

public void println(String s) {
Somewhere inside ensuredpen () ;

the Java API.... textOout.write(s) s
textout.flushBuffer () ;

When I say things like “System.out.println is buried inside the API,” I’m not
doing justice to the API. True, you can ignore all the nitty-gritty Java code inside
the API. All you need to remember is that System.out.println is defined some-
where inside that code. But I’m not being fair when I make the API code sound like
something magical. The API is just another bunch of Java code. The statements in
the API that tell the computer what it means to carry out a call to System.out.
println look a lot like the Java code in Listing 4-1.

The Java class

Have you heard the term object-oriented programming (also known as OOP)? OOP is
a way of thinking about computer programming problems — a way that’s sup-
ported by several different programming languages. OOP started in the 1960s with
a language called Simula. It was reinforced in the 1970s with another language,
named Smalltalk. In the 1980s, OOP took off big-time with the language C++.

Some people want to change the acronym and call it COP — class-oriented pro-
gramming. That’s because object-oriented programming begins with something
called a class. In Java, everything starts with classes, everything is enclosed in
classes, and everything is based on classes. You can’t do anything in Java until
you’ve created a class of some kind. It’s like being on Jeopardy, hearing Alex Trebek
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say, “Let’s go to a commercial,” and then interrupting him by saying, “I’m sorry,
Alex. You can’t issue an instruction without putting your instruction inside a
class.”

It’s important for you to understand what a class really is, so I dare not give a
haphazard explanation in this chapter. Instead, I devote much of Chapter 17 to the
question “What is a class?” Anyway, in Java, your main method has to be inside a
class. I wrote the code in Listing 4-1, so I got to make up a name for my new class.
I chose the name ThingsILike, so the code in Listing 4-1 starts with the words
class ThingsILike.

Take another look at Listing 4-1 and notice what happens after the line class
ThingsILike. The rest of the code is enclosed in curly braces. These braces
mark all the stuff inside the class. Without these braces, you’d know where the
declaration of the ThingsILike class starts, but you wouldn’t know where the
declaration ends.

It's as though the stuff inside the ThingsILike class is in a box. (Refer to
Figure 4-3.) To box off a chunk of code, you do two things:

3 You use curly braces. These curly braces tell the compiler where a chunk of
code begins and ends.

3 You indent code. Indentation tells your human eye (and the eyes of other
programmers) where a chunk of code begins and ends.

Don’t forget. You have to do both.

THE WORDS IN A PROGRAM

Listing 4-1 contains several kinds of words. Find out what happens when you
change some of these words.

¥ Change one of the keywords. For example, change the word class to the
word bologna. Look for an error message in Eclipse’s editor.

3 Change one of the identifiers that you or | can define. For example, change
the word args to the word malarkey. After doing so, can your program
still run?

The word ThingsILike is also a word that you or | can make up. So you can
try changing the word ThingsILike to a different word. If you've copied the
code exactly as it is in Listing 4-1, your program still runs. But if your program
starts with the word public, asin

public class SomeOtherWord {
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you might have some trouble. If you do, simply remove the word public.

¥ Change an identifier that has an agreed-upon meaning. For example, change
printlntodisplay. Look for an error message in Eclipse’s editor.

¥ Change the program’s punctuation. For example, remove a pair of curly
braces. Look for an error message in Eclipse’s editor.

¥ Comment out the entire System.out.println("Chocolate, royalties,
sleep"); line. (Use the end-of-line commenting style.) What happens when
you run the program?

¥ Comment out the entire System.out.println("Chocolate, royalties,
sleep"); line. (Use the traditional commenting style.) What happens when
you run the program?

VALID IDENTIFIERS

There are limits to the kinds of names you can make up. For example, a person’s
name might include a dash, but it can’t include a question mark. (At least it can’t
where I come from.) A well-known celebrity’s name can be an unpronounceable
symbol. But for most of us, plain old letters, dashes, and hyphens are all we
can use.

What kinds of names can you make up as part of a Java program? Find out by
changing the word args to these other words in Eclipse’s editor. Which of the
changes are okay, and which are not?

¥ helloThere
¥ hello_there
¥» args7

¥» ar7gs

» 75

¥» Targs

¥ hello there
¥ hello-there
¥» public

¥ royalties
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¥ @args
¥ #args
¥» /args

YOUR FAVORITE THINGS

Change the code in Listing 4-1 so that it displays things that you like. Run the
program to make sure that it displays these things in the Eclipse Console view.
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IN THIS CHAPTER

» Reading input from the keyboard

» Editing a program

» Shooting at trouble

Chapter 5
Composing a Program

ust yesterday, I was chatting with my servant, RoboJeeves. (RoboJeeves is an
upscale model in the RJ-3000 line of personal robotic life-forms.) Here’s how
the discussion went:

Me: RoboJeeves, tell me the velocity of an object after it's been falling for three
seconds in a vacuum.

Robojeeves: All right, | will. “The velocity of an object after it's been falling for three
seconds in a vacuum.” There, | told it to you.

Me: RoboJeeves, don't give me that smart-alecky answer. | want a number. | want
the actual velocity.

Robojeeves: Okay! “A number; the actual velocity.”

Me: R), these cheap jokes are beneath your dignity. Can you or can’t you tell me the
answer to my question?

Robojeeves: Yes.

Me: “Yes,” what?

RoboJeeves: Yes, | either can or can't tell you the answer to your question.
Me: Well, which is it? Can you?

Robojeeves: Yes, | can.
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Me: Then do it. Tell me the answer.
RoboJeeves: The velocity is 153,984,792 miles per hour.

Me: (After pausing to think. .. .) RJ, | know you never make a mistake, but that
number, 153,984,792, is much too high.

Robojeeves: Too high? That's impossible. Things fall very quickly on the giant planet
Mangorrrrkthongo. Now, if you wanted to know about objects falling on Earth, you
should have said so in the first place.

Sometimes that robot rubs me the wrong way. The truth is, RoboJeeves does
whatever I tell him to do — nothing more and nothing less. If I say “Feed the cat,”
then RJ says, “Feed it to whom? Which of your guests will be having cat for
dinner?”

Computers Are Stupid

104

Handy as they are, all computers do the same darn thing. They do exactly what you
tell them to do, and that’s sometimes very unfortunate. For example, in 1962, a
Mariner spacecraft to Venus was destroyed just four minutes after its launch.
Why? It was destroyed because of a missing keystroke in a FORTRAN program.
Around the same time, NASA scientists caught an error that could have trashed
the Mercury space flights. (Yup! These were flights with people on board!) The
error was a line with a period instead of a comma. (A computer programmer wrote
DO 1@ I=1.10 instead of DO 10 I=1,10.)

With all due respect to my buddy RoboJeeves, he and his computer cousins are all
incredibly stupid. Sometimes they look as though they’re second-guessing us
humans, but actually they’re just doing what other humans told them to do. They
can toss virtual coins and use elaborate schemes to mimic creative behavior, but
they never really think on their own. If you say, “Jump,” they do what they’re
programmed to do in response to the letters J-u-m-p.

So, when you write a computer program, you have to imagine that a genie has
granted you three wishes. Don’t ask for eternal love because, if you do, the genie
will give you a slobbering, adoring mate — someone you don’t like at all. And
don’t ask for a million dollars unless you want the genie to turn you into a bank
robber.

Everything you write in a computer program has to be precise. Take a look at an
example. . ..
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A Program to Echo Keyboard Input

Listing 5-1 contains a small Java program. The program lets you type one line of
characters on the keyboard. As soon as you press Enter, the program displays a
second line that copies whatever you typed.

ICSIIEEN Ajova Program

import java.util.Scanner;

class EcholLine {

public static void main(String args[]) {
Scanner keyboard = new Scanner(System.in);

System.out.println(keyboard.nextLine());

keyboard.close();

Most of the programs in this book are text-based programs. When you run one of

these programs, the input and output appears in Eclipse’s Console view. You can

see GUI versions of the program in Listing 5-1 — and of many other examples from
rememeer  this book — by visiting the book’s website (http://allmycode.com/BeginProg).

Figure 5-1 shows a run of the EcholL ine code (the code in Listing 5-1). The text in
the figure is a mixture of my own typing and the computer’s responses.

El Console 52

FIGURE 5-1: <terminated> EchoLine [Java Application] C:

What part of the Please don't repeat this to anyone.

word don't do you Please don't repeat this to anyone.

not understand?

In Figure 5-1, I type the first line (the first Please don't repeat this to anyone
line), and the computer displays the second line. Here’s what happens when you
run the code in Listing 5-1:

1. at first, the computer does nothing.

The computer is waiting for you to type something.
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2. You click inside Eclipse’s Console view.

As a result, you see a cursor on the left edge of Eclipse’s Console view, as
shown in Figure 5-2.

El Console 22

EchoLine [Java Application] C:\Progran

FIGURE 5-2: |

The computer
waits for you to
type something.

3. You type one line of text — any text at all. (See Figure 5-3.)

El Console 2
EchoLine [Java Application] C:\Program FileshJ

Please don't repeat this to anyone.|

FIGURE 5-3:
You type a
sentence.
4. You press Enter, and the computer displays another copy of the line that
you typed, as shown in Figure 5-4.
El Console 52
FIGURE 5-4: <terminated> EchoLine [Java Application] C:

The computer
echoes your

Please don't repeat this to anyone.
Please don't repeat this to anyone.

input.

After a copy of your input is displayed, the program’s run comes to an end.

Typing and running a program

This book’s website (http://allmycode.com/BeginProg) has a link for down-
loading all the book’s Java programs. After you download the programs, you can
follow the instructions in Chapter 2 to add the programs to your Eclipse work-
space. Then, to test the code in Listing 5-1, you can run the ready-made 05-01
project.
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But instead of running the ready-made code, I encourage you to start from
scratch — to type Listing 5-1 yourself and then to test your newly created code.
Just follow these steps:

1.
2.
3.
4,
5.
6.
N 7.
8.

Launch Eclipse.

From Eclipse’s menu bar, choose File=> New => Java Project.
Eclipse’s New Java Project dialog box appears.

In the dialog box’s Project Name field, type MyNewProject.
Click Finish.

Clicking Finish brings you back to the Eclipse workbench, with MyNewPro ject in
the Package Explorer. The next step is to create a new Java source code file.

In the Package Explorer, select MyNewProject and then, on Eclipse’s main
menu, choose File=> New => Class.

Eclipse’s New Java Class dialog box appears.
In the New Java Class dialog box’s Name field, type the name of your new class.

In this example, use the name EcholL ine. Spell EchoL ine exactly the way | spell
it in Listing 5-1, with a capital E, a capital L, and no blank space.

In Java, consistent spelling and capitalization are very important — if you're not
consistent within a particular program, the program will probably have some
nasty, annoying compile-time errors.

Optionally, you can put a check mark in the box labeled public static void
main(String[] args}. If you leave the box unchecked, you'll have a bit more
typing to do when you get to Step 8. Either way (checked or unchecked), it's no
big deal.

Click Finish.

Clicking Finish brings you back to the Eclipse workbench. An editor in this
workbench has a tab named EchoLine.java.

Type the program of Listing 5-1 in the EchoLine.java editor.
Copy the code exactly as you see it in Listing 5-1.
Spell each word exactly the way I spell it in Listing 5-1.
Capitalize each word exactly the way | do in Listing 5-1.

Include all the punctuation symbols: the dots, the
semicolons — everything.

Double-check the spelling of the word print1ln. Make sure that each
character in the word println is a lowercase letter. (In particular, the 1 in
1n is a letter, not a digit.)
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write the name in uppercase letters, it would be PRINTLN, with a letter L near
the end of the word. (Unfortunately, Java is case-sensitive. So you have to type
REMEMBER println, which might look as though it contains a digit 1. It doesn't.)

@ The name println comes from the words “print a line.” If you were allowed to

If you typed everything correctly, you don't see any error markers in the editor.

If you see error markers, go back and compare everything you typed with the
stuff in Listing 5-1. Compare every letter, every word, every squiggle, every

smudge.
If you're reading an electronic version of this book, you might try copying
directly from Listing 5-1 and pasting it into Eclipse’s editor. This strategy might
be okay, but you might also find that the book’s electronic image contains
TIP characters that don't belong in a Java program. For example, many books use

curly quotation marks (“ and ”), which are different from Java's straight
quotation mark ("). And remember, you can download bona fide electronic
copies of the examples in this book by visiting the book’s website, http: //
allmycode.com/BeginProg.

9. Make any changes or corrections to the code in the editor.
When at last you see no error markers, you're ready to run the program.

10. select the EchoL ine class by either clicking inside the editor or clicking
the MyNewPro ject branch in the Package Explorer.

11

On Eclipse’s main menu, choose Run = Run As => Java Application.
Your new Java program runs, but nothing much happens.

12

Click inside Eclipse’s Console view.

As a result, a cursor sits on the left edge of Eclipse’s Console view. (Refer to
Figure 5-2.) The computer is waiting for you to type something.

& If you forget to click inside the Console view, Eclipse may not send your
keystrokes to the running Java program. Instead, Eclipse may send your
keystrokes to the editor or (strangely enough) to the Package Explorer.
WARNING

13

Type a line of text and then press Enter.

In response, the computer displays a second copy of your line of text. Then the
program’s run comes to an end. (Refer to Figure 5-4.)

If this list of steps seems a bit sketchy, you can find much more detail in Chapter 3.

(Look first at the “Typing and Running Your Own Code” section in Chapter 3.) For
the most part, the steps here are a quick summary of the material in Chapter 3.
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So, what’s the big deal when you type the program yourself? Well, lots of interest-
ing things can happen when you apply fingers to keyboard. That’s why the second
half of this chapter is devoted to troubleshooting.

How the EchoLine program works

When you were a tiny newborn, resting comfortably in your mother’s arms, she
told you how to send characters to the computer screen:

System.out.println(whatever text you want displayed);

What she didn’t tell you was how to fetch characters from the computer keyboard.
There are lots of ways to do it, but the one I recommend in this chapter is

keyboard.nextLine()
Now, here’s the fun part. Calling the nextlL ine method doesn’t just scoop charac-
ters from the keyboard. When the computer runs your program, the computer
substitutes whatever you type on the keyboard in place of the text keyboard.
nextLine().
To understand this, look at the statement in Listing 5-1:
System.out.println(keyboard.nextLine());
When you run the program, the computer sees your call to nextlLine and stops
dead in its tracks. (Refer to Figure 5-2.) The computer waits for you to type a line
of text. So (refer to Figure 5-3) you type this line:

Hey, there's an echo in here.

The computer substitutes this entire Hey line for the keyboard.nextLine() call in
your program. The process is illustrated in Figure 5-5.

The call to keyboard.nextLine() is nestled inside the System.out.println call.
So, when all is said and done, the computer behaves as though the statement in
Listing 5-1 looks like this:

System.out.println("Hey, there's an echo in here.");

The computer displays another copy of the text Hey, there's an echo in here.
on the screen. That’s why you see two copies of the Hey line in Figure 5-4.
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FIGURE 5-5:

The computer
substitutes text in
place of the
nextlLine call.

Hey, there’s an

echo in here.

System.out.printin( "Hey, there's an ..." };

System.out.println( keyboard.nextLine(} )

Getting numbers, words, and other things

In Listing 5-1, the words keyboard.nextLine() get an entire line of text from the
computer keyboard. If you type

Testing 1 2 3
the program in Listing 5-1 echoes back the entire Testing 1 2 3 line of text.

Sometimes you don’t want a program to get an entire line of text. Instead, you
want the program to get a piece of a line. For example, when you type 1 2 3, you
may want the computer to get the number 1. (Maybe the number 1 stands for one
customer or something like that.) In such situations, you don’t put keyboard.
nextlLine() in your program. Instead, you use keyboard. nextInt().

Table 5-1 shows you a few variations on the keyboard.next business. Unfortu-
nately, the table’s entries aren’t very predictable. To read a line of input, you call
nextlLine. But to read a word of input, you don’t call nextWord. (The Java API has
no nextWord method.) Instead, to read a word, you call next.

Also, the table’s story has a surprise ending. To read a single character, you don’t
call nextSomething. Instead, you can call the bizarre findwithinHorizon(".",0).
charAt(@) combination of methods. (You’ll have to excuse the folks who created
the Scanner class. They created Scanner from a specialized point of view.)

110  PART 2 Writing Your Own Java Programs



TABLE 5-1 Some Scanner Methods
A number with no decimal pointin it nextInt()
A number with a decimal point in it nextDouble()
A word (ending in a blank space, for example) next()
A line (or what remains of a line after you've already read nextLine()

some data from the line)

A single character (such as a letter, digit, or findWithinHorizon(".",@).charAt(Q)
punctuation character)

To see some of the table’s methods in action, check other program listings in this
book. Chapters 6, 7, and 8 have some particularly nice examples.

GETTING SINGLE WORDS AND ENTIRE LINES OF TEXT

Follow the instructions in this chapter’s “Typing and running a program” section,
but make these two changes:

¥ In Step 6, type Getlnput in the Name field of the New Java Class dialog box.
¥ Instead of typing the code in Listing 5-1, type the following program:

import java.util.Scanner;

public class GetlInput {

public static void main(String[] args) {

Scanner keyboard = new Scanner(System.in);
System.out.println(keyboard.next());
System.out.println(keyboard.next());

System.out.println(keyboard.nextLine());

keyboard.close();

When the program runs, type the following text (all on one line) in Eclipse’s Con-
sole view, and then press Enter. How does the computer respond? Why?

I enjoy learning Java.
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Type three lines of code and don’t look back

Buried innocently inside Listing 5-1 are three extra lines of code. These lines help
the computer read input from the keyboard. The three lines are

import java.util.Scanner;
Scanner keyboard = new Scanner(System.in);
keyboard.close();

Concerning these three lines, I have bad news and good news:

3 The bad news is, the reasoning behind these lines is difficult to under-
stand. That's especially true here in Chapter 5, where | introduce Java's most
fundamental concepts.

3 The good news is, you don’t have to understand the reasoning behind
these three lines. You can copy and paste these lines into any program that
gets input from the keyboard. You don't have to change the lines in any way.
These lines work without any modifications in all kinds of Java programs.

Just be sure to put these lines in the right places:

¥ Make the import java.util.Scanner line the first line in your program.

¥ Putthe Scanner keyboard = new Scanner(System.in) line inside the
main method immediately after the public static void main(String
args[]) {line.

¥ Make the keyboard.close() line the last line in your program.

At some point in the future, you may have to be more careful about the positioning
of these three lines. But for now, the rules I give will serve you well.

A QUICK LOOK AT THE SCANNER

In this chapter, | advise you to ignore any of the meanings behind the lines import
java.util.Scanner and Scanner keyboard, etc. Just paste these two lines mind-
lessly in your code and then move on.

Of course, you may not want to take my advice. You may not like ignoring things in your
code. If you happen to be such a stubborn person, | have a few quick facts for you:
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® The word Scanner is defined in the Java API.
A Scanner is something you can use for getting input.

This Scanner class belongs to Java versions 5.0 and higher. If you use version Java
1.4.2, you don't have access to the Scanner class. (You see an error marker when
you type Listing 5-1.)

® The words System and in are defined in the Java API.
Taken together, the words System. in stand for the computer keyboard.

In later chapters, you see things like new Scanner(new File("myData.txt")).
In those chapters, | replace System. in with the words new File("myData.txt")
because I'm not getting input from the keyboard. Instead, I'm getting input from a
file on the computer’'s hard drive.

® The word keyboard doesn’t come from the Java API.

The word keyboard is a Barry Burd creation. Instead of keyboard, you can use
readingThingie (or any other name you want to use as long as you use the name
consistently). So, if you want to be creative, you can write

Scanner readingThingie = new Scanner(System.in);
System.out.println(readingThingie.nextlLine());

The revised Listing 5-1 (with readingThingie instead of keyboard) compiles and
runs without a hitch.

® Theline import java.util.Scanner is an example of an import declaration.

The optional import declaration allows you to abbreviate names in the rest of your
program. You can remove the import declaration from Listing 5-1. But if you do, you
must use the Scanner class's fully qualified name throughout your code. Here's how:

class EcholLine {
public static void main(String args[]) {
java.util.Scanner keyboard = new java.util.Scanner(System.in);
System.out.println(keyboard.nextLine());

keyboard.close();

}
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Expecting the Unexpected
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Not long ago, I met an instructor with an interesting policy. He said, “Sometimes
when I’m lecturing, I compose a program from scratch on the computer. I do it
right in front of my students. If the program compiles and runs correctly on the
first try, I expect the students to give me a big round of applause.”

At first, you may think this guy has an enormous ego, but you have to put things
in perspective. It’s unusual for a program to compile and run correctly the first
time. There’s almost always a typo or another error of some kind.

So this section deals with the normal, expected errors that you see when you com-
pile and run a program for the first time. Everyone makes these mistakes, even
the most seasoned travelers. The key is keeping a cool head. Here’s my general
advice:

3 Don't expect a program that you type to compile the first time.
Be prepared to return to your editor and fix some mistakes.
3 Don't expect a program that compiles flawlessly to run correctly.

Even with no error markers in Eclipse’s editor, your program might still
contain flaws. After Eclipse compiles your program, you still have to run it
successfully. That is, your program should finish its run and display the correct
output.

You compile and then you run. Getting a program to compile without errors is
the easier of the two tasks.

3 Read what's in the Eclipse editor, not what you assume is in the Eclipse
editor.

Don't assume that you've typed words correctly, that you've capitalized words
correctly, or that you've matched curly braces or parentheses correctly.
Compare the code you typed with any sample code that you have. Make sure
that every detail is in order.

3 Be patient.

Every good programming effort takes a long time to get right. If you don't
understand something right away, be persistent. Stick with it (or put it away
for a while and come back to it). There's nothing you can't understand if you
put in enough time.

3 Don't become frustrated.

Don't throw your pie crust. Frustration (not lack of knowledge) is your enemy.
If you're frustrated, you can't accomplish anything.
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3 Don't think you're the only person who's slow to understand.
I'm slow, and I'm proud of it. (Katie, Chapter 6 will be a week late.)
3 Don't be timid.

If your code isn't working and you can't figure out why it's not working, ask
someone. Post a message in an online forum. And don't be afraid of anyone’s
snide or sarcastic answer. (For a list of gestures you can make in response to
peoples’ snotty answers, see Appendix Z.)

To ask me directly, send me an email message, tweet me, or post to me on
Facebook. (Send email to BeginProg@allmycode.com, tweets to @allmycode,
or posts to Facebook at /allmycode.)

Diagnosing a problem

The “Typing and running a program” section, earlier in this chapter, tells you
how to run the EcholLine program. If all goes well, your screen ends up looking
like the one shown in Figure 5-1. But things don’t always go well. Sometimes your
finger slips, inserting a typo into your program. Sometimes you ignore one of the
details in Listing 5-1, and you get a nasty error message.

Of course, some things in Listing 5-1 are okay to change. Not every word in
Listing 5-1 is cast in stone. Here’s a nasty wrinkle: I can’t tell you that you must
always retype Listing 5-1 exactly as it appears. Some changes are okay; others are
not. Keep reading for some “f’rinstances.”

Case sensitivity

Java is case-sensitive. Among other things, case-sensitive means that, in a Java
program, the letter P isn’t the same as the letter p. If you send me some fan mail
and start with “Dear barry” instead of “Dear Barry,” I still know what you mean.
But Java doesn’t work that way.

Change just one character in a Java program and, instead of an uneventful compi-
lation, you get a big headache! Change p to P like so:

//The following line is incorrect:

System.out.Println(keyboard.nextLine());

When you type the program in Eclipse’s editor, you get the ugliness shown in
Figure 5-6.
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FIGURE 5-6:

The Java compiler
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notPrintln.
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When you see error markers like the ones in Figure 5-6, your best bet is to stay
calm and read the messages carefully. Sometimes the messages contain useful
hints. (Of course, sometimes they don’t.) The message in Figure 5-6 is The method
Println(String) is undefined for the type PrintStream. In plain English,
this means “The Java compiler can’t interpret the word Print1ln.” (The message
stops short of saying, “Don’t type the word Print1ln, you Dummy!” In any case, if
the computer says you’re one of us Dummies, you should take it as a compliment.)
Now, there are plenty of reasons why the compiler may not be able to understand
a word like Println. But, for a beginning programmer, you should check two
important things right away:

3 Have you spelled the word correctly?

Did you accidentally type print1n with the digit 1, instead of print1ln with
the lowercase letter 1?

3 Have you capitalized all letters correctly?

Did you incorrectly type Println or PrintLn instead of print1n?

Either of these errors can send the Java compiler into a tailspin. So compare your
typing with the approved typing word for word (and letter for letter). When you
find a discrepancy, go back to the editor and fix the problem. Then try compiling
the program again.

As you type a program in Eclipse’s editor, Eclipse tries to compile the program.
When Eclipse finds a compile-time error, the editor usually displays at least three
red error markers. (Refer to Figure 5-6.) The marker in the editor’s left margin
has an X-like marking and sometimes a tiny light bulb. The marker in the right
margin is a small square. The marker in the middle is a jagged red underline.

If you hover the mouse cursor over any of these markers, Eclipse displays a
message that attempts to describe the nature of the error. If you hover over the
jagged line, Eclipse displays a message and possibly a list of suggested solutions.
(Each suggested solution is called a quick fix.) If you right-click the left margin’s
marker (or control-click on a Mac) and choose Quick Fix in the resulting context
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FIGURE 5-7:
A helpful error
message.

menu, Eclipse displays the suggested solutions. To have Eclipse modify your code
automatically (using a suggestion from the quick-fix list), either single-click or
double-click the item in the quick-fix list. (That is, single-click anything that
looks like a link; double-click anything that doesn’t look like a link.)

Not enough punctuation
In English and in Java, using the; proper! punctuation is important)

Take, for example, the semicolons in Listing 5-1. What happens if you forget to
type a semicolon?

//The following code is incorrect:
System.out.println(keyboard.nextlLine())
keyboard.close();

If you leave off the semicolon, you see the message shown in Figure 5-7.

system. out. println(keyboard. nextline( )]

[yntax error, insert ™" to complete Staterment

1
i

13
14

A message like the one in Figure 5-7 makes your life much simpler. I don’t have
to explain the message, and you don’t have to puzzle over the message’s meaning.
Just take the message insert ";" to complete Statement at its face value.
Insert the semicolon between the end of the System.out.printin(keyboard.
nextlLine()) statement and whatever code comes after the statement. (For code
that’s easier to read and understand, tack on the semicolon at the end of the
System.out.println(keyboard.nextLine()) statement.)

Too much punctuation

In junior high school, my English teacher said I should use a comma whenever I
would normally pause for a breath. This advice doesn’t work well during allergy
season, when my sentences have more commas in them than words. Even as a
paid author, I have trouble deciding where the commas should go, so I often add
extra commas for good measure. This makes more work for my copy editor, Becky,
who has a trash can full of commas by the desk in her office.
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WHY CAN'T THE COMPUTER FIX IT?

How often do you get to finish someone else’s sentence? “Please,” says your supervisor,
“go over there and connect the...”

“Wires,"” you say. “I'll connect the wires.” If you know what someone means to say, why
wait for her to say it?

This same question comes up in connection with computer error messages. Take a look
at the message in Figure 5-7. The computer expects a semicolon after the statement on
line 8. Well, Mr. Computer, if you know where you want a semicolon, just add the semi-
colon and be done with it. Why are you bothering me about it?

The answer is simple. The computer isn't interested in taking any chances. What if you
don't really want a semicolon after the statement on line 8? What if the missing semico-
lon represents a more profound problem? If the computer added the extra semicolon,
it could potentially do more harm than good.

Returning to you and your supervisor. . . .

Boom! A big explosion. “Not the wires, you Dummy. The dots. | wanted you to connect
the dots.”

“Sorry,” you say.

It’s the same way in a Java program. You can get carried away with punctuation.
Consider, for example, the main method header in Listing 5-1. This line is a dan-
gerous curve for novice programmers.

For information on the terms method header and method body, refer to Chapter 4.
Normally, you shouldn’t end a method header with a semicolon. But people add
semicolons anyway. (Maybe, in some subtle way, a method header looks like it

should end with a semicolon.)

//The following line is incorrect:

public static void main(String args[]); {

If you add this extraneous semicolon to the code in Listing 5-1, you get the mes-
sage shown in Figure 5-8.
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FIGURE 5-8:

An unwanted
semicolon
messes things up.

FIGURE 5-9:
What's on this
computer's mind?

I Echoline.java 53 =]

1 import java.util.Scanner;

3 class Echoline {
& j public static void pain(String aras[1); { =
& Scanner keyboard = new ScaR 1S Cinod requires a body instead of a semicolon
:\ System.out.println{keyboar 2 quick fixes available:
! & Add body
w keyboard. close(); @ Change 'Echoline.main’ to ‘abstract

13 Press F2' for focus

The error message and quick fixes in Figure 5-8 are a bit misleading. The message
starts with This method requires a body. But the method has a body. Doesn’t it?

When the computer tries to compilepublic static void main(String args[]);
(ending with a semicolon), the computer gets confused. I illustrate the confusion
in Figure 5-9. Your eye sees an extra semicolon, but the computer’s eye interprets
this as a method without a body. So that’s the error message — the computer says
This method requires a body instead of a semicolon.

A semicolon means that this is the end
of the method. Since the end comes
before a body, this method must not

have a body.

®

class Echoline |

-—
—

public static void main(String args([]); {
Scanner keyboard = new Scanner(System.in);

System.out.printlntkeyboard .nextline());

kevboard.close();

This Scanner and println stuff can't
be part of the method body, because
the body ended with the header.
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If you select the Add Body quick fix, Eclipse creates the following (really horrible)
code:

import java.util.Scanner;
class EcholLine {

public static void main(String args[]) {

o
Scanner keyboard = new Scanner(System.in);
System.out.println(keyboard.nextLine());

keyboard.close();

This “fixed” code has no compile-time errors. But when you run this code, noth-
ing happens. The program starts running and then stops running with nothing in
Eclipse’s Console view.

We all know that a computer is a very patient, very sympathetic machine. That’s
why the computer looks at your code and decides to give you one more chance. The
computer remembers that Java has an advanced feature in which you write a
method header without writing a method body. When you do this, you get what’s
called an abstract method — something that I don’t use in this book. Anyway, in
Figure 5-9, the computer sees a header with no body. So the computer says to
itself, “I know! Maybe the programmer is trying to write an abstract method. The
trouble is, an abstract method’s header has to have the word abstract in it. I
should remind the programmer about that.” So the computer offers the Change
'EchoLine.main' to 'abstract' quick fix in Figure 5-9.

One way or another, you can’t interpret the error message and the quick fixes in
Figure 5-9 without reading between the lines. So here are some tips to help you
decipher murky messages:

3 Avoid the knee-jerk response.

Some people see theChange 'EcholLine.main' to 'abstract' quick fixin
Figure 5-9 and wonder how to change EchoLine.main so that it's abstract.
Unfortunately, this isn't the right approach. If you don't know what abstract
means, chances are that you didn't mean to make EcholLine.main be
abstract in the first place.

3 Stare at the bad line of code for a long, long time.

If you look carefully atthepublic static ... linein Figure 5-9, eventu-
ally you'll notice that it's different from the corresponding line in Listing 5-1.
The line in Listing 5-1 has no semicolon, but the line in Figure 5-9 has one.
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Of course, you won't always start with some prewritten code like the stuff in
Listing 5-1. That's where practice makes perfect. The more code you write, the
more sensitive your eyes will become to things like extraneous semicolons
and other programming goofs.

Too many curly braces

You’re looking for the nearest gas station, so you ask one of the locals. “Go to the
first traffic light and make a left,” says the local. You go straight for a few streets and
see a blinking yellow signal. You turn left at the signal and travel for a mile or so.
What? No gas station? Maybe you mistook the blinking signal for a real traffic light.

You come to a fork in the road and say to yourself, “The directions said nothing
about a fork. Which way should I go?” You veer right, but a minute later you’re
forced onto a highway. You see a sign that says, Next Exit 24 Miles. Now you’re
really lost, and the gas gauge points to S. (The S stands for Stranded.)

Here’s what happened: You made an honest mistake. You shouldn’t have turned
left at the yellow blinking light. That mistake alone wasn’t so terrible. But that
first mistake led to more confusion, and eventually, your choices made no sense
at all. If you hadn’t turned at the blinking light, you’d never have encountered
that stinking fork in the road. Then getting on the highway was sheer
catastrophe.

Is there a point to this story? Of course there is. A computer can get itself into the
same sort of mess. The computer notices an error in your program. Then, meta-
phorically speaking, the computer takes a fork in the road — a fork based on the

original error — a fork for which none of the alternatives leads to good results.

Here’s an example. You’re retyping the code in Listing 5-1, and you mistakenly
type an extra curly brace:

//The following code is incorrect:

import java.util.Scanner;
class EcholLine {
public static void main(String args[]) {

Scanner keyboard = new Scanner(System.in);

System.out.println(keyboard.nextlLine());

keyboard.close();
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FIGURE 5-10:
Three error
messages.

REMEMBER

In Eclipse’s editor, you hover over the leftmost marker. You see the messages
shown in Figure 5-10.

E_] Echoline.java 23
1 import java.util.Scanner;
3 class Echoline {
public static void main(String args[]) {
Scanner keyboard = new Scanner(System.in);

}

(X 3] System.out,println(keyboard. nextline());

1
€311 Multiple markers at this line

¥ - Syntax error, insert "SimpleName” to complete QualifiedMame
13 | - Syntax error, insert "}* to complete MethodDeclaration

1 " - Syntax error, insert "ldentifier (" to complete MethodHeaderName

Eclipse is confused because some of the program’s code is completely out of place.
Eclipse displays three messages — something about a SimpleName, something
about the parenthesis, and something concerning the MethodHeaderName. None of
these messages addresses the cause of the problem. Eclipse is trying to make the
best of a bad situation, but at this point, you shouldn’t believe a word that Eclipse
says.

Computers aren’t smart animals, and if someone programs Eclipse to say insert
"SimpleName" to complete QualifiedName, that’s exactly what Eclipse says.
(Some people say that computers make them feel stupid. For me, it’s the opposite.
A computer reminds me how dumb a machine can be and how smart a person can
be. I like that.)

When you see a bunch of error messages, read each error message carefully. Ask
yourself what you can learn from each message. But don’t take each message as
the authoritative truth. When you’ve exhausted your efforts with Eclipse’s mes-
sages, return to your efforts to stare carefully at the code.

If you get more than one error message, always look carefully at each message in
the bunch. Sometimes a helpful message hides among a bunch of not-so-helpful
messages.

Misspelling words (and other missteps)

You’ve found an old family recipe for deviled eggs (one of my favorites). You fol-
low every step as carefully as you can, but you leave out the salt because of your
grandmother’s high blood pressure. You hand your grandmother an egg (a fin-
ished masterpiece). “Not enough pepper,” she says, and she walks away.
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The next course is beef bourguignon. You take an unsalted slice to dear old Granny.
“Not sweet enough,” she groans, and she leaves the room. “But that’s impossi-
ble,” you think. “There’s no sugar in beef bourguignon. I left out the salt.” Even
so, you go back to the kitchen and prepare mashed potatoes. You use unsalted
butter, of course. “She’ll love it this time,” you think.

“Sour potatoes! Yuck!” Granny says, as she goes to the sink to spit it all out.
Because you have a strong ego, you’re not insulted by your grandmother’s behav-
ior. But you’re somewhat confused. Why is she saying such different things about
three unsalted recipes? Maybe there are some subtle differences that you don’t
know about.

Well, the same kind of thing happens when you’re writing computer programs.
You can make the same kind of mistake twice (or at least, make what you think is
the same kind of mistake twice) and get different error messages each time.

For example, if you change the spelling or capitalization of println in Listing 5-1,
Eclipse tells you the method is undefined for the type PrintStream. But if you
change System to system, Eclipse says that system cannot be resolved. And with
System misspelled, Eclipse doesn’t notice whether print1n is spelled correctly.

In Listing 5-1, if you change the spelling of args, nothing goes wrong. The pro-
gram compiles and runs correctly. But if you change the spelling of main, you face
some unusual difficulties. (If you don’t believe me, read the “Runtime error mes-
sages” section, a little later in this chapter.)

Still in Listing 5-1, change the number of equal signs in the Scanner keyboard =
new Scanner(System.in) line. With one equal sign, everybody’s happy. If you
accidentally type two equal signs (Scanner keyboard == new Scanner(System.
in)), Eclipse steers you back on course, telling you Syntax error on token
"==", = expected. (See Figure 5-11.) But if you go crazy and type four equal signs
or if you type no equal signs, Eclipse misinterprets everything and suggests that
you insert ";" to complete BlockStatements. Unfortunately, inserting a
semicolon is no help at all. (See Figure 5-12.)

Java responds to errors in many different ways. Two changes in your code might
look alike, but similar changes don’t always lead to similar results. Each problem
in your code requires its own individualized attention.

Here’s a useful exercise: Start with a working Java program. After successfully
running the code, make a change that intentionally introduces errors. Look care-
fully at each error message and ask yourself whether the message would help you
diagnose the problem. This exercise is useful because it helps you think of errors
as normal occurrences and gives you practice in analyzing messages when you’re
not under pressure to get your program to run correctly.
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FIGURE 5-11:
Remove the
second of two
equal signs.

FIGURE 5-12:
You're missing an
equal sign, but
Eclipse fails to
notice.

EchoLine java &8
1 dmport java.util.scanner;

class Echoline {

public static void main{String args[]) {
Scanner keyboard =s| new Scanner(System.in);

System. out. println 3 Syntax error on token "==", = expected
Press 'F2 for focus
keyboard.close();
12}
[1] *EchoLine java 52
1 dmport jawa.util.Scanner;
2
5 class Echoline {
4
& S public static void main(String args[]) {
[ N] Scanner kevboard| new Scanner(System.in);

System_% @ Syntax errar, insert ", to complete BlockStatements

Press 'F2' for focus]

keyboard. close( ) ;

1z}
13

Runtime error messages

Up to this point in the chapter, I describe errors that crop up when you compile a
program. Another category of errors hides until you run the program. A case in
point is the improper spelling or capitalization of the word main.

Assume that, in a moment of wild abandon, you incorrectly spell main with a
capital M:

//The following line is incorrect:

public static void Main(String args[]) {

When you type the code, everything is hunky-dory. You don’t see any error
markers.

But then you try to run your program. At this point, the bits hit the fan. The catas-
trophe is illustrated in Figure 5-13.

Sure, your program has something named Main, but does it have anything named
main? (Yes, I've heard of a famous poet named e. e. cummings, but who the heck
is E. E. Cummings?) The computer doesn’t presume that your word Main means
the same thing as the expected word main. You need to change Main back to main.
Then everything will be okay.

But in the meantime (or in the “maintime”), how does this improper capitaliza-
tion make it past the compiler? Why don’t you get error messages when you com-
pile the program? And if a capital M doesn’t upset the compiler, why does this
capital M mess everything up at runtime?
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FIGURE 5-13:
Whadaya mean
“Selection does

not contain a

main type”?

TIP

[3) Echolinejava 2
1 import java.util.Scanner;
) class EchoLine {
public static void Nain(string args(]) {
Scanner keyboard = new scanner(System.in);
System. out. println(keyboard. nexctLine());

keyboard. clese();
11 &
the Launch Error [ x|

Q‘ Selection does not contain a main type

0K

The answer goes back to the different kinds of words in the Java programming
language. As I say in Chapter 4, Java has identifiers and keywords.

The keywords in Java are cast in stone. If you change class toClass or public to
Public, you get something new — something that the computer probably can’t
understand. That’s why the compiler chokes on improper keyword capitalizations.
It’s the compiler’s job to make sure that all the keywords are used properly.

On the other hand, the identifiers can bounce all over the place. Sure, there’s an
identifier named main, but you can make up a new identifier named Main. (You
shouldn’t do it, though. It’s too confusing to people who know Java’s usual mean-
ing for the word main.) When the compiler sees a mistyped line, like public
static void Main, the compiler just assumes that you’re making up a brand-new
name. So the compiler lets the line pass. You get no complaints from your old
friend, the compiler.

But then, when you try to run the code, the computer goes ballistic. The Java Vir-
tual Machine (JVM) runs your code. (For details, see Chapter 1.) The JVM needs to
find a place to start executing statements in your code, so the JVM looks for a
starting point named main, with a small m. If the JVM doesn’t see anything named
main, the JVM gets upset. “Main method not found in class EchoLine,” says the
JVM. So at runtime, the JVM, and not the compiler, gives you an error message.

A better error message would be main method not found in class Echoline,

with a lowercase letter m in main. Here and there, the people who create the error
messages overlook a detail or two.

What problem? | don’t see a problem

I end this chapter on an upbeat note by showing you some of the things you can
change in Listing 5-1 without rocking the boat.
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The identifiers that you create

If you create an identifier, that name is up for grabs. For example, in Listing 5-1,
you can change EchoL ine to RepeatAfterMe:

class RepeatAfterMe {
public static void main ... etc.

This presents no problem at all, as long as you’re willing to be consistent. Just
follow most of the steps in this chapter’s earlier section “Typing and running a
program.”

¥ In Step 6, instead of typing EchoLine, type RepeatAfterMe in the New Java
Class dialog box’'s Name field.

¥ In Step 8, when you copy the code from Listing 5-1, don't type

class EcholLine {

near the top of the listing. Instead, type the words

class RepeatAfterMe {

Rather than start your program with only the word class, you can start your pro-
gram with the words public class. If you do, changing the word EcholLine to
RepeatAfterMe might get you into a bit of trouble. For you, the novice program-
mer, the easiest solution is to remove the word public.

Spaces and indentation

Java isn’t fussy about the use of spaces and indentation. All you need to do is keep
your program well-organized and readable. Here’s an alternative to spacing and
indentation of the code in Listing 5-1:

import java.util.Scanner;
class EcholLine
{
public static void main( String args[] )
{
Scanner keyboard =
new Scanner( System.in );
System.out.println
( keyboard.nextLine() )
keyboard.close();
}
}
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How you choose to do things

A program is like a fingerprint. No two programs look much alike. Say that I dis-
cuss a programming problem with a colleague. Then we go our separate ways and
write our own programs to solve the same problem. Sure, we’re duplicating the
effort. But will we create the exact same code? Absolutely not. Everyone has his or
her own style, and everyone’s style is unique.

I asked fellow Java programmer David Herst to write his own EchoLine program
without showing him my code from Listing 5-1. Here’s what he wrote:

import java.io.BufferedReader;
import java.io.InputStreamReader;

import java.io.IOException;

public class EcholLine {
public static void main(String[] args) throws IOException {
InputStreamReader isr = new InputStreamReader(System.in);
BufferedReader br = new BufferedReader(isr);
String input = br.readlLine();
System.out.println(input);

Don’t worry about BufferedReader, InputStreamReader, or things like that. Just
notice that, like snowflakes, no two programs are written exactly alike, even if
they accomplish the same task. That’s nice. It means that your code, however dif-
ferent, can be as good as the next person’s. That’s encouraging.

COMPILE-TIME ERRORS

The MCV vaccine helps you build an immunity to measles by giving you a mild
case of measles. In the same way, you can enhance your immunity against pro-
gramming errors by making mistakes intentionally in small, throwaway Java
programs.

No matter how many years you spend writing code, you’ll always have some
programming errors in any new code you write. Even the most experienced
professional programmers make mistakes. But by practicing with some simple
errors, you can discover some errors that beginners make most often, and become
accustomed to the “code, test, fix, code again” cycle.
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Try these ways of introducing errors in Listing 5-1:

¥ Inthe word println, change the lowercase letter 1 to a digit 1.

¥ Move the entire System.out.println line so that it's above the public
static void main line.

¥ Delete the parentheses around ("Chocolate, royalties, sleep").
¥ Delete the quotation marks around "Chocolate, royalties, sleep".

¥ Break the quoted text between lines as follows:

System.out.println("Chocolate,
royalties,

sleep");

¥ Open your favorite word processing program (Microsoft Word, Apple Pages, or
whatever) and create a document containing only the text “Chocolate, royalties,
sleep”. Most likely, your word processor will automatically use curly quotation
marks (*") instead of straight quotation marks ("), and curly quotation marks
aren't good for a Java program. So copy this curly-quoted text from your word
processor. In Eclipse’s editor, paste the curly-quoted text into Listing 3-1 (over in
Chapter 3). Replace the original "Chocolate, royalties, sleep" textin that
listing, straight quotation marks and all. See the kind of error messages that
Eclipse displays.

n

ALLOWABLE CHANGES IN SPACING AND INDENTATION

You can’t break a quoted string (such as "Chocolate, royalties, sleep") into
two or three lines. But in other parts of a Java program, line breaks don’t matter.
Experiment by changing the spacing and indentation in Listing 5-1. Try running
this code:

import java.util.Scanner;

class ThingsILike

{
public static void main (String[] args)
{
Scanner keyboard = new Scanner (System.in);
System.out.println ("Chocolate, royalties, sleep");
keyboard.close ();
}
}
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» Declaring variables

» Assigning values to variables
» Working with numbers

» Using Java types

Chapter 6

Using the Building Blocks:
Variables, Values, and
Types

ack in 1946, John von Neumann wrote a groundbreaking paper about the

newly emerging technology of computers and computing. Among other

things, he established one fundamental fact: For all their complexity, the
main business of computers is to move data from one place to another. Take a
number — the balance in a person’s bank account. Move this number from the
computer’s memory to the computer’s processing unit. Add a few dollars to the
balance and then move it back to the computer’s memory. The movement of
data . .. that’s all there is; there ain’t no more.

Good enough! This chapter shows you how to move your data around.
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Using Variables

Here’s an excerpt from a software company’s website:

SnitSoft recognizes its obligation to the information technology community. For
that reason, SnitSoft is making its most popular applications available for a nominal
charge. For just $5.95 plus shipping and handling, you receive a flash drive
containing SnitSoft's premier products.

Go ahead. Click the Order Now! link. Just see what happens. You get an order form
with two items on it. One item is labeled $5.95 (Flash drive), and the other
item reads $25.00 (Shipping and handling). What a rip-off! Thanks to Snit-
Soft’s generosity, you can pay $30.95 for ten cents’ worth of software.

Behind the scenes of the SnitSoft web page, a computer program does some
scoundrel’s arithmetic. The program looks something like the code in
Listing 6-1.

m SnitSoft's Grand Scam

FIGURE 6-1:
Running the code
from Listing 6-1.

class SnitSoft {

public static void main(String args[]) {
double amount;

amount = 5.95;
amount = amount + 25.00;

System.out.print("We will bill $");
System.out.print(amount);
System.out.println(" to your credit card.");

When I run the Listing 6-1 code on my own computer (not on the SnitSoft
computer), I get the output shown in Figure 6-1.

We will bill $3@.95 to your credit card.
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Using a variable

The code in Listing 6-1 makes use of a variable named amount. A variable is a
placeholder. You can stick a number like 5.95 into a variable. After you’ve placed a
number in the variable, you can change your mind and put a different number,
like 30.95, into the variable. (That’s what varies in a variable.) Of course, when
you put a new number in a variable, the old number is no longer there. If you
didn’t save the old number somewhere else, the old number is gone.

Figure 6-2 gives a before-and-after picture of the code in Listing 6-1. When the
computer executes amount = 5.95, the variable amount has the number 5.95 in it.
Then, after the amount = amount + 25.00 statement is executed, the variable
amount suddenly has 30.95 in it. When you think about a variable, picture a place in
the computer’s memory where wires and transistors store 5.95, 30.95, or whatever.
In Figure 6-2, imagine that each box is surrounded by millions of other such boxes.

— amount = 5.95; amount = 5.95;
amount = amount + 25.007 — amount = amount + 25.00;
amount amount
5.95 -
3085
FIGURE 6-2: Before executing After executing
A variable (before amount = amount + 25.00; amount = amount + 25.00;
and after).

Now you need some terminology. (You can follow along in Figure 6-3.) The thing
stored in a variable is called a value. A variable’s value can change during the run
of a program (when SnitSoft adds the shipping and handling cost, for example).
The value stored in a variable isn’t necessarily a number. (You can, for example,
create a variable that always stores a letter.) The kind of value stored in a variable
is a variable’s type. (You can read more about types in the rest of this chapter and
in the next two chapters.)

There’s a subtle, almost unnoticeable difference between a variable and a vari-

e able’s name. Even in formal writing, I often use the word variable when I mean

\J variable name. Strictly speaking, amount is the variable name, and all the memory

TecunicaL  storage associated with amount (including the value and type of amount) is the

STUFF variable itself. If you think this distinction between variable and variable name is
too subtle for you to worry about, join the club.
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FIGURE 6-3:

A variable, its
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value, and its
type.
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REMEMBER

type double <:££EEEEEE:EEEEEEz>

Houb]e”amount%

amount = 5.95;
[
amount
5.95

Every variable name is an identifier — a name that you can make up in your own
code (for more about this topic, see Chapter 4). In preparing Listing 6-1, I made
up the name amount.

Understanding assighment statements

The statements with equal signs in Listing 6-1 are called assignment statements.
In an assignment statement, you assign a value to something. In many cases, this
something is a variable.

You should get into the habit of reading assignment statements from right to left.
For example, the first assignment statement in Listing 6-1 says, “Assign 5.95 to
the amount variable.” The second assignment statement is just a bit more compli-
cated. Reading the second assignment statement from right to left, you get “Add
25.00 to the value that’s already in the amount variable, and make that number
(30.95) be the new value of the amount variable.” For a graphic, hit-you-
over-the-head illustration of this, see Figure 6-4.

In an assignment statement, the thing being assigned a value is always on the left
side of the equal sign.

To wrap or not to wrap?

The last three statements in Listing 6-1 use a neat trick. You want the program to
display just one line on the screen, but this line contains three different things:

¥ Theline starts withwWe will bill $.
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¥ The line continues with the amount variable's value.

¥ Theline ends with to your credit card.

amount = 5.95

"Assign 5.95 to j
L» amount.”

amount = amount + 25.00;
FIGURE 6-4: "Add 5.95 (that is, amount's old value) and  25.00 j
Reading an _
assignment < ...and assign the sum to....
statement from amount.”
right to left.

FORGET WHAT YOU'VE SEEN

In Listing 6-1, and in other examples throughout this book, | do something that experi-
enced programmers avoid doing. | put actual numbers, such as5.95 and 25.00 in my
Java code. This is called hard-coding the values. | hard-coded values to keep these intro-
ductory programming examples as simple as possible.

But in most real-life applications, hard-coding is bad. Imagine a day when SnitSoft raises
its shipping and handling fee from $25.00 to $35.00. Then the program in Listing 6-1 no
longer works correctly. Someone has to launch Eclipse, look over the code, change the
code, test the new code, and distribute the new code to the people who run it. What a
pain! For the ten-line program in Listing 6-1, this process takes minutes. For a 10,000-
line program in a real-life setting, this process might take days, weeks or months.

Instead of hard-coding values, you should type values on the keyboard during the run
of the program. If that's not practical, your program can read values from a computer’s
hard disk. (Chapter 13 has the scoop on reading from disk files.) One way or another,
you should design your program to work with all values, not only with specific values
such as5.95 and 25.00.

Keep reading this book's examples. When you see my hard-coded values, remember that
| use hard-coded values to keep you from being distracted by input and output problems.
| keep you focused on whatever new ideas each example has to offer. | don't do hard-
coding to convince you that hard-coding is good programming practice. In fact, it's not.
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by System.
.print and
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println.

REMEMBER

These are three separate things, so you put these things in three separate
statements. The first two statements are calls to System.out.print. The last
statement is a call to System.out.printin.

Calls to System.out .print display text on part of a line and then leave the cursor
at the end of the current line. After executing System.out.print, the cursor is
still at the end of the same line, so the next System.out.whatever can continue
printing on that same line. With several calls to print capped off by a single call
to println, the result is just one nice-looking line of output, as Figure 6-5
illustrates.

int orint
We will bill § -0 30. 95220 to your credit card.—

println

A call to System.out . print writes some things and leaves the cursor sitting at the
end of the line of output. A call to System.out.println writes things and then
finishes the job by moving the cursor to the start of a brand-new line of output.

What Do All Those Zeros and Ones Mean?

134

Here’s a word:

gift
The question for discussion is, what does that word mean? Well, it depends on
who looks at the word. For example, an English-speaking reader would say that
gift stands for something one person bestows upon another in a box covered in
bright paper and ribbons:

Look! I'm giving you a gift!
But in German, the word gift means “poison:”

Let me give you some gift, my dear.

And in Swedish, gift can mean either “married” or “poison:”

As soon as they got gift, she slipped a gift into his drink.
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FIGURE 6-6:

An extreme
close-up of eight
black-and-white
screen pixels.

Then there’s French. In France, there’s a candy bar named “Gift”:
He came for the holidays, and all he gave me was a bar of Gift.

What do the letters g-i-f-t really mean? Well, they don’t mean anything until you
decide on a way to interpret them. The same is true of the zeros and ones inside a
computer’s circuitry.

Take, for example, the sequence 01001010. This sequence can stand for the letter J,
but it can also stand for the number 74. That same sequence of zeros and ones can
stand for 1.0369608636003646x10-43. And when interpreted as screen pixels, the
same sequence can represent the dots shown in Figure 6-6. The meaning of
01001010 depends entirely on the way the software interprets this sequence.

Types and declarations

How do you tell the computer what 01001010 stands for? The answer is in
the concept called type. The type of a variable describes the kinds of values that the
variable is permitted to store.

In Listing 6-1, look at the first line in the body of the main method:

double amount;
This line is called a variable declaration. Putting this line in your program is like
saying, “I’m declaring my intention to have a variable named amount in my pro-
gram.” This line reserves the name amount for your use in the program.
In this variable declaration, the word double is a Java keyword. This word double

tells the computer what kinds of values you intend to store in amount. In particu-
lar, the word double stands for numbers between —1.8x103°8 and 1.8x103°8, That’s
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an enormous range of numbers. Without the fancy x10 notation, the second of
these numbers is

18000000020V AVVVVYVIVVYVYVVVIVVYVAD
0000002VVAVVAVVAVVAVVVYVAVVVVVVAVVYVVVVVIVVVAD
0000002VVAVVAVVAVVAVVVYVAVVVVYVAVVYVYVVVVVVAD
0000002V AVVVVVYVVVIYVYVIVVIVVVAD
0000002V AVVAVVAVVVYVAVVVVVVVVIYVVVVVIVVVAD
0000002V AVVAVVAVVAVYVAVAAQ . O

If the folks at SnitSoft ever charge that much for shipping and handling, they can
represent the charge with a variable of type double.

What's the point?

More important than the humongous range of the double keyword’s numbers is
the fact that a double value can have digits to the right of the decimal point. After
you declare amount to be of type double, you can store all sorts of numbers in
amount. You can store 5.95, 0.02398479, or —3.0. In Listing 6-1, if l hadn’t declared
amount to be of type double, I wouldn’t have been able to store 5.95. Instead, I
would have had to store plain old 5 or dreary old 6, without any digits beyond the
decimal point.

For more info on numbers without decimal points, see Chapter 7.

This paragraph deals with a really picky point, so skip it if you’re not in the mood.
People often use the phrase decimal number to describe a number with digits to the
right of the decimal point. The problem is, the syllable “dec” stands for the num-
ber 10, so the word decimal implies a base-10 representation. Because computers
store base-2 (not base-10) representations, the word decimal to describe such a
number is a misnomer. But in this book, I just can’t help myself. I’m calling them
decimal numbers, whether the techies like it or not.

Here are some things for you to try:

NUMBER CRUNCHING

Change the number values in Listing 6-1, and run the program with the new
numbers.

VARYING A VARIABLE

In Listing 6-1, change the variable name amount to another name. Change the
name consistently throughout the Listing 6-1 code. Then run the program with its
new variable name.
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USING UNDERSCORES

Modify the code in Listing 6-1 so that shipping and handling costs 1 million dol-
lars. Use1_000_000 .00 (with underscores) to represent the million-dollar amount.

MORE INFORMATION, PLEASE

Modify the code in Listing 6-1 so that it displays three values: the original price of
the flash drive, the cost of shipping and handling, and the combined cost.

Reading Decimal Numbers
from the Keyboard

I don’t believe it! SnitSoft is having a sale! For one week only, you can get the
SnitSoft flash drive for the low price of just §5.75! Better hurry up and order one.

No, wait! Listing 6-1 has the price fixed at $5.95. I have to revise the program.

I know. I’ll make the code more versatile. I’ll input the amount from the keyboard.
Listing 6-2 has the revised code, and Figure 6-7 shows a run of the new code.

m Getting a Double Value from the Keyboard

import java.util.Scanner;

class VersatileSnitSoft {

public static void main(String args[]) {
Scanner keyboard = new Scanner(System.in);
double amount;

System.out.print("What's the price of a flash drive? ");
amount = keyboard.nextDouble();
amount = amount + 25.00;

System.out.print("we will bill $");
System.out.print(amount);

System.out.println(" to your credit card.");

keyboard.close();
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FIGURE 6-7:

Getting the value
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of a double
variable.

WARNING

What's the price of a flash drive? 5.75
We will bill $30.75 to your credit card.

Grouping separators vary from one country to another. The run shown in
Figure 6-7 is for a computer configured in the United States where 5.75 means
“five and seventy-five hundredths.” But the run might look different on a computer
that’s configured in what I call a “comma country” — a country where 5,75 means
“five and seventy-five hundredths.” If you live in a comma country and you type
5.75 exactly as it’s shown in Figure 6-7, you probably get an error message (an
InputMismatchException). If so, change the number amounts in your file to
match your country’s number format. When you do, you should be okay.

Though these be methods, yet
there is madness in 't

Notice the call to the nextDouble method in Listing 6-2. Over in Listing 5-1, in
Chapter 5, I use nextLine; but here in Listing 6-2, I use nextDouble.

In Java, each type of input requires its own, special method. If you’re getting a line
of text, then nextLine works just fine. But if you’re reading stuff from the key-
board and you want that stuff to be interpreted as a number, you need a method
like nextDouble.

To go from Listing 6-1 to Listing 6-2, I added an import declaration and some
stuff about new Scanner(System.in).You can find out more about these things by
reading the “Getting numbers, words, and other things” section in Chapter 5. (You
can find out even more about input and output by visiting Chapter 13.) And more
examples (more keyboard. nextSomething methods) are in Chapters 7 and 8.

Methods and assignments

Note how I usekeyboard.nextDouble in Listing 6-2. The call to method keyboard.
nextDouble is part of an assignment statement. If you look in Chapter 5 at the
section on how the EcholLine program works, you see that the computer can
substitute something in place of a method call. The computer does this in
Listing 6-2. When you type 5.75 on the keyboard, the computer turns

amount = keyboard.nextDouble();
into

amount = 5.75;
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WHO DOES WHAT, AND HOW?

When you write a program, you're called a programmer, but when you run a program,
you're called a user. So when you test your own code, you're being both the program-
mer and the user.

Suppose that your program contains a keyboard. nextSomething() call, like the calls
in Listings 5-1 (in Chapter 5) and 6-2. Then your program gets input from the user. But,
when the program runs, how does the user know to type something on the keyboard? If
the user and the programmer are the same person, and the program is fairly simple,
knowing what to type is no big deal. For example, when you start running the code in
Listing 5-1, you have this book in front of you, and the book says “The computer is wait-
ing for you to type something. . .. You type one line of text. . . ." So you type the text and
press Enter. Everything is fine.

But very few programs come with their own books. In many instances, when a program
starts running, the user has to stare at the screen to figure out what to do next. The
code in Listing 6-2 works in this stare-at-the-screen scenario. In Listing 6-2, the first call
toprint puts an informative message What's the price of a flash drive?)on
the user’s screen. A message of this kind is called a prompt.

When you start writing programs, you can easily confuse the roles of the prompt and the
user's input. Remember: No preordained relationship exists between a prompt and the
subsequent input. To create a prompt, you call print or println. Then, to read the user's
input, you call nextLine, nextDouble, or one of the Scanner class's other next Something
methods. These print and next calls belong in two separate statements. Java has no
commonly used, single statement that does both the prompting and the “next-ing.”

As the programmer, your job is to combine the prompting and the next-ing. You can
combine prompting and next-ing in all kinds of ways. Some ways are helpful to the user,
and some ways aren't, as described in this list:

® If you don’t have a call to print or println, the user sees no prompt. A blink-
ing cursor sits quietly and waits for the user to type something. The user has to
guess what kind of input to type. Occasionally that's okay, but usually it isn't.

® Ifyou call print or println but you don't call a keyboard . nextSomething
method, the computer doesn’t wait for the user to type anything. The program
races to execute whatever statement comes immediately after the print orprintln.

® If your prompt displays a misleading message, you misled the user. Java has
no built-in feature that checks the appropriateness of a prompt. That's not surpris-
ing. Most computer languages have no prompt-checking feature.

Be careful with your prompts. Be nice to your user. Remember that you were once a
humble computer user, too.
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(The computer doesn’t really rewrite the code in Listing 6-2. This amount = 5.75
line simply illustrates the effect of the computer’s action.) In the second assign-
ment statement in Listing 6-2, the computer adds 25.00 to the 5.75 that’s stored
in amount.

Some method calls have this substitution effect, and others (like System.out.
println) don’t. To find out more about this topic, see Chapter 19.

Variations on a Theme

140

In Listing 6-1, it takes two lines to give the amount variable its first value:

double amount;

amount = 5.95;
You can do the same thing with just one line:
double amount = 5.95;

When you do this, you don’t say that you’re “assigning” a value to the amount
variable. The line double amount=5.95 isn’t called an “assignment statement.”
Instead, this line is called a declaration with an initialization. You’re initializing the
amount variable. You can do all sorts of things with initializations, even
arithmetic:

double gasBill = 174.59;
double elecBill = 84.21;
double H20Bill = 22.88;
double total = gasBill + elecBill + H20Bill;

Moving variables from place to place

It helps to remember the difference between initializations and assignments. For
one thing, you can drag a declaration with its initialization outside of a method:

//This is okay:
class SnitSoft {

static double amount = 5.95;

public static void main(String args[]) {

amount = amount + 25.00;
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System.out.print("We will bill $");
System.out.print(amount);

System.out.println(" to your credit card.");

You can’t do the same thing with assignment statements (see the following code
and Figure 6-8):

//This does not compile:
class BadSnitSoftCode {

static double amount;
amount = 5.95; //Misplaced statement

public static void main(String args[]) {

amount = amount + 25.00;

System.out.print("We will bill $");
System.out.print(amount);

System.out.println(" to your credit card.");

] BadSnitSoftCode java 3 =8

1 //This does not compile: - n
2 class BadSnitSoftCode {
e static double amount;. [gorias orror on token ™", | expected) %
amount = 5.95; /fhisplaced statement
7 public static void main(String args[]) {
8 anownt = anount + 25.00;
FIGURE _6'8: System.out.print(“We will bill $%);
A failed 11 System. out.print(anount);
attempt to 12 System.out.println(” to your credit card.™);
compile }
BadsSnit 1
SoftCode.

You can’t drag statements outside of methods. (Even though a variable declaration
ends with a semicolon, a variable declaration isn’t considered to be a statement.
Go figure!)

The advantage of putting a declaration outside of a method is illustrated in
Chapter 17. While you wait impatiently to reach that chapter, notice how I added

the word static to each declaration that I pulled out of the main method. I had to
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do this because the main method’s header has the word static in it. Not all
methods are static. In fact, most methods aren’t static. But whenever you pull a
declaration out of a static method, you have to add the word static at the
beginning of the declaration. All the mystery surrounding the word static is
resolved in Chapter 18.

Combining variable declarations

The code in Listing 6-1 has only one variable (as if variables are in short supply).
You can get the same effect with several variables:

class SnitSoftNew {

public static void main(String args[]) {
double flashDrivePrice;
double shippingAndHandling;
double total;

flashDrivePrice = 5.95;
shippingAndHandling = 25.00;
total = flashDrivePrice + shippingAndHandling;

System.out.print("We will bill $");

System.out.print(total);

System.out.println(" to your credit card.");

This new code gives you the same output as the code in Listing 6-1. (Refer to
Figure 6-1.)

The new code has three declarations — one for each of the program’s three vari-
ables. Because all three variables have the same type (the type double), I can
modify the code and declare all three variables in one fell swoop:

double flashDrivePrice, shippingAndHandling, total;

Which is better — one declaration or three declarations? Neither is better. It’s a
matter of personal style.

You can even add initializations to a combined declaration. When you do, each
initialization applies to only one variable. For example, with the line

double flashDrivePrice, shippingAndHandling = 25.00, total;
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the value of shippingAndHandling becomes 25.00, but the variables flashDrive-
Price and total get no particular value.

Would you like some practice with this section’s concepts? You got it!

™ TIP THE PARKING ATTENDANT

An online blog advises a $2 tip when a parking attendant fetches your car in a
New York City garage. Write a program like the one Listing 6-2. When the pro-
gram runs, you type the garage’s posted price for parking your car. The program
tells you how much you’ll pay after adding the $2 tip.

DOUBLE PRICE

Modify the code in Listing 6-2 so that, whatever a flash drive normally costs, the
program charges twice that amount. In other words, the price for a $5 flash drive
ends up being $10, and the price for a $100 flash drive becomes $200.

Experimenting with JShell

The programs in this book all begin with the same old tiresome refrain:
class SomethingOrOther {
public static void main(String args[]) {

Retyping this boilerplate code into Eclipse’s editor can be annoying, especially
when your goal is to test the effect of executing a few simple statements. To fix
this problem, the stewards of Java came up with a new tool in Java 9. They call
it JShell.

When you use JShell, you hardly ever type an entire program. Instead, you type a
Java statement, and then JShell responds to your statement, and then you type a
second statement, and then JShell responds to your second statement, and then
you type a third statement, and so on. A single statement is enough to get a
response from JShell.

JShell is only one example of a language’s Read Evaluate Print Loop (REPL). Many

programming languages have REPLs and, with Java 9, the Java language finally
has a REPL of its own.
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Launching the JShell program

To run JShell, make sure you have Java 9 (or a higher version of Java when it
becomes available) on your computer.

To launch JShell on a Windows computer
1. Open a Command Prompt window.
In Windows 7: Press Win+R, and then type emd, and then press Enter.

In Windows 8: On the Start screen, press Win+Q. In the resulting search field,
type command prompt, and then press Enter.

In Windows 10: Choose Start = Windows System => Command Prompt.

2. Inthe Command Prompt window, type the following commands:

cd "\Program Files\Java"

dir jdkx
On some computers, you might have better luck typingcd "\Program Files
(x86)\Java" for the first of the two commands. Whatever works!
TIP The Command Prompt window responds by listing some directory names.

3. Inthe Command Prompt window’s response, look for a directory named
jdk-9, or something like that.

Directories whose names start with jdk1 .8 or lower won't work. You must
have Java 9 or higher installed in order to run JShell.

In the next step, | assume that you've found a directory named jdk-9. If your
directory has a different name, adjust your typing to match that name.

4. Inthe Command Prompt window, type the following commands:

cd jdk-9\bin
jshell

If all goes well, the Command Prompt window displays the JShell> prompt.
That's how you know that you've successfully launched JShell.

To launch JShell on a Mac
1. Press Command+spacebar, and then type Terminal, and then press Enter.

As a result, your computer's Terminal application starts running.
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An intimate
conversation
between me and
JShell.

In the Terminal application’s window, type the following commands:

cd /Library/Java/JavaVirtualMachines
dir jdkx

The Terminal application responds by listing some directory names.

In the Terminal application’s response, look for a directory named jdk-9.

jdk, or something like that.

Directories whose names start with jdk1 .8 or lower won't work. You must
have Java 9 or higher installed in order to run JShell.

In the next step, | assume that you've found a directory named jdk-9. jdk. If
your directory has a different name, adjust your typing to match that name.

In the Terminal application’s window, type the following commands:

cd jdk-9. jdk/Contents/Home/bin
./jshell

If all goes well, the Terminal application displays the JShell> prompt. That's
how you know that you've successfully launched JShell.

Using JShell

In Figure 6-9, I use JShell to experiment with this chapter’s Java concepts.

C:\Program Files\Java\jdk-9\bin> jshell
| Welcome to JShell -- Version é
or an introduction type: /help intro

jshell> double amount
lamount ==>

jshell> amount = 5.95
lamount ==> 5.95

jshell> amount = amount 25.00
lamount ==> 30.95

174.59
84.21
= 22.88

jshell> double total = gasBill + elecBill + H20Bill
total ==> 281.68

ishell) double flashDrivePrice, shippingAndHandling = 25.00, total
lashDrivePrice ==

shlpplngAndHandllng ==> 25.0

fshell) sexit
Goodbye

IC:\Program Files\Java\jdk=-9\bin>_
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When you run JShell, the dialogue goes something like this:

jshell> You type a statement
JShell responds

jshell> You type another statement

JShell responds

For example, in Figure 6-9, I type double amount and then press Enter. JShell
responds by displaying

amount ==> 0.0
Then I type amount = 5.95, and JShell responds with
amount ==> 5.95

And then, when I type amount = amount + 25.00, JShell comes back with a
friendly

amount ==> 30.95

Here are a few things to notice about JShell:

3 You don’t have to type an entire Java program.

Typing a few statements such as

double amount
amount = 5.95
amount = amount + 25.00

does the trick. It's like running the code snippet in Listing 4-1 (except that
Listing 4-1 doesn't declare amountInAccount to be a double).

¥ InJShell, semicolons are (to some extent) optional.
In Figure 6-9, | don't bother to end any lines with semicolons.
3 JShell responds immediately after you type each line.

After | declare amount to be double, JShell responds by telling me that the
amount variable has the value 0. 0. After | type amount = amount + 25.00,
JShell tells me that the new value of amount is 30.95.
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FIGURE 6-10:
Using JShell to
evaluate
expressions.

TIP

Figure 6-10 illustrates a few more of JShell’s nice features.

double gasBill = 174.59
==> 174.59

ishell? double elecBill = 84.21
elecBill ==> 84.21

42 + 7
49

gshell) $4 + 1
S ==> 50

3 You can ask JShell for the value of an expression.

You don't have to assign the expression’s value to a variable. For example, in

Figure 6-10, | type

gasBill + elecBill

JShell responds by telling me that the value of gasBill + elecBill is258.8.
JShell makes up a temporary name for that value. In Figure 6-10, the name

happens to be $3.

3 You can even get answers from JShell without using variables.

In Figure 6-10, | ask for the value of 42 + 7, and JShell generously answers
with the value 49. JShell makes up the temporary name $4 for that value 49.
So, on the next line in Figure 6-10, | ask for the value of $4 +1, and JShell gives

me the answer 50.

While you’re running JShell, you don’t have to retype commands that you’ve
already typed. If you press the up-arrow key once, JShell shows you the command
that you typed most recently. If you press the up-arrow key twice, JShell shows
you the next-to-last command that you typed. And so on. When JShell shows you
a command, you can use the left- and right-arrow keys to move to any character
in the middle of the command. You can modify characters in the command.
Finally, when you press Enter, JShell executes your newly modified command.

To end your run of JShell, you type /exit (starting with a slash). But /exit is only
one of many commands you can give to JShell. To ask JShell what other kinds of

commands you can use, type /help.
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TRY IT OUT

With JShell, you can test your statements before you put them into a full-blown
Java program. That makes JShell a truly useful tool.

FUN WITH JShell

Launch the JShell application on your computer. Type the following statements,
one after another, into the JShell application, and watch how JShell responds:

jshell> double bananaCalories = 100.0
jshell> double appleCalories = 95.0

jshell> double dietSodaCalories = 0.0
jshell> double cheeseburgerCalories = 500.0

jshell> bananaCalories + appleCalories +

..> dietSodaCalories + cheeseburgerCalories

Notice that, in JShell, a statement can straddle two or more lines. After typing the
first part of a statement

bananaCalories + appleCalories +
you press Enter. Then, on the next line, JShell doesn’t display its usual jshell>
prompt. Instead, JShell displays ...»>, which indicates that you should continue

typing more of the same statement.

Keep JShell running in preparation for the next experiment.

MOVING WITHIN JShell

In the previous experiment, you entered the calorie counts for four food items. But
because you performed that experiment, you've revised your estimate of the
number of calories in a cheeseburger.

With JShell still running, press your keyboard’s up-arrow key until you see the
statement

double cheeseburgerCalories = 500.0
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Then press the left-arrow key until the cursor is next to the 5 digit. Press your
keyboard’s Backspace or Delete key to get rid of the 5 digit, and then type a 7 digit
in its place. Now the statement reads as follows:

double cheeseburgerCalories = 700.0

Press Enter to confirm that you want JShell to execute that revised statement.

With the value of cheeseburgerCalories changed to 700.0, use your keyboard’s
up arrow and down arrow to make JShell sum up the calorie counts a second time:

jshell> bananaCalories + appleCalories +

...> dietSodaCalories + cheeseburgerCalories

Don’t retype the variable names. Let your arrow keys do the work!
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IN THIS CHAPTER

» Processing whole numbers

» Making new values from old values

» Understanding Java's more exotic
types

Chapter 7
Numbers and Types

ot so long ago, people thought computers did nothing but big, number-
crunching calculations. Computers solved arithmetic problems, and that
was the end of the story.

In the 1980s, with the widespread use of word processing programs, the myth of
the big metal math brain went by the wayside. But even then, computers made
great calculators. After all, computers are very fast and very accurate. Computers
never need to count on their fingers. Best of all, computers don’t feel burdened
when they do arithmetic. I hate ending a meal in a good restaurant by worrying
about the tax and tip, but computers don’t mind that stuff at all. (Even so, com-
puters seldom go out to eat.)

Using Whole Numbers

Let me tell you, it’s no fun being an adult. Right now I have four little kids in my
living room. They’re all staring at me because I have a bag full of gumballs in
my hand. With 30 gumballs in the bag, the kids are all thinking, “Who’s the best?
Who gets more gumballs than the others? And who’s going to be treated unfairly?”
They insist on a complete, official gumball count, with each kid getting exactly the
same number of tasty little treats. I must be careful. If I’m not, I’ll never hear
the end of it.
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With 30 gumballs and four kids, there’s no way to divide the gumballs evenly. Of
course, if I get rid of a kid, I can give 10 gumballs to each kid. The trouble is,
gumballs are disposable; kids are not. So my only alternative is to divvy up what
gumballs I can and dispose of the rest. “Okay, think quickly,” I say to myself.
“With 30 gumballs and 4 kids, how many gumballs can I promise to each kid?”

I waste no time in programming my computer to figure out this problem for me.
When I’'m finished, I have the code in Listing 7-1.

m How to Keep Four Kids from Throwing Tantrums

FIGURE 7-1:
Fair and square.

class KeepingKidsQuiet {

public static void main(String args([]) {
int gumballs;
int kids;
int gumballsPerKid;

gumballs = 30;
kids = 4;
gumballsPerKid = gumballs / kids;

System.out.print("Each kid gets ");
System.out.print(gumballsPerKid);
System.out.println(" gumballs.");

Figure 7-1 shows a run of the KeepingKidsQuiet program. If each kid gets seven
gumballs, then the kids can’t complain that I’'m playing favorites. They’ll have to
find something else to squabble about.

Each kid gets 7 gumballs.

At the core of the gumball problem, I’ve got whole numbers — numbers with no
digits beyond the decimal point. When I divide 30 by 4, I get 7%/, but I can’t take
the Y2 seriously. No matter how hard I try, I can’t divide a gumball in half, at least
not without hearing “my half is bigger than his half.” This fact is reflected nicely
in Java. In Listing 7-1, all three variables (gumballs, kids, and gumballsPerKid)
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are of type int. An int value is a whole number. When you divide one int value by
another (as you do with the slash in Listing 7-1), you get another int. When you
divide 30 by 4, you get 7 — not 7%2. You see this in Figure 7-1. Taken together, the
statements

gumballsPerKid = gumballs/kids;
System.out.print(gumballsPerKid);

put the number 7 on the computer screen.

Reading whole numbers from the keyboard

What a life! Yesterday there were four kids in my living room, and I had 30 gum-
balls. Today there are six kids in my house, and I have 80 gumballs. How can I
cope with all this change? I know! I'll write a program that reads the numbers of
gumballs and kids from the keyboard. The program is in Listing 7-2, and a run of
the program is shown in Figure 7-2.

m A More Versatile Program for Kids and Gumballs

import java.util.Scanner;

class KeepingMoreKidsQuiet {

public static void main(String args[]) {
Scanner keyboard = new Scanner(System.in);
int gumballs;
int kids;
int gumballsPerKid;

System.out.print("How many gumballs? How many kids? ");
gumballs = keyboard.nextInt();
kids = keyboard.nextInt();

gumballsPerKid = gumballs / kids;
System.out.print("Each kid gets ");
System.out.print(gumballsPerKid);
System.out.println(" gumballs.");

keyboard.close();
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FIGURE 7-2:

Next th|’ng you How many gumballs? How many kids? 8@ &
know, I'l have Each kid gets 13 gumballs.
70 kids and 1,000

gumballs.

You should notice a couple of things about Listing 7-2. First, you can read an int
value with the nextInt method. (Refer to the table in Chapter 5.) Second, you can
issue successive calls to Scanner methods. In Listing 7-2, I call nextInt twice. All
I have to do is separate the numbers I type by blank spaces. In Figure 7-2, I put one
blank space between my 80 and my 6, but more blank spaces would work as well.

This blank-space rule applies to many of the Scanner methods. For example,
here’s some code that reads three numeric values:

gumballs = keyboard.nextInt();
costOfGumballs = keyboard.nextDouble();
kids = keyboard.nextInt();

Figure 7-3 shows valid input for these three method calls.

FIGURE 7-3:
Three numbers
for three 80 7.35 6
Scanner
method calls.

What you read is what you get

When you’re writing your own code, you should never take anything for granted.
Suppose that you accidentally reverse the order of the gumballs and kids assign-
ment statements in Listing 7-2:

//This code is misleading:

System.out.print("How many gumballs? How many kids? ");

kids = keyboard.nextInt();
gumballs = keyboard.nextInt();

Here, the line How many gumballs? How many kids? is misleading. Because the
kids assignment statement comes before the gumballs assignment statement,
the first number you type becomes the value of kids, and the second number
you type becomes the value of gumballs. It doesn’t matter that your program dis-
plays the message How many gumballs? How many kids?. What matters is the
order of the assignment statements in the program.
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FIGURE 7-4:
How to make
six kids very
unhappy.

TRY IT OUT

If the kids assignment statement accidentally comes first, you can get a strange
answer, like the zero answer in Figure 7-4. That’s how int division works. It just
cuts off any remainder. Divide a small number (like 6) by a big number (like 80),
and you get 0.

How many gumballs? How many kids? 80 6
Bach kid gets 9 gumballs.

kids =/ myScanner.nextInt ()
gumballs = myScanner.nextInt();

gurballsPerkKid = gumballs / kids;
0 = 6/80

Like the mad scientist in an old horror movie, try these fascinating experiments!

MAKE IT AND BREAK IT

Run the program in Listing 7-2. When the program asks How many gumballs? How
many kids?, type 80.5 6. (Actually, if you live in a country where 80,5 represents
eighty-and-a-half, type 80,5 instead of 80.5.)

What unpleasant message do you see during this run of the program? Why do you
see this message?

BREAK IT AGAIN

Run the program in Listing 7-2. When the program asks How many gumballs? How
many kids?, type "80" "6" (quotation marks and all).

What unpleasant message do you see during this run of the program? Why do you
see this message?

ATINY ADDING MACHINE

Write a program that gets two numbers from the keyboard and displays the sum
of the two numbers.

CHAPTER 7 Numbers and Types 155



Creating New Values by
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TIP

What could be more comforting than your old friend, the plus sign? It was the first
thing you learned about in elementary school math. Almost everybody knows how
to add two and two. In fact, in English usage, adding two and two is a metaphor
for something that’s easy to do. Whenever you see a plus sign, one of your brain
cells says, “Thank goodness, it could be something much more complicated.”

So Java has a plus sign. You can use the plus sign to add two numbers:

int apples, oranges, fruit;
apples = 5;
oranges = 16;

fruit = apples + oranges;
Of course, the old minus sign is available, too:
apples = fruit - oranges;
Use an asterisk for multiplication and a forward slash for division:

double rate, pay, withholding;

int hours;

rate = 6.25;

hours = 35;

pay = rate x hours;
withholding = pay / 3.0;

When you divide an int value by another int value, you get an int value. The
computer doesn’t round. Instead, the computer chops off any remainder. If you
put System.out.println(11 / 4) in your program, the computer prints 2, not
2.75. If you need a decimal answer, make either (or both) of the numbers you’re
dividing double values. For example, if you put System.out.println(11.0 / 4)
in your program, the computer divides a double value, 11.9, by an int value, 4.
Because at least one of the two values is double, the computer prints 2. 75.

Finding a remainder

There’s a useful arithmetic operator called the remainder operator. The symbol for
the remainder operator is the percent sign (%). When you put System.out.
println(11 % 4) in your program, the computer prints 3. It does so because 4
goes into 11 who-cares-how-many times, with a remainder of 3.
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?63 Another name for the remainder operator is the modulus operator.
tecunicar  The remainder operator turns out to be fairly useful. After all, a remainder is the
STUFF amount you have left over after you divide two numbers. What if you’re making
change for $1.38? After dividing 138 by 25, you have 13 cents left over, as shown in
Figure 7-5.
138 cents
— 138/25is 5
FIGURE 7-5: | 1200/ ok i
Hey, bud! Got 138%25is 13
change for -
138 sticks?

The code in Listing 7-3 makes use of this remainder idea.

m Making Change

import java.util.Scanner;

class MakeChange {

public static void main(String args[]) {
Scanner keyboard = new Scanner(System.in);
int quarters, dimes, nickels, cents;
int whatsLeft, total;

System.out.print("How many cents do you have? ");

total = keyboard.nextInt();
(continued)
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quarters = total / 25;
whatsLeft = total % 25;

dimes = whatsLeft / 10;
whatsLeft = whatsLeft % 10;

nickels = whatsLeft / 5;
whatsLeft = whatsLeft % 5;

cents = whatsLeft;

System.out.println();

System.out.println("From " + total + " cents you

System.out.println(quarters +
System.out.println(dimes + " dimes");

System.out.println(nickels + " nickels");

System.out.println(cents + " cents");

keyboard.close();

quarters");

A run of the code in Listing 7-3 is shown in Figure 7-6. You start with a total of

138 cents. The statement

quarters = total / 25;

divides 138 by 25, giving 5. That means you can make 5 quarters from 138 cents.

Next, the statement

whatsLeft = total % 25;

divides 138 by 25 again, and puts only the remainder, 13, into whatsLeft. Now you’re
ready for the next step, which is to take as many dimes as you can out of 13 cents.

How many cents do you have? 138

From 138 cents you get
5 quarters

1 dimes

@ nickels

FIGURE 7-6: 3 cents

Change for $1.38.
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You keep going like this until you’ve divided away all the nickels. At that point, the
value of whatsLeft is just 3 (meaning 3 cents).

The code in Listing 7-3 makes change in U.S. currency with the following coin
denominations: 1 cent, 5 cents (one nickel), 10 cents (one dime), and 25 cents (one
quarter). With these denominations, the MakeChange program gives you more
than simply a set of coins adding up to 138 cents. The MakeChange class gives you
the smallest number of coins that add up to 138 cents. With some minor tweaking,
you can make the code work in any country’s coinage. You can always get a set of
coins adding up to a total. But, for the denominations of coins in some countries,
you won’t always get the smallest number of coins that add up to a total. In fact, I'm
looking for examples. If your country’s coinage prevents MakeChange from always
giving the best answer, please, send me an email (BeginProg@allmycode.com),
tweet to @al lmycode, or post on Facebook at /allmycode. Thanks.

IF THINE INT OFFENDS THEE, CAST IT OUT

The run in Figure 7-6 seems artificial. Why would you start with 138 cents? Why not use
the more familiar $1.38? The reason is that the number 1.38 isn't a whole number, and
whole numbers are more accurate than other kinds of numbers. In fact, without whole
numbers, the remainder operator isn't very useful. For example, the value of1.38 %
0.25 is0.1299999999999999. All those nines are tough to work with. Imagine reading
your credit card statement and seeing that you owe $0.1299999999999999. You'd prob-
ably pay $0.13 and let the credit card company keep the change. But after years of
rounding numbers, the credit card company would make a fortune! Chapter 8
describes, in a bit more detail, inaccuracies that may come from using double values.

Throughout this book, | illustrate Java's double type with programs about money. Many
authors do the same thing. But for greater accuracy, avoid using double values for
money. Instead, you should use int values or use the 1ong values that | describe in the
last section of this chapter. Even better, look upBigInteger and BigDecimal in Java's
APl documentation. These BigSomethingOrOther types are cumbersome to use, but
they provide industrial-strength numeric range and accuracy.

Now, what if you want to input 1 . 38 and then have the program take your 1.38 and
turn it into 138 cents? How can you get your program to do this?

My first idea is to multiply 1.38 by 100:

//This doesn't quite work.
double amount;

(continued)

CHAPTER 7 Numbers and Types 159


mailto:BeginProg@allmycode.com
http://www.twitter.com/allmycode
http://www.facebook.com/allmycode

(continued)

int total;
amount=keyboard.nextDouble();
total=amount*100;

In everyday arithmetic, multiplying by 100 does the trick. But computers are fussy. With
a computer, you have to be very careful when you mix int values and double values.
(See the first figure in this sidebar.)

1o System.out.printIn("How much money do you have? *);
1 amount = keyboard. nextDoublel ) ;

1 total = amount [108; //This doesn’t quite work.
1

1

1

1

1

1

|

]

& Type mismatch: cannot corvert from double to int

2 quick fires availables
quarters = totall (L
whatsLeft = tota) b Addcastie‘int
& Change fype of total*to dauble’
a dimes = total / Press 'F2' for focus
20 whatsleft = total %O

To cram a double value into an int variable, you need something called casting. When
you cast a value, you essentially say, “I'm aware that I'm trying to squish a double value
into an int variable. It's a tight fit, but | want to do it anyway.”

To do casting, you put the name of a type in parentheses, as follows:

//This works!
total = (int) (amount * 100);

This casting notation turns the double value 138.00 into the int value 138, and every-
body’s happy. (See the second figure in this sidebar.)

double amount;
int total;

o 